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CHAPTER 1  INTRODUCTION 

About PhotoMesh  

Skyline’s PhotoMesh fully automates the generation of high-resolution, textured, 3D mesh models from 

standard 2D photographs, Lidar and Full Motion Video (FMV), offering a significant reduction in cost and 

time compared to traditional modeling methods. PhotoMesh’s breakthrough technology is based on the 

highest-performance photogrammetry, computer vision, and computational geometry algorithms. 

Combining any number of photographs, in a wide range of formats and resolutions, PhotoMesh generates 

highly-detailed 3D models that can be viewed and queried using TerraExplorer or other 3D and GIS 

products. 

PhotoMesh employs elaborate tiling mechanisms to efficiently handle projects with even hundreds of 

thousands of photos. Running on standard hardware, PhotoMesh can also exploit computer clusters and 

cloud computing to run a single project simultaneously on hundreds of fuser machines. Sharing the 

workload involved in generating PhotoMesh output vastly accelerates all steps of the build. 

PhotoMesh Components 

The PhotoMesh application is composed of three components: 

▪ PhotoMesh Editor – The main PhotoMesh working area for various workflow actions such as 

preparing, submitting for processing, monitoring, and reviewing the build.  

▪ PhotoMesh Fuser – Worker component of PhotoMesh which allows you to share the workload 

between several computers on the same network. The master computer, equipped with PhotoMesh 

fuser, utilizes the computing power of the network’s client computers by connecting to PhotoMesh 

fusers on the client machines.  

Note: Fuser pools can be used to share fusers between several PhotoMesh master computers in 

your organization. PhotoMesh can also work with Amazon Web Services (AWS), adding 

and terminating virtual fuser machines, based on resource needs. 

▪ PhotoMesh Build Manager – Manager application that is responsible for managing the build process 

and PhotoMesh fusers. PhotoMesh Build Manager keeps track of all build tasks and fusers, 

distributing tasks among the fusers and assigning new tasks as fusers complete their tasks and 

become available. During the build process, PhotoMesh Build Manager monitors the build and 

provides the user with detailed information about the build’s progress.  

PhotoMesh Resources  

Resources that provide information about the application and about your application license are easily 

accessible from the PhotoMesh button . 

To open PhotoMesh resources:  

▪ Click the PhotoMesh button, point to Resources and then click one of the following resources: 

Resource Description 

PhotoMesh Help (F1) Provides access to PhotoMesh Help files. 

License Manager Opens the License Manager tool. 
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PhotoMesh API Provides access to interactive documentation of the PhotoMesh 
REST API to automate the production phases, e.g., load photo 
files or list, set AT and reconstruction areas, begin and manage a 
build, and create new build versions. 

PhotoMesh Start Page Opens the Start page from which you can create a new project, 
open an existing one, open the automation dashboard, and more. 

About PhotoMesh Access basic application information, including version number, 
contact information, and license information. 

SkylineGlobe Product Suite 

The SkylineGlobe software suite sets the standard for 3D desktop and web-based applications, enabling 

an enterprise to build and efficiently publish realistic 3D environments that can be explored, queried, 

analyzed and edited by desktop, web, and mobile clients. The suite includes: 

▪ Editors – PhotoMesh, TerraBuilder, and TerraExplorer Pro 

▪ Cloud Services – Streaming, Storing, and Cataloging  

▪ Clients – Desktop, Mobile, and Web applications 

 

SkylineGlobe Product Suite  

The SkylineGlobe Enterprise solution is scalable, with licenses to support from ten to tens of thousands of 

concurrent users. 

Whether deploying a desktop, mobile or web-based application, SkylineGlobe Enterprise provides a full 

Application Programming Interface (API) allowing you to customize it according to your requirements. 
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Because SkylineGlobe Enterprise is based on open OGC standards such as WFS and WMS, it can 

operate as a seamless 3D interface with other existing, legacy systems within the organization. 

"On the fly" data fusion from disparate and distributed sources without data pre-processing allows you to 

keep your 3D environment current and relevant. 

Skyline’s range of products allows users to design an implementation customized to meet their 

requirements. Deployment options include the ability to work in a networked or disconnected (off-line) 

mode and make content available to the public or keep it restricted to secure networks and authorized 

users. Highly efficient streaming server technology supports large enterprise deployments with minimal 

hardware requirements.  

Editors 

Skyline offers powerful applications for generating, editing and publishing 3D terrain and urban model 

databases from a wide variety of data types.  

TerraBuilder 

TerraBuilder is a 3D terrain database creator with professional-grade tools for manipulating and merging 

orthophotos, DEM and DSM raster files of different sizes and resolutions. The resulting photo-realistic, 

geographically accurate terrain database (MPT) can be made available to local TerraExplorer clients or 

published to remote clients using the SkylineGlobe Server.  

PhotoMesh 

Skyline’s breakthrough PhotoMesh application fully automates the building of high-resolution, textured, 

3D mesh models from oblique and nadir photographs and Lidar captured from street view, drones, UAV 

and airplanes. PhotoMesh results can be generated in standard 3D model (3DML, OSGB, DAE, OBJ), 

raster (Orthophoto, DSM, DTM) and point cloud (LAS) formats.  

TerraExplorer Pro 

TerraExplorer Pro is a powerful GIS tool for merging unlimited, geo-referenced 3D terrain, 3D mesh, 

Lidar, BIM, raster and feature layers into a 3D high-resolution, geospatial environment. The project and all 

its individual layers can be directly uploaded and published to SkylineGlobe cloud server from 

TerraExplorer. Through a single publishing operation, the project and its individual layers are made 

available to all TerraExplorer clients: Desktop, Mobile, and TE for Web, as well as standard geospatial 

clients. TerraExplorer Pro also provides powerful tools and a high resolution 3D environment in which to 

view, query, analyze and present geospatial data. 

Cloud Services 

SkylineGlobe Server (SGS) is a private cloud solution that provides a comprehensive set of web services 

for publishing, storing, managing and streaming 3D spatial data. SkylineGlobe Server provides streaming 

services for all your spatial data types including terrain (MPT/TBP), map (raster-WMS/WMTS), feature 

(WFS/WFS-T), 3D Mesh (3DML, OGC 3D Tiles, I3S/SLPK), and point cloud (CPT, OGC 3D Tiles). All 

data on your server is cataloged and referenced so clients can easily find the specific published layer 

required. Your data is kept safe by multiple security layers, including restriction of each user group to 

predefined data folders and a robust user authentication mechanism. 

The server’s built-in complete user access control system allows easy management of users, groups, and 

administrative roles controlling the server-side storage and client-side view/edit permissions. 

SkylineGlobe Server is compliant with the following OpenGIS Implementation Specifications:  

▪ OpenGIS® Web Feature Service (WFS) Implementation Specification  
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▪ OpenGIS® Web Feature Service Transactions (WFS-T) Implementation Specification  

▪ OpenGIS® Web Map Service (WMS) Implementation Specification  

▪ OpenGIS® Web Map Tiling Service (WMTS) Implementation Specification  

 

SkylineGlobe Terrain Service 

Powerful terrain service technology for streaming terrain data stored either in Skyline optimized terrain 

databases (MPT) or in terrain databases defined by the TerraBuilder project file (TBP) to remote 

TerraExplorer clients and any application that reads the standard OGC WMS/WMTS protocol. 

SkylineGlobe Feature Service 

Powerful feature service technology for streaming point, polyline, and polygon feature layers from files 

and from the Oracle, SQL server, PostGIS and ArcSDE databases to remote TerraExplorer clients and 

any application that reads the standard OGC WFS protocol. The Feature Service can stream most 

TerraExplorer supported feature layer formats. It also supports advanced spatial and attribute queries 

from TerraExplorer and other WFS clients. With SGS’s support for WFS-T (Web Feature Service-

Transactional), remote clients can edit (create, delete, and update features) the feature layer and save 

changes to the data source.  

SkylineGlobe Maps Service 

Powerful maps service technology for streaming most TerraExplorer supported raster layer formats to 

remote TerraExplorer clients and any application that reads the standard OGC WMS/WMTS protocol. The 

layers are streamed as WMS/WMTS tiles in JPEG and PNG formats. 
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SkylineGlobe 3D Mesh Service  

Powerful 3D city model service technology for streaming 3D Mesh Layer (3DML) databases from 3DML 

files to remote TerraExplorer clients. 3D mesh layers (3DML) are high-resolution, textured, 3D mesh 

models that have been compressed and stream-optimized to accelerate loading speed and efficiently 

handle memory. The 3D Mesh Service also exposes the data as 3D tiles for TerraExplorer for Web and 

Cesium based clients. 

SkylineGlobe Point Cloud Service 

Powerful point cloud service technology for streaming multi-resolution and stream-optimized point cloud 

data from CPT files to remote TerraExplorer clients. The Point Cloud Service also exposes the data as 3D 

tiles for TerraExplorer for Web and Cesium based clients. 

Clients 

Skyline offers a range of 3D visualization clients that enable users to interact with, edit and annotate a 

geo-referenced 3D environment. Users can customize the database with data from a network, local drive 

or the Internet. Overlaying data specific to the user’s requirements onto a 3D map creates a targeted, 

interactive picture that can meet the needs of a diverse user base and the specific requirements of each 

individual user. Skyline’s client applications can be used in a local desktop environment, accessing terrain 

and content data directly, or in a network environment via the SkylineGlobe server. 

TerraExplorer Desktop 

A cutting-edge 3D GIS desktop viewer and creator that provides powerful tools and a high resolution 3D 

environment in which to view, query, analyze and present geospatial data. 

With TerraExplorer's robust and extensive capabilities and ever-increasing interoperability, stunningly 

realistic 3D visualizations can be created by overlaying the terrain with unlimited data layers, 3D models, 

virtual objects and more.  

TerraExplorer for Web 

TerraExplorer for Web is a lightweight 3D GIS viewer that enables you to view high-resolution, stunningly 

realistic SkylineGlobe 3D content in a web browser, without any plug-ins. The employment of 

HTML5/WebGL standards allows TerraExplorer for Web to provide support for multiple platforms and 

browsers. Built on the powerful Cesium open source library, TerraExplorer for Web further extends the 

core functionality with additional capabilities and enhanced performance. 

TerraExplorer for Mobile 

TerraExplorer for Mobile is a 3D GIS viewer for Android and Apple iOS devices, based on TerraExplorer 

for Web, that enables you to view high-resolution SkylineGlobe 3D content. The TerraExplorer for Mobile 

app can display most of your spatial databases including 3D city layers and feature layers, and it provides 

powerful tools to query, analyze and present your data on the go. TerraExplorer for Mobile seamlessly 

accesses online data from Skyline’s SkylineGlobe server and other OGC-compliant servers, and quickly 

loads online TerraExplorer projects. 
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CHAPTER 2  GETTING STARTED 

Software and Hardware Requirements 

Operating System Windows® 8 / 10 Windows® Server 2012 R2 / 2016 / 2019 – 64bit 
required. 
Ubuntu 18.04 and Debian 10.0 – 64-bit required (Only for PhotoMesh 
fusers). 

System Memory 16 GB RAM (32 GB recommended). 

Note: RAM requirements are mostly affected by the number of photos in 
the AT tile and the reconstruction tile size. See “Setting AT 
Parameters” and “Setting Reconstruction Parameters” in the 
“Building” chapter for more information. 

Video Card 1 GB of video memory (2 GB or more recommended). Pixel and vertex 
shader v3.0.  

Processor 4 cores (8 cores recommended). PhotoMesh works best in a multi-core 
environment and can utilize multiple CPU’s and hyper-threaded 
processors.  

In the latest PhotoMesh performance tests, using a single computer, 16 
GB RAM and 8 cores, output was between 10-15 gigapixels/day, 
depending on the machine and resource availability. 

Additional Software .Net Framework 4.6.1 required. 

License Mechanism for PhotoMesh 

PhotoMesh is protected by a licensing mechanism that controls its operation, license term, and available 

modules. A license file issued by Skyline determines the licensing mechanism used. 

The following licensing mechanisms are available for PhotoMesh: 

▪ Local Hardware Protection (USB Key) 

▪ Local Hardware Protection (HASP Key) 

▪ Workstation Dependent Software License 

▪ Skyline Floating License Server 

▪ HASP Floating License 

Local Hardware Protection (USB Key) 

A USB key is a physical hardware key delivered with the PhotoMesh software package that plugs into the 

USB port of the computer – to allow the operation of the product. Verify that the USB key is plugged into 

the USB port before starting PhotoMesh. 

Local Hardware Protection (HASP Key) 

In some cases, Gemalto’s HASP key solution is used instead of a USB key. The HASP key is a physical 

hardware key delivered with the PhotoMesh software package that plugs into the USB port of the 

computer – to allow the operation of the product. Verify that the HASP key is plugged into the USB port 

before starting PhotoMesh. To use a HASP key, the necessary driver must be downloaded and installed 

on your computer. See “Manual Installation of the HASP Driver” in this chapter for information. 
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Workstation Dependent Software License 

Another type of license is the workstation dependent software license. This license does not require any 

hardware protection but is limited to a specific computer. Before working with the workstation dependent 

software license, you must first register to get a license locked to your computer. The license cannot be 

transferred without repeating the registration process. 

Skyline Floating License Server 

The license information can also be obtained using a floating license server which enables a number of 

licenses to be shared among a larger number of users. When an authorized user wants to run 

PhotoMesh, the user requests a license from the license server, and if one is available, the license server 

allows PhotoMesh to run. When the user finishes running PhotoMesh, the license is returned to the 

license server for use by other users. See “Configuring PhotoMesh to Use the Skyline Floating License 

Server (SFLS)” in this chapter for information. The floating license server also supports the PhotoMesh 

GX mechanism, which allows you to pre-purchase a bank of gigapixel credits, load them to your local 

Skyline Floating License Server (SFLS), and automatically apply them towards different PhotoMesh 

projects to allow building of all output types without watermarks. See “Applying Gigapixel Credits” in the 

“Building” chapter for more information. 

HASP Floating License 

In some cases, Gemalto’s NetHASP solution is used instead of Skyline's Floating License Server. The 

NetHASP key is a physical hardware key delivered with the PhotoMesh software package that plugs into 

the USB port of the server computer along with installation of the NetHASP License Manager software. It 

allows a predetermined number of concurrent users on the same network to use PhotoMesh, according to 

the license level defined by Skyline, without an individual hardware key on each of their computers.  

License Manager 

The License Manager allows the user to view and update the current license level. 

To activate the License Manager: 

▪ Click the PhotoMesh  button, point to Resources, and then click License Manager. The License 
Manager window is displayed. 

PhotoMesh License Options 

The following PhotoMesh license options are available: 

▪ PhotoMesh Standard – Pay per fuser. No gigapixel limit. 

▪ PhotoMesh GX – Pay per gigapixel in your project. Unlimited managers/fusers. This option is 

generally implemented with Skyline Floating License Server (SFLS), or using an online gigapixel 

credit form or request file. Gigapixel credits are loaded to SFLS, and then applied to a project’s 

photos when building the project. See the SFLS Setup Guide for more information. 

▪ PhotoMesh Evaluation – 1 manager/ 1 fuser. Only 3DML output can be produced, displaying a 

watermark. 
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Installing PhotoMesh  

The PhotoMesh application installation includes fuser installation. A standalone fuser installation is also 

available. See “Installing PhotoMesh Fusers” in this chapter for information. 

To install PhotoMesh: 

Note: On some operating systems, administrative privileges may be required. 

 If you have an old version of PhotoMesh running, close it before continuing with the installation. 

 Place the PhotoMesh license file (SLPhotoMesh.lic) next to the PhotoMeshSetup.msi file in the 

installation folder. 

 On your computer, browse to the Photomesh.msi file and double-click. The Welcome to PhotoMesh 

Setup dialog box is displayed. 

 

Welcome to PhotoMesh Setup 

 Click Next. The End-User License Agreement is displayed. 
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License Agreement 

 Select the check box to agree to the license agreement terms and then click Next to continue the 

installation.  
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Destination Folder 

 Select the folder in which setup should install the files, and then click Next. The Ready to Install 

PhotoMesh dialog box is displayed. 
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Ready to Install PhotoMesh Dialog Box 

 Click Install. A dialog box is displayed when the installation process is complete. 

 

PhotoMesh Setup Complete 
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 Click Finish to exit the Setup Wizard. 

Manual Installation of the HASP Driver 

If your software was delivered with a HASP license key, you can manually install the required HASP 

driver. 

To install the HASP driver: 

 Download the HASP driver zip file: Sentinel_LDK_Run-time_setup. 

 Unzip the file to a temporary directory, and run the HASPUserSetup.exe file. 

 Follow the installation wizard instructions to complete the installation. 

Configuring PhotoMesh to Use the Skyline Floating License Server (SFLS) 

Each machine that is sharing the floating license for PhotoMesh must be configured with the address of 

the Floating License Server.  

Note: The Skyline Floating License should be installed on the server before configuring it on each of the 

machines that is sharing the license. 

To configure PhotoMesh to the SFLS address: 

 Open the License Manager. See “License Manager” in this chapter for information. 

 If the Skyline Floating License received from Skyline was not used in the installation (i.e., placed next 

to the PhotoMesh.msi file in the installation folder), from the File menu, select Load License File, 

and browse to the license file.  

 From the File menu, select Set Floating License Server to set the floating license server URL, e.g., 

http://<server_name>/SFLS.  

Uninstalling PhotoMesh 

The Uninstall feature lets you quickly remove all folders and files that you installed to your hard disk 

during the installation procedure. 

To uninstall PhotoMesh (including PhotoMesh fuser): 

 Exit the PhotoMesh and PhotoMesh fuser applications. 

 From the Windows Start menu, click All Programs, then click the Skyline PhotoMesh folder, and 

select Uninstall. The Windows Installer dialog box is displayed. 

 Click Yes to uninstall. 

Installing PhotoMesh Fusers 

PhotoMesh fuser can be installed as a standalone installation on any client computer on the same 

network. The number of fusers that can run simultaneously is determined according to the PhotoMesh 

license. See “PhotoMesh License Options” in the “Getting Started” chapter. See the “Fusers” chapter for 

information on installing fusers for a fusers pool and for general fuser information. 

To install a PhotoMesh fuser:  

 Log on as a user with administration privileges. 

https://www.skylinesoft.com/KB_Resources/General/HASP/Sentinel.LDK.Runtime.setup.zip
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 On your computer, browse to the PhotoMesh Fuser.msi file and double-click. The Welcome dialog 

box is displayed. 

 

PhotoMesh Fuser Welcome Dialog Box 

 Click Next to view the Software License Agreement dialog box. If you agree to the licensing terms, 

click Yes to continue the installation. The Installing PhotoMesh Fuser dialog box is displayed. 
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Installing PhotoMesh Fuser Dialog Box 

 Click Next. The Completed PhotoMesh Fuser Setup dialog box is displayed. 

 

Completed Fuser Setup Dialog Box 

 Click Finish. 
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Installing Linux Fusers 

To install a Linux fuser: 

See: "Customizing the Instance" in the "Getting Started with AWS" chapter  for more information. 

 Make sure you have the latest graphics drivers for your graphics card and X Window System 

configured. 

Note: To verify that your graphics card is configured properly, type the following in the terminal 

window: “glxinfo -B” and see if the right graphics card info is displayed. 

 Install and configure Wine by doing the following: 

a. Copy the installation package received from Skyline, “wineinst.tar”, to your Linux machines, under 
“/home/ubuntu/”. 

b. In terminal window, type the following: 

i. tar -xvf  wineinst.tar 

ii. sh fuser.sh 

Note: This process can take a few minutes to complete. 

 Run PhotoMeshFuser: 

a. In terminal window, mount all the relevant shared drives on the Linux machine. (Working folder, 
Project, Input data) 
Example: 
mount -t cifs //<IP>/<SharedDrive> /mnt/mount1 -o 
username=<username>,password=<password>,vers=2.0,uid=ubuntu 

b. In terminal window, mount and hard link Wine DOS devices: 
Example: 
mkdir ~/.wine/dosdevices/unc 
mkdir ~/.wine/dosdevices/unc/<IP> 
ln -s /mnt/mount1 ~/.wine/dosdevices/unc/<IP>/<SharedDrive> 

c. In terminal window, navigate to the PhotoMesh fuser folder and run PhotoMeshFuser.exe with 
Wine. The fuser files can be on your Linux machine or on a shared drive. 
Example: 
wine photomeshfuser.exe 

Uninstalling PhotoMesh Fusers  

The uninstall feature lets you quickly remove all folders and files that were installed on the hard disk 

during the installation procedure. 

To uninstall a standalone PhotoMesh fuser: 

 Exit PhotoMesh application. 

 From the Windows Start menu, click All Programs, then click the Skyline PhotoMesh Fuser folder, 

and select Uninstall PhotoMesh Fuser.  

 The Windows Installer dialog box is displayed. Click Yes to uninstall. 

Starting PhotoMesh 

Start PhotoMesh by doing one of the following: 

▪ Click Start > Skyline PhotoMesh> PhotoMesh. 

▪ Click the PhotoMesh icon on your desktop. 

https://www.winehq.org/
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▪ Double-click any .PhotoMeshXML file on your file system.  
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CHAPTER 3  NEW FEATURES IN RELEASE 7.8 

What’s New in 7.8 

Quality Improvements to Support Higher Quality Close Range Projects 

With PhotoMesh 7.8, you can build ultra-realistic, close range 3D models such as towers, bridges, 

factories and more.  The latest PhotoMesh features several enhancements for working with close range, 

sub-centimeter data collections:  

▪ Modifications of aerotriangulation process to support data collection of close-range objects such as 

towers and antennas. 

▪ Automatic identification and cleaning of sky background 

▪ Better sharpening and modeling of thin elements such as poles and pipes to produce higher quality, 

detailed point clouds and mesh models  

▪ Noise reduction around edges of complex models 

▪ Improved model quality across all levels of resolution pyramid  
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Higher Quality Orthophoto 

Quality-optimized image compression produces cleaner and higher quality orthophoto output. New preset 

offers the following advantages: 

▪ Higher quality texture resolution: 

▪ Higher compression rate for the photos 

▪ Higher compression rate for the final ortho 

▪ Improved quality for ortho texturing  

▪ Sharper building edges 

▪ Reduced noise 
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New Option to Use Reference Project to Improve Project Alignment 

This mechanism automatically geo-references a new project based on the aerotriangulation results of a 

previously built project, to ensure both projects are completely aligned. 

▪ This tool can be particularly useful for multiple flights over the same area. Ground control points, or 

high accuracy GPS locations (RTK, PPK) can be used for the first flight and then the Reference 

Project mechanism can be used to accurately register the other flights, even without GCPs or 

accurate location information. 

▪ The Reference Project mechanism can ensure perfect horizontal and vertical alignment for 

visualization and difference comparison tools.  

▪ The Reference Project can also be used with partially overlapping projects. For best success, the 

same sensor and flight pattern should be used for both projects although the Reference Project 

mechanism can support different sensors and patterns  
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Export Undistorted Photos 

New option to save the undistorted photos created in the AT process when exporting AT results. During 

the photo preparation steps, PhotoMesh calculates the photos’ distortion parameters (that result from 

most cameras lens properties) and uses these parameters to undistort the photos so that feature 

matching and other AT sub-steps can be performed properly. 

 

Performance Improvements 

▪ Close range project memory usage optimized for 16GB machines 

▪ Optimized production time for close range projects 

▪ Overall performance improvements accelerate production 
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Quality Report API 

PhotoMesh provides a REST API for PM Production to automate the production phases, e.g., load photo 

files or list, set AT and reconstruction areas, begin and manage a build, and create new build versions. 

PhotoMesh 7.8 features the addition of a new method to the API for generation of a report in JSON 

format with information about the general project, photo collections, AT results, control points, reference 

projects and reconstruction results.  
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Usability Improvements 

▪ Close range navigation - Improved 3D navigation to support close range and vertical objects  

▪ Relative path – Project can be copied or moved to a new folder or drive location after any build step. 

It can then be resumed from any step from its new location 
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AT/Reconstruction Area Buffer 

New options make it easier to set the appropriate area for aerotriangulation, especially in close-range 

projects. The area of the project on which PhotoMesh should perform aerotriangulation can now be 

calculated automatically by PhotoMesh based on all the project’s photos plus a buffer in meters that is 

either based on the collections’ maximum effective range or a set value that you define. 

 

AWS Improvements: Fuser Throttling and Tagging 

▪  Throttling – New Launch Rate setting lets you control the maximum number of fuser instances 

launched per minute, e.g. if Maximum Instances was set to 200, and the Launch Rate to 50, the Build 

Manager will spread the launch of the fusers over 4 minutes. This prevents a potential bottleneck that 

could be caused by a large number of fusers attempting to read the build data at the same time. 

▪  Tagging – New user-defined tags added to fuser properties to help you easily identify a fuser 

instance in the Amazon EC2 console after it is launched. 

Bug Fixes and Stability Improvements 

▪ Resolved issue causing Lidar bounding box to float above point cloud data 

▪ Resolved issue causing orthophoto generation to fail when tile size exceeded 50,000 pixels. 

▪ Resolved issue causing build to fail in projects with more than 4,000 Lidars 

▪ Fixed bug that caused Lidars to disappear from project after changing their coordinate system and 

then reopening the project 

▪ Fixed bug that resulted in control point editor sometimes opening showing an “Overflow error” 

▪ Corrected issue that caused a build to fail when generating orthophoto output with 'Mesh Vertical 

Bias' preset 

▪ Failed photos are now included in the calculated lists of the Control Point Editor, with their name 

marked in red and a tooltip to inform the user that they were not calculated in the AT process. 

▪ Resolved bug relating to control point sampling error variance 
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▪ Fixed bug affecting display of table in CSV/TXT Importer 

▪ Fixed bug affecting display of orthophoto on white background 

▪ Corrected bug causing white dots to display on PhotoMesh window when using the shortcut keyboard 

combination to open a tile's folder 

 

New Features in 7.7 

Quality Enhancements 

Better handling of close-range projects: 

▪ Photo matching step prioritizes features close to the camera in the bundle adjustment to improve 

aerotriangulation results in close-range projects (Implemented using "AT foreground object at close 

range" preset).  

▪ Sharpens thin objects such as poles and wires by cleaning point cloud noise around their edges 

(Implemented using "Reconstruction ground-based LIDAR and projects with tall structures" preset).   

▪ Cleans sky background from photos looking at the horizon (Implemented using "Reconstruction sky 

background clean" preset).  

 

▪ Improved build results in low overlap, nadir projects – Fills in ground gaps in areas with low coverage 

(e.g., to sharpen building outlines and fill holes in the ground) by incorporating calculated ground 

surface (Implemented using "Reconstruction fill in ground" and "Reconstruction fill in ground and add 

walls" presets. Can be used together with the "Reconstruction mesh vertical bias" preset).  

▪ Improved color balancing – Enhances contrast of project photos using a Contrast Limited Adaptive 

Histogram Equalization (CLAHE) algorithm (Implemented using the “DataPrep local_brightness 

histogram correction for images (CLAHE)” preset. Other preset options include " DataPrep brightness 
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histogram correction for images” and “DataPrep color histogram correction for images”). 

▪ Optimized mesh and texture quality:  

▪ Sharper mesh edges and more triangles in areas of complex topology.  

▪ Fewer triangles in flat areas, which results in cleaner geometry and reduced file size and 

processing time.  

▪ Optimized mesh triangle count for each of the model’s levels of detail (LOD) produces a more 
accurate mesh in different viewing distances. 

▪ Better support for multi-band projects: 

▪ Provides the ability to select one or more bands for orthophoto texturing and any three bands for 

mesh model processing.  

▪ Improves color balancing for multi-spectral bands (NIR, thermal) by minimizing color artifacts. 

▪ Optimizes texturing algorithm performance by restricting texture generation to only bands that are 

in use. 

 

▪ Improved DSM quality – Smooths mesh model triangle artifacts when generating DSM raster output.   

▪ Improved control point use in aerotriangulation algorithm – Ground control and tie points are now 

assigned a stronger weight when performing aerotriangulation, to increase geographical accuracy in 

projects with unreliable inputted camera positions.  

▪ Improved Lidar textures – Improvements to Lidar color-based textures by applying a color smoothing 

algorithm. 
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Expanded Input and Output Support 

PhotoMesh 7.7 offers expanded input and output options, including all the following: 

Outputs:  

▪ New DSM to LAS tool exports the Digital Surface Model (DSM) output as colored point cloud model in 

LAS or LAZ format.  

 

▪ OBJ and DAE output models are now saved with single texture file per tile. 

▪ Enhanced options for orthophoto and Digital Surface Model (DSM) outputs: 

▪ Ability to define maximum tile size in pixels. 

▪ Ability to define grid origin.  

▪ Ability to define tile overlap in pixels. 

▪ Default coordinate system for all raster outputs changed to the local UTM zone in project area. 

▪ Aerotriangulation and reconstruction tile polygons saved as part of a project’s outputs.  

▪ Raster output (orthophotos, DSM & DTM) TIFFs can be saved as LZW lossless compression or as jpg 

compression.  
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Inputs 

▪ Fully support photo orientation in yaw/pitch/roll format. 

▪ Support reading photos directly from Amazon S3 buckets and behind HTTP servers (*not supported 

by the Gigapixel mechanism). 

▪ CSV/Text loader - Photo and photo collection information (e.g., sensor width, focal length, and 

aerotriangulation data) can now be loaded from a CSV file. 

▪ Phase One – Read photos in IIQ RAW file format that were created by Phase One sensors.  

Lidar Improvements 

PhotoMesh 7.7 features enhancements to Lidar display and functionality. Lidar data can be integrated 

with project photos to supplement project data and increase model accuracy. 

▪ Point cloud styling - Set point size, color and visibility based on point cloud attribute information.  

▪ Manage Lidar sources in a sortable, multi-edit list. 

▪ Display the Lidar's trajectory in the 3D Window.  

▪ Lidar files can now be loaded even after aerotriangulation is performed. If reconstruction had already 

started, all reconstruction tiles that intersect with the new Lidar’s bounding box are rebuilt 

automatically in the next project build. 

▪ Change Lidar coordinate system and automatically reconvert and import these Lidar files in the next 

project build. 
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Preset Mechanism 

PhotoMesh's build-preset mechanism has been enhanced to allow saving of only specific build settings 

as a preset, loading of multiple presets, and more. The preset mechanism makes it easy to automatically 

set the required parameters to generate the optimum output for the project’s data as well as to share 

user-defined build settings between projects.  

▪ Presets now include only changes from the default settings.  

▪ Users can control which step settings are saved (AT/ Reconstruction/ Output/ CS), so only changes 

to these steps are saved and loaded.  

▪ Multiple presets can be selected for a build, each of which defines settings for a different subset of 

the build steps. If selected preset files have conflicting properties or flags, the value from the last file 

on the list is applied.  

▪ New set of presets for different use cases (close range, optimization for special output formats and 

more).  

▪ GUI improvements include detailed descriptions of the selected presets, selection control to multi-

select presets for a project, and powerful management control to load, edit and delete presets.  

 

 

Manual Retouch 

Mesh imperfections, such as bumps, irregular surfaces, or floating artifacts, can be flattened, filled, and 

cleaned up directly in PhotoMesh using the Manual Retouch tool. This tool performs smart selection, 

taking your rough marking of floating artifacts, wires, or surfaces for flattening, analyzing the pixels, and 

determining the object it thinks you want within the rough selection. You can then further modify the 
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selection polygon and adjust the applied buffers. The output of the Manual Retouch tool is a polygonal 

feature layer with attribute information that defines what retouch action should be performed in each area: 

clean, flatten, and retexture. When rebuilding the project, PhotoMesh uses the manual retouch layer to 

add a set of constraints to the reconstruction algorithms. 

 

 

Project Queue  

Improvements to the Project Queue automation mechanism. The Project Queue is a REST API to create 

a project queue, and then activate, monitor, and manage the queue processing. 

▪ New script step type (python,JS) to analyze and manages the outputs of the queue processing. 

▪ New pause step type to pause a build so the user can inspect the result and add control/tie points 

and then resume the process. 

▪ Ability to load multiple presets, and support full path name for the preset location. 

▪ Ability to sort the queue. 
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AWS and Cloud Automation 

Improvements to the AWS fusers management mechanism to optimize your cloud resources: 

▪ Increased options for defining fuser allocation allow you to select the most cost-effective fuser 

solution for your build processing needs and steps. You can now define the instance type, AWS zone, 

Spot/On-Demand allocation type and even use GPU machines only when needed.  

▪ Support for instance startup script to dynamically allocate cloud resources needed for the build 

process (disk mount).  

▪ Better management of your cloud costs and reporting by supporting AWS tags by your manager and 

fuser instances.  
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Usability Enhancements 

New Item List 

The Item List provides a powerful and efficient method of viewing information about and working with the 

items in a Project Tree group: photos, Lidar, reconstruction tiles, AT tiles, manual retouch layers, 

manually created water polygons and every imported water polygon layer. You can easily perform a 

textual or geographic search of the list to find and select the item you need, and then perform a wide 

range of actions on the item using an easy-to-access right-click menu or ribbon commands.  

 

Enhanced Selection Tools 

PM 7.7's new point, polygon, and rectangle selection commands provide expanded options for selecting 

items in 3D Window by geographic location  

 

3D Tile Selection Modes 

New 3D tile selection modes allow you to view and inspect your project’s 3D mesh layer output while 

selecting the underlying AT and reconstruction tiles. 
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Tiles User Status Mechanism 

Using the new tile’s user status mechanism, user can inspect, and tag AT and reconstructions tiles using 

a set of colored flags to indicate what additional operations still need to be performed on the tile: rebuild, 

external retouch, editing, or control points. 

 

Cursor Selection Modes 

New "List" selection mode limits your selection to the item type of the List currently open, making it easier 

to select the precise item you want in the 3D Window, e.g., if you want to select a tile when the Tile List is 

open, clicking on a camera icon that is somewhat concealing your tile, will still select the tile below it. You 

can easily toggle between List selection and Global selection, which selects whatever PhotoMesh item 

you point to in the 3D Window. 

Depth Perception Mode 

Highlight depth changes in the 3D model to make it easier to recognize the model’s contours and shape. 

This can be particularly useful for an untextured model or point cloud without colors. 
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Drag and Drop 

New drag and drop capability let you easily open a new project or load photos, Lidar, control points, and 

video files. 

Import AT Area Polygon 

The AT area can now be set either by drawing a polygon or by importing an AT area polygon. 

New PhotoMesh Start Page 

New Start page makes it easy to access recent projects, training materials, videos, demo projects and more.  
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New Automation Dashboard 

The Automation Dashboard consolidates all your PhotoMesh automation capabilities and documentation 

in one, easy-to-access place: 

▪ Fusers Pool – Monitor and manage your fusers pool. The fusers pool is used to share fusers between 

several PhotoMesh master computers in your organization, using a distributed management 

approach.  

▪ Amazon Web Services (AWS) Instances – Monitor and manage your AWS instances. PhotoMesh can 

work with Amazon Web Services to scale project production up and down based on resource needs. 

AWS fuser instances can be dynamically launched whenever there are unassigned pending fuser 

tasks, to further accelerate model creation.  

▪ PhotoMesh API – View interactive documentation of the REST API for PhotoMesh Production. This 

API can be used to automate the production phases, e.g., load photo files or list, set AT and 

reconstruction areas, begin and manage a build, and create new build versions.  

▪ Project Queue API – View technical and interactive documentation of the REST API for project 

queues and open the Project Queue Manager. The Queue API can be used to create a project queue 

and then activate, monitor, and manage queue processing.  
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CHAPTER 4  THE PHOTOMESH WORKFLOW 

About PhotoMesh Workflow 

PhotoMesh converts standard 2D photographs into high-resolution, textured, 3D mesh models in a 

streamlined, step-by-step process: 

▪ Step 1: Imagery Acquisition 

▪ Step 2: Creating a PhotoMesh Project 

▪ Step 3: Loading Photos and Other Input Sources and Preparing the Project 

▪ Step 4: Managing Local, Pool, and AWS Fusers 

▪ Step 5: Building the Model 

▪ Step 6: Managing and Reviewing the Build 

Step 1: Imagery Acquisition 

The first step to creating a 3D model is imagery acquisition. All visible surfaces of the intended object or 

scene must be photographed from multiple overlapping viewpoints.  

The accuracy of the resulting 3D mesh model is affected by several factors including: input image 

resolution and quality, lens distortion, overlapping ratio, directionality, and lighting. While PhotoMesh 

optimizes the accuracy of the 3D mesh model by selecting the best photos for an area, each factor can 

affect the overall output or cause varying levels of accuracy and quality in different areas of a project. 

See the “Imagery Acquisition” chapter for more information. 
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Step 2: Creating a PhotoMesh Project 

Before beginning to work in PhotoMesh, you must create a new project or open an existing project. See 

“Creating and Opening a PhotoMesh Project” in the “Project Management” chapter for more information.  

Step 3: Loading Photos and Other Input Sources and Preparing the Project 

Photos and other input sources are loaded into a project using any of the following methods: 

▪ Load photo files from disk (JPG, TIF, IIQ). 

▪ Load an Excel/XML file with a list of photos, their file paths, all photo information (e.g., XYZ, 

OPK/YPR) and photo collection and camera information (e.g., focal length, sensor width, pixel size).  

▪ Load a CSV file with a list of photos, their file paths and XYZ and OPK/YPR photo information. 

▪ Load a PhotoMesh project. When a PhotoMesh project (.PhotoMeshXML) is loaded into a second 

project, only the project’s photos and photo and collection parameters are loaded. 

▪ Load a video from which PhotoMesh extracts individual image frames. 

▪ Import photos of different data types (e.g., Inpho, Bingo, Stellacore) into the project with their 

metadata (e.g., sensor width, focal length, and aerotriangulation data). When AT results are imported, 

the AT step of the build process can be skipped (by selecting “Fully trusted input” in the Camera 

Position Accuracy AT parameter).  
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▪ Load Lidar data in .las, .laz or .e57 formats into a PhotoMesh project, integrating it with project photos 

to supplement project data and increase model accuracy.  

See “Loading Photos” and “Importing Photos with Metadata” in the “Photo Management” chapter, and 

“Loading Lidar Data” in the “Lidar Management” chapter for information. 

After photos have been loaded, do any of the following to prepare the project for the build: 

▪ Modify photo and photo collection properties 

▪ Verify that the camera symbols generate the expected cluster form 

▪ Project photos on the terrain to see if they fit the terrain imagery or to better understand their position 

▪ Show Lidars on the terrain to see if they fit the terrain imagery or to better understand their position 

▪ Associate a Lidar with its trajectory data that provides information about the scanner’s position while 

capturing the point cloud 

▪ Improve the accuracy of the model’s position by creating ground control points that associate real-

world X, Y, Z coordinates with corresponding locations (in pixels) in photos 

▪ Establish a correspondence between project photos and improve aerotriangulation results by creating 

tie points in the same physical point in three or more photos 

▪ View photos in the photo viewer 

▪ Import or draw water body polygons to generate a flat surface with correct texturing over user-defined 

water bodies  

▪ Display the coverage map to identify which areas of the project have sufficient coverage and which 

require more 

▪ Create a subset AT area in which to validate camera parameters and build settings 

▪ Set a reconstruction area 

See “Modifying Photo and Photo Collection Properties” in the “Photo Management” chapter, “Working 

with Water Body Polygons” in the “Reviewing your Build” chapter and the “Lidar Management”, “Preparing 

the Project”, and “Control Points” chapters for information. 

Step 4: Managing Local, Pool, and AWS Fusers 

Fusers allow you to share the demanding workload involved in processing the different build steps (data 

preparation, AT, point cloud, mesh model, texture, 3DML/other outputs) between several computers on 

the same local network. The master computer utilizes the computing power of the network’s client 

computers by connecting to PhotoMesh fusers on the client machines.  

Fusers can be shared between several PhotoMesh Build Managers in your organization, enabling each 

machine running PhotoMesh to use the combined resources of all the machines in the pool. PhotoMesh 

can also work with Amazon Web Services (AWS), adding and terminating virtual fuser machines, to scale 

a project up and down based on resource needs. 

See “Installing PhotoMesh Fusers” and “Uninstalling PhotoMesh Fusers” in the “Getting Started” chapter 

for information on installing and starting the fusers. See “Fuser Management (on the Master computer)” 

and “Fuser Auto-Scaling” in the “Fusers” chapter for information on managing the fusers, and the "Getting 

Started with AWS" chapter for information about AWS fusers.  
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Step 5: Building the Model 

After all photos are added to the project and all properties are set as required, you can launch PhotoMesh 

Build Manager to begin the build process. The build process provides flexibility both with regard to the 

area of the project being built (entire or selected area) and the build steps that are to be performed. To 

achieve optimal results and avoid unnecessary rebuilding, it is recommended to initially perform only the 

aerotriangulation step (“AT Only”), and then review the results, to ensure a precise AT which includes all 

project’s photos that intersect with the AT area, before proceeding with the rest of the build. When an AT 

Only build is repeated following project adjustments, PhotoMesh determines precisely which tiles and 

which specific AT sub-processes were affected by the modification of properties or control points, 

enabling a much lighter and faster AT process. 

The build process involves the following steps: 

▪ Data Preparation  

▪ Conversion of photos to PhotoMesh's internal format (SMPT) 

▪ Conversion of Lidar to PhotoMesh's internal format (CPT) 

▪ Color correction of photos 

▪ Aerotriangulation 

▪ Reconstruction  

▪ Point Cloud Creation  

▪ Model Creation 

▪ Model Texturing  

▪ Project Output - Select all required output formats: 3DML (for loading directly into TerraExplorer and 

streaming with SkylineGlobe Server), DAE, OBJ, 3D Tiles, I3S/SLPK, OSGB, Orthophoto, DSM, 

DTM/DEM, and LAS (Point cloud public file format). See “Setting Output Formats” in the “Building” 

chapter for information on the different file formats. 

See the “Building” chapter for information. 

Step 6: Managing and Reviewing the Build 

Throughout the build process, you can monitor build progress from PhotoMesh Build Manager and view 

the build data already created in the PhotoMesh 3D Window. As soon as a build step is completed for a 

tile, its build data is viewable in the 3D Window, e.g. if aerotriangulation was performed, PhotoMesh can 

display the calculated camera positions in the 3D Window, and if reconstruction tiles were calculated, 

they can be displayed in the 3D Window, with each tile colorized according to the build step completed. 

You can also view point cloud, 3D model, and texture data for one or more tiles once this build step for 

the selected tile is completed. Build reports are available, as well, with statistical and graphical 

information about the build process. See "Reviewing Aerotriangulation (AT) and Reconstruction Tiles" in 

the "Reviewing Your Build" chapter for information. 

After a build is complete, water bodies can be defined by drawing or importing a water body polygon, and 

mesh imperfections, such as bumps, irregular surfaces, or floating artifacts, can be marked for flattening, 

filling, and clean up using the Manual Retouch tool. See "Working with Water Body Polygons" and 

"Marking a Mesh Layer for Retouching" in the "Reviewing Your Build" chapter for information.  

After reviewing build data, you can easily rebuild any of the following: the entire project, error tiles, or 

selected tiles. See “Monitoring a Build” in the “Building” chapter and the “Reviewing Your Build” chapter 

for information. Alternatively, you can create a new build version with different project steps and different 
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build parameters. You have the option to create a completely new build version or one which copies the 

AT information from the previous build, thereby accelerating the build process. See “Creating a New Build 

Version” and “Creating a New Build Version with a Copy of the Current Aerotriangulation Results” in the 

“Building” chapter for information. 

Before rebuilding, 3D models can be exported when necessary to external software, such as Autodesk® 

MeshMixer, to perform certain edits, e.g. to remove a particular building that is being torn down, flatten 

surfaces and correct certain imperfections such as bumps or irregular surfaces, or edit textures, and then 

reimported to PhotoMesh. See the “Importing and Exporting Models” chapter for more information.  
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CHAPTER 5  BASIC CONCEPTS 

Overview 
This chapter addresses the following topics: 

▪ Start Page 

▪ Application Layout 

▪ Error/Message Log 

▪ PhotoMesh Ribbon 

▪ Setting the Display of the 3D Window 

▪ Saving a Project 

▪ Undoing/Redoing an Action 

▪ Selecting Objects in the 3D Window 

▪ Dragging and Dropping Files in PhotoMesh 

▪ Setting PhotoMesh Options 

▪ Coordinate System Advanced Capabilities 

Start Page 

The Start Page is the first page you see after opening PhotoMesh from the Program Files menu or from 

the desktop icon. The Start Page also appears after you close your current project. 

When you start PhotoMesh by selecting a .PhotoMeshXML file or link, PhotoMesh opens the project 

directly and does not show the Start Page.  
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Start page options: 

▪ New Project – Opens a dialog box in which you can create a new project. 

▪ Open Project – Opens a dialog box in which you can browse to a project file. 

▪ Automation Dashboard – Opens PhotoMesh's automation center, from where you can do all the 

following: 

▪ Fusers Pool – Monitor and manage fusers in your fusers pool. 

▪ AWS Instances – Monitor and manage your AWS instances. 

▪ PhotoMesh API – View interactive documentation of the REST API for PM Production. 

▪ Project Queue API – View technical and interactive documentation of the REST API for project 

queues and open the Project Queue Manager. 

▪ Support Center – Opens Skyline's knowledge base, a centralized repository of information about 

PhotoMesh. 

▪ Videos of major PhotoMesh Features – Opens Skyline's YouTube channel with videos 

demonstrating PhotoMesh key features. 

▪ Recent Projects – Opens one of your recent PhotoMesh projects. 

▪ Example Projects – Download one of the ready-to-build example projects in PhotoMesh, and follow 

the instructions to get started building.  

▪ Contact Business and Sales – Opens the Contact Skyline page on Skyline's website. 

▪ Technical Support – Opens the Skyline Technical Support page on Skyline's website. 

▪ License Agreement – Displays the PhotoMesh software license agreement on the main window. 

https://support.skylinesoft.com/hc/en-us/categories/360002453079-PhotoMesh
https://www.youtube.com/watch?v=1UPjNIzncN4&list=PLIhGyqtf4NhkaBRZTHZPgajLHzeyNE0Nc
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Automation Dashboard 

 

From PhotoMesh's Start page, you can access PhotoMesh's Automation Dashboard, from which you can 

control all the following: 

▪ Fusers Pool – Monitor and manage fusers in your fusers pool: 

▪ Change pool settings: Active / Not active, and maximum number of fusers. Click Settings to open 

the Auto Scaling Fusers Settings dialog to change the pool status, pool folder, or maximum 

fusers. See "Using a Fusers Pool" in the "Fusers" chapter for more information. 

▪ Manage the fusers pool. Click View Pool to open the Pool Manager with information on all the 

fusers in the pool. See "Managing a Fusers Pool" in the "Fusers" chapter for more information 

▪ Click Help  to open the relevant section in Skyline's online knowledge base.  

▪ AWS Instances – Monitor and manage your AWS instances: 

▪ Change AWS fuser settings: Active / Not active, and maximum number of instances. Click 

Settings to open the Auto Scaling Fusers Settings dialog to use/stop using AWS Instances, 

change maximum instances or other AWS settings. See "Using Amazon Web Services (AWS) 

Fusers" in the "Fusers" chapter for more information. 

▪ Click Help  to open the relevant section in Skyline's online knowledge base.  

▪ PhotoMesh API – View interactive documentation of the REST API for PM Production. See 

"PhotoMesh API" in the "PhotoMesh Automation" chapter for more information. You can do all the 

following: 

▪ Click Reference Guide to view interactive documentation of the REST API for PM Production. 
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▪ Click Help  to open the relevant section in Skyline's online knowledge base. 

▪ Project Queue API – View technical and interactive documentation of the REST API for project 

queues and open the Project Queue Manager. See "Queue API" in the "PhotoMesh Automation" 

chapter for more information. You can do all the following: 

▪ Click Reference Guide to view technical and interactive documentation of the REST API for 

project queues. 

▪ Click Project Queue to open the Project Queue Manager. 

▪ Click Help  to open the relevant section in Skyline's online knowledge base. 

Application Layout 

The PhotoMesh display includes five primary panels:  

Panel Description 

3D Window The main working area for various actions including preparing, monitoring, and 
reviewing the build. 

Project Tree Provides access to the items in the project. See “Using the Project Tree and Item 
List” chapter for further information. The Project Tree has the following groups:  

▪ Photos – Includes all the photo collections loaded into the project. Information 
about the each of the photos in each collection is available from the Photos 
List. 

▪ Lidars – All the Lidars in the project are listed in the Lidars List. 

▪ Control Points – Includes all control points in the project.  

▪ AT Tiles – All the AT tiles created in the current build (only visible in Review 
mode) are listed in the AT Tiles List. 

▪ Reconstruction Tiles – All the reconstruction tiles created in the current build 
(only visible in Review mode) are listed in the Reconstruction Tiles List. 

▪ Retouch Layers – Includes a Manual Retouch layer, a Water Polygons 
(Manually Created) group, and all the Water Polygons (Imported) layers. 

▪ Manual Retouch – All the manual retouch polygons are listed in the 
Manual Retouch List.  

▪ Water (Manually Created) – All water polygons are listed in the Water 
(Manually Created) List. 

▪ Water (Imported) – For each imported water polygon layer, all water 
polygons are listed in the respective Water (Imported) List. 

▪ Objects and Layers – Includes all terrain objects: locations, imagery layers, 
elevations layers, 3DML and modify terrain/hole on terrain objects and some of 
the project outputs: 3DML, AT Calculated Photos, AT Tiles, DSM, DTM, and 
Orthophoto. These outputs are added to the Project Tree when a build is 
finished, and can be opened in TerraExplorer directly from the Project Tree’s 
shortcut menu. The Project Tree’s shortcut menu also provides an option to 
access to any of the project’s outputs by opening the location of the project’s 
output folder.  

List Displays a list of all the items in the currently selected Project Tree group, and 
information about each item. The Item List is displayed for the following groups: 
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photos, Lidars, reconstruction tiles, AT tiles, manual retouch layers, manually 
created water polygons and every imported water polygon layer.  

Properties Displays data relating to the currently selected photo collection, photo, control 
point, or water polygon layer.  

Note: Lidar point cloud and terrain object properties are not displayed in the 
property sheet panel. You can view Lidar point cloud properties by right-
clicking the Lidar in the Lidar List, and selecting Style Point Cloud. You 

can view terrain object properties by clicking Edit  in the Properties 
field.  

See “Modifying Photo and Photo Collection Properties” in the “Photo Management” 
chapter, "Editing Control Points" in the "Control Points" chapter, and "Setting 
Water Body Polygon Properties" in the "Reviewing your Build" chapter for 
information.  

Error/Message 
Log 

Records and displays warnings, messages, and errors to help you troubleshoot 
any PhotoMesh issue. 

See “Error/Message Log” in this chapter for more information. 

You can create the application layout that is most convenient for you by repositioning or auto-hiding any 

of the panels, besides the 3D Window, on the screen.  

Floating/Docked Windows 

To reposition a panel: 

 Click the panel's title bar and drag the panel from its current location. A guide diamond with four 

arrows appears.  

 If you want the panel to float in front of the other application panels, drag it to the desired location. 

 If you want to dock the panel, do the following: 

a. Drag the panel towards the location where you want to dock it, and then rest the cursor on the 
guide diamond arrow that best corresponds to the desired docking location. A shaded blue outline 
of the panel appears in the area where the panel will dock.  

b. Release the mouse button to dock the panel in the area indicated. 

Auto-Hide 

When a panel is in auto-hide, a tab appears on an edge of the screen that controls the panel’s display. 

When the cursor rests on the tab, the panel displays, and when it is moved away from the tab and the 

displayed panel, the panel disappears.  

To auto-hide a panel, click the pushpin icon  on the panel’s title bar. 

To view an auto-hidden panel: 

▪ Move the cursor over the panel’s tab.  

Note: If you want to hide the panel again, move the cursor off the panel. 

To restore a panel from auto-hide, click the pushpin icon  on the panel’s title bar.  

Error/Message Log 

The PhotoMesh log records and displays warnings, messages, and errors to help you troubleshoot any 

PhotoMesh issue. Logs can be exported and sent to Skyline support: 

▪ Errors – Alerts users of critical problems. 
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▪ Warnings – Alerts users of conditions they should be aware of, which might cause problems in the 

future.  

▪ Messages – Records various activities.  

Viewing the Log 

To view the log: 

 

Error, Warning, and Message Log 

▪ Click the Errors, Warnings, and Messages buttons to toggle the display of their respective 

messages on and off.  

Clearing the Log 

To clear the log: 

▪ At the top of the log, click Clear Log.  

Stop Logging  

To stop logging: 

▪ At the top of the log, click Stop Logging. 

Auto-Hiding the Log 

To auto-hide the log: 

▪ Click the pushpin icon  on the panel’s title bar. 

To view the auto-hidden log: 

▪ Move the cursor over the panel’s tab.  

Note: If you want to hide the panel again, move the cursor off the panel. 

To restore the log from auto-hide: 

▪ Click the pushpin icon  on the panel’s title bar.  

PhotoMesh Ribbon  

The following commands are available from the PhotoMesh button  located at the upper left hand 

corner of the application:  
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Commands Shortcut Key Activity 

New CTRL+N Creates a new PhotoMesh project. See 
“Creating and Opening a PhotoMesh Project” 
in this chapter for information.  

Open CTRL+O Opens an existing PhotoMesh project. See 
“Creating and Opening a PhotoMesh Project” 
in the "Project Management" chapter for 
information.  

Close  Closes the open PhotoMesh project. 

Save CTRL+S Saves the current project. See “Save Project” 
in this chapter for information. 

Resources  Opens resources that display license 
information, basic application information, or 
help files. See "PhotoMesh Resources" in the 
"Introduction" chapter for information. 

 

Home Tab 

The Home tab contains commands for setting up your project (setting build settings, adding photos to a 

project, setting photo display on the terrain, and setting the aerotriangulation and reconstruction areas), 

building the 3D model, and reviewing your project. 

 

Home Tab  

Group Description 

Select See "Selecting Objects in the 3D Window" in the "Basic Concepts" 
chapter. 

Add  See “Loading Photos” in the “Photo Management” chapter, 
“Loading Lidar Data” in the “Lidar Management” chapter, “Setting 
the Terrain Database” in the “Project Management” chapter, 
“Working with Water Body Polygons” in the “Reviewing your Build” 
chapter, “Importing a Model” in the “Importing and Exporting 
Models” chapter and the “Control Points” chapter. 

Photos See “Displaying Camera Symbols” and “Showing the Coverage 
Map” in the “Preparing the Project” chapter. 

Area See “Setting the AT Area” and “Setting the Reconstruction Area” in 
the “Preparing the Project” chapter. 

Build See the “Building” chapter and “Managing Build Versions” in the 
“Reviewing Your Build” chapter. 

Review See the “Reviewing Your Build” chapter. 
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View Tab  

The View contains commands for changing your units and view in the 3D Window. 

 

View Tab 

Group Description 

Photos See “Displaying Camera Symbols” and “Selecting Camera Symbol Size and 
Color” in the “Preparing the Project” chapter. 

Environment See “Setting the Display of the 3D Window” in this chapter. 

Units See “Units” in this chapter.  

Mesh Layer See “3DML Display Style Options” in the “Reviewing Your Build” chapter. 

Reconstruction 
Tiles 

See "Setting a Reconstruction Tile's Selection Style" and “Displaying User 
Status Flags and Legend” in the “Reviewing Your Build” chapter. 

 

Tools Tab 

The Tools tab provides a set of TerraExplorer analysis tools that help you validate photo parameters. It 

also contains terrain objects and layers that can be added to a PhotoMesh project and a command for 

connecting to SkylineGlobe Server. 

 

Tools Tab 

Group Description 

Measure See the “Analysis Tools” chapter. 

SkylineGlobe See “Connecting to a SkylineGlobe Server” in the “Working with 
SkylineGlobe Server” chapter. 

Objects and Layers See the “Adding Terrain Objects and Layers” chapter. 

Coordinate System See “” in the “Basic Concepts” chapter.  

Fuser Automation See “Fuser Auto-Scaling” in the “Fusers” chapter and the 
“PhotoMesh Automation” chapter. 

Tiles See “Viewing Aerotriangulation (AT) Tiles” and “Viewing 
Reconstruction Tiles” in the “Reviewing Your Build” chapter. 
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Photo Tab  

The Photo (contextual) tab contains tools for viewing the project’s photos. This tab is displayed when a 

photo is selected in the photo list. 

 

Photo Tab 

Group Description 

Navigation See “Navigating to a Photo” in the “Preparing the Project” chapter. 

View See “Viewing Photos in the Photo Viewer” and “Projecting a Photo on the 
Terrain” in the “Preparing the Project” chapter. 

Selection See “Displaying Camera Symbols” in the “Preparing the Project” chapter and 
“Excluding a Photo”, and “Deleting a Photo” in the “Photo Management” 
chapter.  

Tie Point See “Creating Tie Points” in the “Control Points” chapter. 

 

Lidar Tab 

The Lidar (contextual) tab is displayed when a Lidar file is selected and it provides tools for viewing the 

Lidar data.    

 

Lidar Tab 

Group Description 

Navigation See “Navigating to a Lidar” in the “Lidar Management” chapter. 

View See “Showing a Lidar Point Cloud on the Terrain” in the “Lidar Management” 
chapter. 

Selection See “Showing a Lidar Point Cloud on the Terrain”, “Excluding a Lidar”, and 
“Deleting a Lidar” in the “Lidar Management” chapter.  
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Tile Tab 

The Tile (contextual) tab is displayed when either an AT or reconstruction tile is selected and it provides 

tools for displaying and exporting the different steps of the build output. The commands included in the 

tab depend on whether an AT or reconstruction tile is selected.  

 

Reconstruction Tile Tab 

 

 AT Tile Tab 

Group Description 

View See “Navigating to a Tile”, “Viewing a Tile’s Build Report”, and 
“Viewing an Aerotriangulation Tile’s Detailed Report” in the 
“Reviewing Your Build” chapter.  

Calculated Photos See “Displaying Calculated Camera Positions for Tiles” in the 
“Reviewing Your Build” chapter. 

Original Photos See “Displaying Original Camera Positions for Tiles” in the 
“Reviewing Your Build” chapter. 

User Status See “Selecting Tiles" and "Viewing Tile Information in the Tile 
List" in the “Reviewing Your Build” chapter for information. 

Sparse Point Cloud See “Viewing an Aerotriangulation Tile’s Sparse Point Cloud” in 
the “Reviewing Your Build” chapter. This group only displays 
when an AT tile is selected. 

Show See “Displaying Reconstruction Tile Results” in the “Reviewing 
Your Build” chapter. This group only displays when a 
reconstruction tile is selected. 

Import See “Importing a Model” in the “Importing and Exporting Models” 
chapter. This group only displays when a reconstruction tile is 
selected. 

Export See “Exporting a Point Cloud” and “Exporting a Model” in the 
“Importing and Exporting Models” chapter. This group only 
displays when a reconstruction tile is selected. 

Control Point Tab 

The Control Point (contextual) tab provides commands for working with control points and marking the 

position of control points in photos. 
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Control Point Tab 

Group Description 

Navigation See “Navigating to a Control Point” in the “Control Points” 
chapter. 

Manage See “Editing Control Points” and “Marking Control Points in 
Photos” in the “Control Points” chapter.  

Selection See “Hiding Control Point Symbols”, “Excluding Control Points”, 
and “Deleting Control Points” in the “Control Points” chapter.  

Shortcut Keys  

Most commands can be activated through a shortcut key combination (KeyTip) that appears on the 

Ribbon when you press the ALT key.  

Note: Some alternate shortcut keys appear in this documentation in parentheses in the section where 

the command is explained. 

To use KeyTips: 

 Press ALT. The KeyTips are displayed over each main tab and over each command on the Quick 

Access toolbar. 

 

PhotoMesh KeyTips  

 Press the letter or number shown in the KeyTip over the tab/command that you want to use.  

 If you pressed a letter over one of the tabs, that tab is displayed showing KeyTips over the enabled 

commands. Press the letter of the required command.  

Note: Pressing ALT a second time hides the KeyTips.  

Quick Access Toolbar 

The Quick Access toolbar is a customizable toolbar that contains a set of commands that are 

independent of the tab that is currently displayed.  

Commands can be added or deleted from the Quick Access toolbar, according to each user’s needs and 

convenience.  
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Adding/Deleting Commands from the Quick Access Toolbar 

The Quick Access toolbar can be customized in two ways: 

▪ By right-clicking the required commands on each tab. 

Note: This method is recommended for addition/deletion of just a few commands.  

▪ By opening a dialog box in which you select the commands to include in the Quick Access toolbar. 

Note: This method is recommended for extensive modification of the Quick Access toolbar. 

Adding/Deleting Commands by Right-Clicking 

To add or delete a command: 

 If you want to add a command to the Quick Access toolbar, do the following: 

a. On the required tab, right-click the command you want added to the Quick Access toolbar. 

b. From the shortcut menu, select Add to Quick Access Toolbar. The command is added to the 
Quick Access toolbar. 

 If you want to delete a command from the Quick Access toolbar, do the following: 

a. On the Quick Access toolbar, right-click the command you want to delete. 

b. From the shortcut menu, select Remove from Quick Access Toolbar. The command is deleted 
from the Quick Access toolbar. 

Adding/Deleting Commands Using the Customize Dialog Box 

To add or delete commands from the Customize dialog box: 

 Right-click anywhere on the Ribbon. 

 From the shortcut menu, select Customize Quick Access Toolbar. The Customize dialog box is 

displayed.  

 From the Choose commands from drop-down list, select the Ribbon group whose commands you 

want to add or remove from the Quick Access toolbar.  

The Commands section displays all of the commands that are available on the selected option. The 

section on the right side of the dialog box displays all the commands that are presently included on 

your Quick Access toolbar. 

 If you want to add a command, select it in the Commands list and click Add. 

 If you want to remove a command, select it in the section on the right side of the dialog box, and click 

Remove. 

 If you want to change the order in which the commands are displayed on the Quick Access toolbar, in 

the section on the right side of the dialog box, drag the command to the desired position. 

Note: The default commands included in the Quick Access toolbar are: Save, Undo and Redo. 

 Click OK. 

Setting the Display of the 3D Window 

You can control the view, layout, and overlay of the 3D Window. This includes the display of several 

controls and indicators to orient you, options for creating a more realistic 3D World environment, and 

options for displaying the 3D model: 

▪ Navigation Controls  
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▪ Status Bar 

▪ Date and Time Slider 

▪ Sun 

▪ Underground Mode  

▪ Units 

▪ Hide Terrain 

▪ Mesh Model Display Style 

▪ Highlight Depth Changes 

Navigation Controls  

The navigation controls and virtual joystick enable you to zoom in or out or turn the plane to face north.  

   

Navigation Controls 

To navigate in the 3D Window using the navigation control:  

▪ Click the navigation controls to turn North or zoom in or out of the terrain. 

Navigation 
Control 

Description 

 
Turn the plane to face north. 

 
Zoom in. 

 
Zoom out. 

 

Status Bar 

The status bar displays: 

▪ The longitude, latitude, altitude, and direction of the plane/camera. Clicking on the status bar opens 

the Jump to Location dialog box. See the “Navigating in the 3D World” chapter in the TerraExplorer 

manual for further information.  

▪ The current terrain buffering level in a graphical format. The display quality indicator represents the 

current terrain resolution for the area shown in the 3D Window, compared to the estimated maximum 
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resolution available in the terrain database. The graphic bar indicates values from 0%-100% of 

quality. 

 

Status Bar 

Sun 

You can turn the sunlight source on or off. When turned on, the sun is used as the project's light source 

and affects the lighting on the terrain and on building objects. 

To toggle the sunlight source on/off: 

▪ On the View tab, in the Environment group, click Sun. 

Date and Time Slider  

The Date and Time Slider enables you to modify the current date and time so you can view each area of 

terrain in the date and time that you require. If the sun is used as the project’s light source, the displayed 

light on the terrain corresponds to the sunlight there is on the terrain at the hour and date indicated by the 

blue marker on the slider.  

To use the Date and Time slider: 

 On the View tab, in the Environment group, click Time Slider. The Date and Time slider is displayed 

on the upper left corner of the 3D Window. 

 

Date and Time Slider 

 Click the Date and Time Settings  icon to the right of the slider to select a mode. The Date and 

Time Setting dialog box is displayed. 
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Date and Time Setting Dialog Box 

 Select one of the following time zones. The time zone you select determines which time zone is used 

for the time you select in the Date and Time Setting section in the same dialog box.  

▪ My computer – Your local time zone.  

▪ UTC (coordinated Universal Time) – UTC time (GMT + 0:00). 

▪ Specific – The time zone you select from the drop-down list.  

 Control the interval of time for which you can view objects and features with timespans by selecting a 

date and time range for the date/time slider:  

▪ Project time range  

 

The slider’s time range corresponds to the project’s time range. Date and hour adjustments are 

both made on the same slider.  

▪ Always use <> at viewer position  
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The slider’s time range is 24 hours.  

This option also requires you to select a specific time that will be the default current time (until the 

time is changed on the slider).  

▪ One year range (two sliders)  

 

The time slider’s range is 24 hours and the date slider’s range is one year.  

 If you want the date and time sliders ranges to automatically readjust to correspond to the timespan 

of the selected group, select the Automatically adjust range to selected group check box. 

Note: This option does not apply in PhotoMesh. 

 Set the project’s current time and date or time range.  

Note: The current date and time can only be set when Project time range is selected above and 

there are objects or groups in the project for which timespans were set.  

▪ If you want to set a specific current time and date, set the same Start and End Date and Time. 

The blue marker and yellow arrow are displayed together on the slider .  

▪ If you want to set a current time range so that all objects and features whose timespans fall 

anywhere in the range display, set a Start Date and Time, and then set an End Date and Time. 

The blue marker on the slider indicates the Start Date/Time and the yellow arrow indicates the 

End Date/Time .  

Note: Start and end date and time must be within the project range.  

Underground Mode 

The underground navigation mode allows you to explore the subsurface of the terrain. You can navigate 

under the terrain’s surface and through buildings. A subsurface grid navigation aid appears when you 

navigate below the terrain, allowing you to navigate the same way as above ground. 

To fly in underground mode: 

▪ On the View tab, in the Environment group, click Underground Mode. You can freely go through 

the terrain surface in any direction. 

Units 

You can change the units used throughout PhotoMesh. Changing the unit settings substantially changes 

the display of your project: inputs and outputs and property sheets are all affected.  

To change units: 

▪ On the View tab, in the Units group, select the coordinate units and altitude: 
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Parameter Description 

Lat-Long Coordinates 

Decimal  Presents coordinate values in a decimal degrees format. This 
option is only available when the terrain is defined in the Lat/Long 
coordinate system. 

Degrees; Minutes; Seconds Presents coordinate values in a degrees, minutes and seconds 
format. This option is only available when the terrain is defined in 
the Lat/Long coordinate system. 

Altitude Units 

Above Ground Level (AGL) Displays altitude values as meters or feet above ground level.  

Absolute Values  Displays altitude values as meters or feet above the terrain 
database vertical datum base ellipsoid.  

Hide Terrain 

You can hide the terrain texture (the terrain appears as a black image). 

To toggle the display of the terrain on/off: 

▪ On the View tab, in the Environment group, click Hide Terrain. 

Display Style 

There are several options for displaying the mesh model once it is built. The mesh model can include a 

wireframe and be textured or solid color. to view the interior of buildings or expose obscured sections of 

the 3D View. 

To select a display style: 

▪ On the View tab, in the Mesh Layer group, click Display Style, and select a style: 

▪ Texture  

▪ Texture + wireframe  

▪ Solid color  

▪ Solid color + wireframe  

Depth Perception 

You can highlight depth changes in the 3D model to make it easier to recognize the model’s contours and 

shape. This can be particularly useful for an untextured model or point cloud without colors. 

To highlight depth changes: 

▪ On the View tab, toggle on Depth Perception. 

Saving a Project 

You can save a project and its system information. 

Save Project 

To save a project:  

▪ Click the PhotoMesh button, and then click Save (Ctrl + S). 
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Undoing/Redoing an Action 

You can undo and redo up to 100 actions in PhotoMesh. 

To undo a single action: 

▪ On the Quick Access Toolbar, click Undo  (<CTRL> Z). 

To undo multiple actions: 

 Click the arrow next to Undo. 

 Select the actions you want to undo, and then click the list. All the selected actions are undone. 

To redo the last action that you undid: 

▪ On the Quick Access Toolbar, click Redo  (<CTRL> Y). 

To redo multiple actions that you undid: 

 Click the arrow next to Redo. 

 Select the actions that you want to redo, and click the list. All the selected actions are redone. 

Selecting Objects in the 3D Window 

Two selection modes are available for selecting objects in the 3D Window: Global Selection and List 

Selection. Use Global Selection to select whichever PhotoMesh item you point to in the 3D Window. Use 

List Selection to limit your selection to only the item type of the list currently open, e.g., if the tile list is 

open, and you click in the 3D Window on a camera icon, the tile below it is selected.  

 

To change the selection mode: 

▪ On the Home tab, in the Select group, toggle on Global Selection or List Selection. 

Dragging and Dropping Files in PhotoMesh 

PhotoMesh’s drag and drop capability supports project files, all photo and Lidar formats, control point 

lists, and video files. A single or multiple files can be dragged and dropped anywhere on the 3D Window.  

File Type How Loaded 

.photmeshxml (project already open) Open project file 

.jpg .jpeg .jp2 .j2k jpc .tif .tiff, folder Load photo or all photos in folder 

.las .laz e57, folder Load Lidar or all Lidar in folder  

.gcp Import control point data. 

.asf, .wmv, .mp4, .avi, .fly, .mpg, .ts, .mov (only a single 
file at a time) 

Load video. 

 

Setting PhotoMesh Options 

Default system settings for PhotoMesh are set from the Options dialog box. 

To modify PhotoMesh Options: 

 Click the PhotoMesh button, and click Options (F9). 
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Options Dialog Box 

 Modify the following settings as required: 

Parameter Description 

General Preferences 
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Working Folder The working folder that PhotoMesh Build Manager (on the master 
computer) and PhotoMesh fusers use to communicate: to deposit 
and collect pending tasks, and share information about fuser 
availability, status and progress.  

The working folder should be set to a network folder with read-
write access permissions, for both the master and client 
computers. See “Setting the Working Folder (on the Master 
Computer)” in the “Fusers” chapter for information. Click Browse 
to browse to a different working folder, and then click Select 
Folder. 

Preset Manager Click Open to open the Preset Manager to load or manage preset 
files. See “Working with Presets” in the “Building” chapter for 
information. 

Defaults for New Projects 

Terrain Database Default MPT (local or remote) or .FLY to use as the base project 
when creating new project. Click Browse to browse to a different 
terrain database, and then click Open. 

Note: If a project is open, changes to the terrain database will 
take effect only after saving the project file and reopening 
it.  

Terrain Vertical WKT Well-Known Text of vertical datum of terrain database.  

Note: You can use the Coordinate System Generator to generate 
a WKT string defining the required coordinate system. 
Only enter the Vert_CS entity of the WKT in this field. See 
"Coordinate System" in the “Basic Concepts” chapter for 
information. 

Camera Symbol Size Select the size of the camera symbols that display for each photo. 

DJI Altitude 

 

Select the DJI altitude information to read from the metadata 
encoded in the photo files: 

▪ Load Absolute – Load the absolute altitude values. 

▪ Load Relative – Load the relative altitude values, and define 
altitude offset based on the terrain elevation at the position of 
the first photo in each collection. 

Load Hyperspectral Bands Select the check box to load hyperspectral bands for photos. 

Display 

Original Position The camera symbol’s color for photos in the original position. Click 
Change to select a different color, and then select the color. 

Calculated Position The camera symbol’s color for photos in the calculated position. 
Click Change to select a different color, and then select the color. 

Failed to Calculate The camera symbol’s color for photos whose position PhotoMesh 
was unable to calculate. Click Change to select a different color, 
and then select the color. 

Excluded  The camera symbol’s color for photos manually excluded by the 
user or outside the project crop area. Click Change to select a 
different color, and then select the color. 

Point Cloud Point Size Enter the maximum size, in pixels, to display each point. 



 

70 

PhotoMesh User Guide 

Show legend in review mode Select the check box to display AT Tile and Reconstruction Tile 
legends in the 3D Window when in review mode, which indicate 
what color is associated with each AT and Build status.  

Calculate AT Tile Area 

Set AT area to include PhotoMesh can automatically calculate the AT area based on all 
the project’s photos plus a buffer. The automatic AT area’s buffer 
can be based on the collections’ largest effective range, i.e., the 
maximum distance from the camera for which photo information is 
considered valid for aerotriangulation, or on a buffer you set. 

Select one of the following options: 

▪ Photo collections' effective range - Calculate the AT area 
based on the positions of all the project’s photos plus a buffer 
that is based on the collections’ largest effective range. 

▪ Use buffer of - Calculate the AT area based on the positions 
of all the project’s photos plus the buffer that you set. 

Tile Bottom Buffer When splitting photos into AT tiles, photos whose frustum 
intersects with a box that defines the AT tile are included in the tile. 
This box’s base is defined by the AT area's minimum terrain 
elevation minus the Tile Bottom Buffer value (in meters).  

Tile Top Buffer When splitting photos into AT tiles, photos whose frustum 
intersects with a box that defines the AT tile are included in the tile. 
This box’s top is defined by the AT area's maximum terrain 
elevation plus the Tile Top Buffer value (in meters). 

Maximum Photos Per Tile Maximum number of photos that can be included in an AT tile, 
even if the Do Not Split If Sum Exceed or Do Not Split If Child 
Exceed properties (below) are met. 

Note: When a tile is split, some photos will be included in both 
sub-tiles, based on frustum area.  

Do Not Split If Sum Exceed In cases where splitting a tile into sub-tiles, based on Maximum 
Photos Per Tile, results in a significant number of photos that are 
included in both tiles, it may not be desirable to split the tile. This 
property sets the maximum percent the sum of the photos in the 
sub-tiles can exceed the photos in the original tile. If the percent 
increase exceeds this value, the tile will not be split into sub-tiles 
even though Maximum Photos Per Tile was exceeded.  

Do Not Split If Child Exceed In cases where splitting a tile into sub-tiles, based on Maximum 
Photos Per Tile, results in sub-tiles that are nearly as large as the 
original tile, i.e., a significant number of photos were included in 
both tiles, it may not be desirable to split the tile. This property sets 
the maximum percentage (of the original tile) for either sub-tile 
after the split. If either of the sub-tiles exceeds this value, the tile 
will not be split into sub-tiles even though Maximum Photos Per 
Tile was exceeded.  

Photo Frustum Buffer When splitting photos into AT tiles, photos whose frustum volume 
intersects with a box that defines the AT tile are included in the tile. 
This property lets you increase or decrease the frustum volume by 
a set percent. 

Fully Trusted Max GP Maximum number of gigapixels per AT tile for fully trusted input 
data when aerotriangulation is not performed. See "Importing 
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Photos with Metadata" in the "Photo Management" chapter for 
more information on fully trusted data. 

User Status 

AT Tile Select the name and color to represent each of the user status 
options in the AT Tiles List. The user status indicates what actions 
still need to be performed on the tile, e.g., rebuild or control points. 
See “Selecting Tiles" and "Viewing Tile Information in the Tile List" 
in the “Reviewing Your Build” chapter for information. 

Reconstruction Tile Select the color to represent each of the user status options in the 
Reconstruction Tiles List. The user status indicates what actions 
still need to be performed on the tile, e.g., rebuild, editing or 
external retouch. See “Selecting Tiles" and "Viewing Tile 
Information in the Tile List" in the “Reviewing Your Build” chapter 
for information. 

  

Coordinate System 

A coordinate system is a reference system used to represent the locations of project data within a 

common coordinate framework. A coordinate system can be projected (X, Y), geographic (latitude-

longitude), or geocentric (X, Y, Z). Each coordinate system is associated with its Well-Known Text (WKT) 

description, a simple structured, text-based format for spatial reference system information that is easy to 

store and share between systems (See http://www.geoapi.org/2.0/javadoc/org/opengis/referencing/doc-

files/WKT.html). A coordinate system can optionally include a vertical datum that defines the origin for 

height values.  

When you add input data to a project, PhotoMesh reprojects the various inputs to the AT’s project 

coordinate system and eventually to the output’s coordinate system. The inputs and other project 

information (e.g., calculated photos and output previews) are also reprojected to the 3D Window’s Lat-

Long WGS84 coordinate system (with vertical datum if provided). If an input source does not include 

coordinate system information or PhotoMesh is unable to read this information, you must supply it so that 

PhotoMesh can reproject the source. Usually, the data supplier provides the information about the 

coordinate system used for each source.  

The Coordinate System dialog box is used to define the coordinate system for all project data. 

When data is in Lat-Long WGS84 or ECEF coordinate system and no other coordinate system was used 

for photos and ground control points, etc., the default system used is the Universal Transverse Mercator 

(UTM) grid system with the UTM zone based on where the center of the data falls. 

 

To set the coordinate system: 

 Open the Coordinate System dialog box.  

http://www.geoapi.org/2.0/javadoc/org/opengis/referencing/doc-files/WKT.html
http://www.geoapi.org/2.0/javadoc/org/opengis/referencing/doc-files/WKT.html


 

72 

PhotoMesh User Guide 

 

Coordinate System Dialog Box 

 Enter the coordinate system information using one of the following methods: 

▪ Click History and select one of the recently used coordinate systems. The last 20 coordinate 

systems used are saved in the History for future use. 

▪ In the Search field, type the EPSG code or a phrase from the Coordinate system Description, as 

indicated by the supplier, and click Search. Then select the required result from the search 

results displayed directly below. 
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▪ In the Well-Known Text section, type the WKT. The Well-Known Text representation of spatial 

reference systems, regulated by the Open Geospatial Consortium (OGC), provides a standard 

textual representation for coordinate system information. You can edit an existing WKT. 

Note: A custom coordinate system is listed with all the other coordinate systems, with an 

asterisk in the Custom column. 

 If your coordinate system includes vertical datum, click Set and select a vertical datum from a list of 

supported datums. 

Note: If the WKT of your coordinate system references a particular GTX file that was not bundled 

with the PhotoMesh installation, you can add the GTX by downloading it and placing it in 

the correct directory. See “Adding Vertical Datum (GTX) Files” in this chapter for 

information. 

 Click OK. 

 

The following advanced coordinate system capabilities are available: 

▪ Generate WKT strings for coordinate systems 

▪ Add missing vertical datum grid shift files (GTX) 

Coordinate System Projection Tool 

The Projection Tool projects data from one coordinate system to another: 

▪ Generate a WKT string that defines a coordinate system (optionally, with vertical datum) for inclusion 

in Excel/XML photo list files, control point files, and trajectory files. 

▪ Convert coordinate, OPK, and YPR values from one coordinate system to another. 

▪ Convert the rotation format from a rotation matrix to OPK/YPR. The rotation matrix transforms 

coordinates in the specified coordinate system into camera coordinates using: a 3x3 matrix with <Mij> 

tags, where Mij denotes the coefficient of the (i+1) row and the (j+1) column of the rotation matrix. 

▪ Convert the rotation format from OPK/YPR to a rotation matrix 

To generate a WKT string for a coordinate system: 

 On the Tools tab, in the Coordinate System group, click Reprojection. The Projection Tool dialog 

box is displayed. 

 Click Open List, and select a coordinate system. 

 Click Set and select a vertical datum from a list of supported datums. 

 Click OK. The generated WKT string can be copied into your files as required. 

To convert from one coordinate system to another: 

 On the Tools tab, in the Coordinate System group, click Reprojection. The Projection Tool dialog 

box is displayed. 

 On the left side, do the following: 

a. Click Open List, and select a coordinate system. 

b. Click Set and select a vertical datum from a list of supported datums. 

c. Click OK. 

d. Enter the XYZ values, and optionally, the OPK or YPR values. 
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 On the right side, do the following: 

a. Click Open List, and select the coordinate system you want to project to. 

b. Click Set and select a vertical datum from a list of supported datums. 

c. Click OK. 

 Click Project . The XYZ, OPK, and YPR fields on the right side are populated with the 

projected values. 

To convert a rotation matrix to OPK and YPR: 

 On the Tools tab, in the Coordinate System group, click Reprojection. The Projection Tool dialog 

box is displayed. 

 On either of the sides, do the following: 

a. Click Open List, and select a coordinate system. 

b. Click Set and select a vertical datum from a list of supported datums. 

c. Click OK. 

d. Enter the XYZ and OPK or YPR values. 

 Click Convert : 

To convert OPK and YPR to a rotation matrix: 

 On the Tools tab, in the Coordinate System group, click Reprojection. The Projection Tool dialog 

box is displayed. 

 Enter a rotation matrix. 

 Click Convert : 

 

Adding Vertical Datum (GTX) Files 

PhotoMesh uses vertical datum grid shift files (GTX) for shifting and transforming between some 

coordinate systems that have different datums. Sometimes the Well-Known Text (WKT) of one of the 

coordinate systems in your project references a particular GTX file that was not bundled with your 

installation, or the reference itself is missing from the WKT. The steps below describe how to add the 

missing GTX information in both of these cases. 

To add missing GTX information: 

 If a referenced GTX file was not bundled with the installation, download and unzip the required GTX 

file. Common GTX files are available from the following sites:  

▪ https://github.com/OSGeo/proj-datumgrid/tree/master/ 

▪ https://vdatum.noaa.gov/download.php  

▪ https://raw.githubusercontent.com/OSGeo/proj.4/gh-pages/proj.pdf 

▪ https://proj.org/resource_files.html#transformation-grids 

 For computers with full PhotoMesh installation (See “Installing PhotoMesh” in the “Getting Started” 

chapter), copy the GTX file into the following subdirectories: 

▪ The \PhotoMesh\proj subdirectory of PhotoMesh’s installation directory. 

▪ The \PhotoMesh\Fuser\proj subdirectory of PhotoMesh’s installation directory. 

https://github.com/OSGeo/proj-datumgrid/tree/master/
https://vdatum.noaa.gov/download.php
https://raw.githubusercontent.com/OSGeo/proj.4/gh-pages/proj.pdf
https://proj.org/resource_files.html#transformation-grids
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 For computers with only fuser installation (See “Installing PhotoMesh Fusers” in the “Getting Started” 

chapter), copy the GTX file into the \PhotoMesh\proj subdirectory of PhotoMesh Fuser’s installation 

directory. 

 If a reference to the GTX file is missing in the WKT, add the following reference within the WKT's 

VERT_DATUM object that is under the VERT_CS object: 

EXTENSION["PROJ4_GRIDS","[Name of GTX File]" 

E.g., 

COMPD_CS["RGF93 / Lambert-93 + NGF-IGN69 height", 

 PROJCS["RGF93 / Lambert-93", 

 ..., 

 AUTHORITY["EPSG","2154"]], 

VERT_CS["NGF-IGN69 height", 

 VERT_DATUM["Nivellement General de la France - IGN69",2005,  

  EXTENSION["PROJ4_GRIDS","RAF18.gtx"], 

 AUTHORITY["EPSG","5119"]], 

 UNIT["metre",1,AUTHORITY["EPSG","9001"]], 

 AXIS["Up",UP],AUTHORITY["EPSG","5720"]] 

] 
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CHAPTER 6  WORKING WITH SKYLINEGLOBE SERVER 

About Working with SkylineGlobe Server 

SkylineGlobe Server (SGS) is a private cloud solution that provides a comprehensive set of web services 

for publishing, storing, managing and streaming 3D spatial data. Remote PhotoMesh clients can connect 

to a SkylineGlobe Server to load imagery, elevation and 3DML layers into their projects. All data on your 

server is cataloged and referenced so clients can easily find the specific published layer required.  

For more information about SkylineGlobe Server, see the SkylineGlobe Server User Guide. 

Connecting to a SkylineGlobe Server 

To connect to a SkylineGlobe Server: 

 On the Tools tab, in the SkylineGlobe group, click Disconnected. The SkylineGlobe Server dialog 

box is displayed. 

Note: If you are already connected to a server and want to connect to a different one, on the 

Tools tab, in the SkylineGlobe group, click Connected. In the Connect to SkylineGlobe 

Server dialog box that is displayed, first click Disconnect, and then enter the new server 

connection information.  

 

Connect to SkylineGlobe Server Dialog Box 

 Enter the connection information and click Connect: 

Parameter Activity 

Server The Server Host Name, which is the URL link of the server. 

User Name User name to access the server (mandatory). 

Password Enter the password.  

Remember Password Select this option to save the password. The password will be saved 
and will be displayed using asterisks the next time the SkylineGlobe 
Server dialog box is displayed. 

https://www.skylinesoft.com/hubfs/KB_Resources/SGS/Web%20Help/User%20Guide/index.htm#t=About_SkylineGlobe_Server_SGS.htm&rhsearch=block%20width&rhsyns=%20
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The values that you enter for Server and User Name are saved. The next time you load this window, 

this information is automatically filled in.  

Loading SkylineGlobe Layers 

To add a layer from a SkylineGlobe server:  

 On the Tools tab, in the Objects and Layers group, click the required layer type (Imagery Layer, 

Elevation Layer, or 3DML). The Browse dialog box is displayed.  

 In the From Server section, select SkylineGlobe Server as the Server Type, and click Select. The 

SkylineGlobe Layers dialog box is displayed, showing the selected layer type. 

 

SkylineGlobe Layers Dialog Box 

 If you aren’t already connected to the required SkylineGlobe Server, the Connect to SkylineGlobe 

Server dialog box is first displayed to enable you to connect. See “Connecting to a SkylineGlobe 

Server” in this chapter for information. After connecting, the SkylineGlobe Layers dialog box is 

displayed showing all layer types. 

 Search for the required layer. See “Searching for SkylineGlobe Layers” in the “Working with 

SkylineGlobe Server” chapter. 

 Select the layer you want to load, and click Load Layer. Use CTRL-click or SHIFT-click to multi-

select layers. 
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Searching for SkylineGlobe Layers 

To search for a layer in the SkylineGlobe Layers dialog box: 

 If you want to search for layers whose property information contains a specific string (e.g., ID, Name, 

Data Source), do the following: 

a. In the Search String field, type a search string or enter an attribute, condition, and value and click 

Insert String . The search expression is displayed in the Search string field. 

b. If you want to include additional strings in your search expression, select a connector: 

and OR or, and repeat step a for the next condition. 

 If you want to search according to geographic location, do the following: 

c. Click Set Bounding Box, and select the required region by drawing a rectangle on the map on 
the right side of the page around the area to which the search is confined  

d. From the Map field, select one of the following: 

▪ Do Not Use – To ignore the bounding box. 

▪ Contained – If you want to search only for layers whose entire geometry fall within the 

bounding box.  

▪ Intersect – If you want to search for all layers whose geometry intersect at any point with the 

bounding box. 

e. If you want to clear the bounding box, click Clear.  

 Click Search. Your search results are displayed in the search results list at the bottom of the page.  
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CHAPTER 7  IMAGERY ACQUISITION 

About Imagery Acquisition 

The first step in the PhotoMesh process entails photographing all visible surfaces of the intended object 

or scene from multiple overlapping viewpoints. PhotoMesh supports standard image formats and large 

frame sensors.  

The accuracy of the resulting 3D mesh model is affected by several factors including: input photo 

resolution and quality, lens distortion, overlapping ratio, directionality, and lighting. While PhotoMesh 

optimizes the accuracy of the 3D mesh model by selecting the best photos for an area, each factor can 

affect the overall output or cause varying levels of accuracy and quality in different areas of a project.  

In most projects with good quality input, the resolution of the 3D model has been found to be 

approximately 1-2 times the ground sample distance of the source imagery. 

Input Format and Resolution 

Input Format/Data 

Image Format Standard image formats (JPG, TIF, IIQ, etc.). 

Positioning Information XY coordinates and altitude of each photo.  

Orientation Information Omega, Phi, Kappa values (Recommended for large scale 
projects). 

Camera 

Large Frame Sensors (100+ 
Mega Pixel) 

Supported.  

Focal Length Photos with different focal lengths are supported. 

Digital Zoom No. 

Directionality 

Since PhotoMesh models can be viewed from any angle, it is important to capture nearly all visible 

surfaces, including walls and facades. Any object in the area of interest should be photographed multiple 

times from the top and at least four other directions. 

 

Overlap 

To create an accurate 3D model, each point in the area of interest should be visible in multiple photos. A 

>66% overlap between consecutive photos is recommended. Each point in the area of interest should be 

visible by, at least, 3 cameras (min 10° offset). PhotoMesh can combine photos with different ground 

resolutions. 
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For structured aerial photography 

▪ Overlap in direction of flight (forward overlap) – 75 - 90% (recommended - 80%)  

▪ Overlap between neighboring rows (side overlap) – 70 - 90% (recommended - 80%) 

 

Structured Aerial Photography Recommendations 

The following guidelines are recommended for optimal model accuracy and texture quality: 

▪ Capture time – Avoid long shadows and sun reflections 

▪ Capture date – Capture all photos in the same season 

▪ Collection system – Use stable platforms with minimal smearing 

Data Collection Recommendations for Photos 

This section outlines Skyline’s recommendations for optimal 3D PhotoMesh production from collected 

data: 

▪ Camera and lens combinations (hardware preferences) 

▪ Camera settings and image format 

▪ Flight planning and execution 

▪ Mobile photography 

Camera and Lens Combinations (Hardware Preferences) 

The following factors in sensor and lens selection are critical for 3D model geometry and quality: 

▪ A high quality lens, with minimal distortion. 

▪ Fixed focal length - to avoid alternating focal lengths in photos which are meant to be processed in 

the same dataset. 

▪ For a standard grid collection pattern, it is important to 

have a lens with a field of view (FOV) at least 90 degrees 

wide in the long axis (60 degrees in the short axis, ~108 

degrees in diagonal). 

▪ A FOV < 120 degrees in the long axis, since these lenses 

tend to be fish-eye and too distorted for high-quality 

aerotriangulation. 

▪ A lens which can maintain sharpness in the edges of the 

90 degrees 

60 degrees 
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image - for proper aerotriangulation and texturing of facades in the 3D model. 

▪ A sensor which can collect images rapidly - to maintain high overlap collection in low altitude flights 

while achieving proper overlap. 

Camera Settings and Image Format 

The following camera settings are recommended: 

▪ Disable any “auto-rotate” options, to ensure that all of the images maintain a uniform orientation 

during the flight. 

▪ Avoid slow shutter speed (generally < 1/1000) since it will cause significant motion blur, resulting in 

photos that cannot be used in the PhotoMesh production process. Instead of allowing a shutter speed 

drop to 1/640 or 1/500, it is preferable to open up the aperture value as wide as possible, even at risk 

of slight softness at the corners of the image. It is also possible to increase the ISO value in high 

quality cameras, and still maintain non-grainy images with high dynamic range in bright and dark 

areas. 

▪ Disable any settings which might affect the relative location of the lens to the sensor, such as anti-

shock or vibration features, since this will create a random principal point for the camera model. 

Vibration or motion in the UAV stabilization platform should be addressed with the camera and lens 

combination as a static object. 

▪ Avoid auto-focus or automatic zoom. Focus the lens (usually to infinity) and lock it in that position. 

▪ Use full resolution format, so that it is not down-sampled from the sensor pixels. 

▪ Collect the photos in full uncompressed format. If JPEG format is necessary, use minimum 

compression to avoid artifacts or missing information in the images. 

Flight Planning and Execution 

The following flight patterns and execution are recommended: 

▪ For single building or small area collection, use a circular flight pattern, with the target area in the 

center of the image from all perspectives. 

▪ For large scale collection, use a grid pattern which allows for efficient area collection with the goal of 

creating 3D products. 

▪ For nadir cameras with a field of view of approximately 60 degrees, tilt the camera 10-15 degrees 

forward to achieve the necessary 40-45 degree oblique perspective in all directions. The resulting 

field of view profile looks as follows: 
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Standard Nadir Flight      15 Degree Forward-Tilt 

 

• Maintain a frontal (vertical) overlap of 75 - 90% (recommended - 80%). 

• Maintain a side (lateral) overlap of 70 - 90% (recommended - 80%). 

Mobile Photography 

The following perspective and overlap are recommended for optimum reconstruction results: 

▪ Perspective – Capture required objects and facades at a perpendicular angle and a 30 degree 

oblique variance (60 and 120 degrees) to maximize triangulation quality, while minimizing perspective 

distortion.  In close-range data collection, any perspective which captures the object or façade at 

more than a 45 degree oblique will most likely be at a considerably lower resolution to provide 

effective input for the reconstruction. 

▪ Sky – Limit the sky component in the photo to no more than 30%. This can be achieved by setting the 

tripod to a higher altitude when possible, as well as by slightly angling the camera down (instead of 

pointing the camera directly at the horizon, 90 degrees from the ground, it can be angled 70-80 

degrees from the ground).  

▪ Overlap – Maintain at least an 80% overlap, so that each object will appear in at least five photos. 

This provides PhotoMesh with the data to fill in holes in planes and facades that are partially 

obstructed by objects (such as trees and street furniture) which are closer to the camera. 

 

 

-15 degrees        Nadir                        45 degrees off nadir 

-30 degrees                Nadir                   30 degrees off nadir 

15 degrees     tilt forward 
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Data Collection Recommendations for Full Motion Video (FMV) 

This section outlines Skyline’s recommendations for optimal 3D PhotoMesh reconstruction from full 

motion video. The recommendations below are for oblique data. It is generally recommended to use nadir 

video datasets only for production of orthophotos or point clouds, and not for full 3D Mesh models. 

Video Camera – Hardware and Settings 

▪ Use video setting most suitable for sharp video frames in motion. 

▪ Use gyroscope or accelerometer-based gimbal or other 3-axis stabilization. 

Flight Planning and Execution 

▪ Slow flight to prevent motion blur. 

▪ Minimum field of view - 45 degrees (optimal: 60-100 degrees), depending on the lens quality. 

▪ Minimum lateral (side) overlap - 40% (optimal: 60-80%).  

▪ Minimum overlap between consecutive photos - 60%. This can be achieved by a combination of flight 

speed and frame rate. 

▪ It is recommended to use consistent zoom, especially in random flight patterns. 

▪ For large area collection, use a criss-cross grid pattern. 

▪ For single building or small area collection, video the target feature from different altitudes, and 

different pointing angles for complete coverage. 
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CHAPTER 8  PROJECT MANAGEMENT 

Creating and Opening a PhotoMesh Project 

When you create a new project, PhotoMesh creates an output folder with the same name as the project 

file for the project file and output files.  

To start a new project:  

 Click the PhotoMesh button , and then click New (CTRL+N). The New Project dialog box is 

displayed. 

  

New Project on Local Drive / New Project on Network Drive 

 Browse to the required path for the project folder.  

Note: PhotoMesh can take advantage of computer clusters to accelerate database creation. See 

the "Fusers" chapter for more information. To enable this, both the project folder and the 

working folder  should be set to network folders with read-write access permissions, for 

both the master and client computers. It is recommended to use UNC format (\\[UNC 

Master] \folder\ProjectFolder, e.g.: \\Machine1\c\PhotoMesh\ProjectFolder and \\[UNC 

Master] \folder\WorkingFolder, e.g.: \\Machine1\c\PhotoMesh7.0\WorkingFolder), though a 

mapped network drive can also be used as long as the same letter is mapped to the same 

share on all computers. The shared project folder and working folder must both be on a 

device that supports the number of concurrent network connections you require, e.g., 

Windows 10 limits the number of supported concurrent connections to 20. 

 In the Name field, type a project name, and then click Ok. PhotoMesh creates an output folder (with 

the same name as the project file) for the project file and output files.  

 If PhotoMesh cannot load the default base terrain (generally because you are not connected currently 

to the Internet), the Terrain Database dialog box is displayed. See “Setting the Terrain Database” in 

this chapter for more information. 

To open an existing project: 

 Click the PhotoMesh button, and then click Open. The Open dialog box is displayed. 

 Browse to the required file and click Open. 

 If PhotoMesh cannot load the default base terrain (generally because you are not connected currently 

to the Internet), the Terrain Database dialog box is displayed. See “Setting the Terrain Database” in 

this chapter for more information. 

Setting the Terrain Database 

You can set the MPT or .FLY to use as the base terrain for your project. 

file://///Machine1/c/PhotoMesh/ProjectFolder
file://///Machine1/c/PhotoMesh7.0/WorkingFolder
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To set the terrain database: 

 On the Home tab, in the Add group, click Terrain Database. The Terrain Database dialog box is 

displayed.  

 

Terrain Database Dialog Box 

 Select one of the terrain database options: 

▪ SkylineGlobe online terrain database – To use the default terrain database 

(skylineglobe.tbp@tglobe.skylinesoft.com). 

▪ PhotoMesh default local terrain database – To use the base terrain file included with the 

PhotoMesh installation (Default_Local_Terrain.mpt).  

▪ Custom terrain database – To use a custom terrain database. Browse to the required file.  

 If you want to set your selected option as the default for new projects, select the check box. The 

default terrain database for new projects is listed in the PhotoMesh Options dialog box. See “Setting 

PhotoMesh Options” in the “Basic Concepts” chapter for more information. 

 Click OK. 

Viewing Build Settings 

The Build Settings dialog box is used to view project parameters, such as AT and reconstruction settings, 

output coordinate system, and output formats. Build settings can only be edited when beginning a build 

or rebuild process. See “Setting Build Parameters and Processing the Build” in the “Building” chapter for 

information. 

To view Build Settings: 

 On the Home tab, in the Build group, click the arrow next to Build, and select View Build Settings. 

The Build Settings dialog box is displayed, showing the Steps tab.  

 Click the tabs to view the build parameters. See “Setting Build Parameters and Processing the Build” 

in the “Building” chapter for more information about these parameters.  
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Setting the Coordinate System 

The Coordinate System Settings dialog box is used to set and view the project’s internal coordinate 

system, in which aerotriangulation and reconstruction are performed. The coordinate system is also 

relevant for calculating the horizontal and vertical accuracy of the control points. 

Note: When Review mode is on, you can only view the coordinate system. 

To view Coordinate System Settings: 

 On the Home tab, in the Build group, click the arrow next to Build, and select View Coordinate 

System Settings. The Coordinate System Settings dialog box is displayed, showing the name of the 

project’s coordinate system.  

Note: When Review mode is off, you can click the arrow to select a different coordinate system 

from the drop-down list. Select the Custom option to create a new custom coordinate 

system. See “Setting Output Formats (Coordinate System)” in this chapter and “Coordinate 

System” in the “Basic Concepts” chapter for more information. 

 Click View to view the full Well-Known Text (WKT) for the coordinate system. 
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CHAPTER 9  USING THE PROJECT TREE AND ITEM LIST 

About the Project Tree  

The Project Tree provides quick access to PhotoMesh items. The Project Tree lists all of the project’s 

photo collections, AT tiles, reconstruction tiles, Lidars, control points, retouch layer, water body layers 

(manually created and imported), terrain objects, imagery and elevation layers and outputs.  

Note: The number in brackets next to the name of each collection indicates the number of photos in this 

collection. The number in brackets next to the name of each control point indicates the number of 

photos in which this control point was marked.  

 

Project Tree 
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About the Item List 

The Item List provides a list of all the items in the currently selected Project Tree group, and information 

about each item. An item list is displayed for each of the following groups: photos, Lidars, reconstruction 

tiles, AT tiles, manual retouch layers, manually created water polygons and every imported water polygon 

layer. The columns in each item list vary depending on the item type. The List panel is by default 

displayed under the 3D Window.  

 

Photo List 

Searching the Project Tree 

You can search the Project Tree for any project element: collection group, photo, Lidar, control point, 

AT/reconstruction tile, retouch layer, water polygon, terrain object, imagery/elevation layer, or output.  

To search:  

▪ In the Project Tree’s Quick search field, type a search term, and click Find. The first project 

element in the Project Tree with the specified text is selected.  

To select an item: 

▪ In the Project Tree, click the required item. 

Showing and Hiding Items  

Click on the item’s show/hide icon  to display or hide it in the 3D Window. 

Selecting Items Using the Item List 

You can search for and select items, e.g., photos, Lidars, and tiles, using the Item List. All selected items 

are selected both in the list (a check is displayed in the Selection column and their row is highlighted) and 

in the 3D Window. 

To select items using an item list: 

 If you want to search for items according to geographic location, use any of the selection buttons: 
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Selection Point - Select all list items that intersect with the point you draw. This 
option is only available for photos and Lidar.  

 
Selection Polygon - Select all list items that intersect with the polygon you draw. 

 
Selection Rectangle - Select all list items that intersect with the rectangle you draw. 

 
Select All - Select all list items. 

 
Clear Selection - Clear all selected list items. 

 

Clear Columns Filter – Clear any active filter that was applied. See "Filtering Data" in 
this chapter for information. 

 

Manual Retouch – Open Manual Retouch tool. This option is only available for 
manual retouch polygons. See "Marking a Mesh Layer for Retouching" in the 
"Reviewing Your Build" chapter for information. 

 

Filter by Reconstruction Area – Select all tiles in the current reconstruction area. 
This option is only available for reconstruction tiles. See "Setting the Reconstruction 
Area" in the "Preparing the Project" chapter for information on defining the area of the 
project on which PhotoMesh should perform the reconstruction steps of the build 
process. 

 If you want to search for group items whose property information contains a specific string (e.g., 

Name, Altitude or X/Y value), in the list’s search field, type a search term, and press ENTER. The 

specified text is highlighted wherever it appears in the list. The number of search results found is 

indicated to the right of the search term entered. You can use the Previous  and Next  buttons to 

jump in the list from one search result to the next. 

Filtering Data  

To filter data: 

 Point to the column by which you want to filter, and click the Filter icon . The Filter dialog box is 

displayed. 

     

Numeric/Text Filters 
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 Do any of the following: 

▪ To select a numeric/text filter, select the Numeric Filters/Text Filters tab. A filter is comprised of 

the (already) selected property, an operator, and a property value. Each property type has its 

corresponding operators. Select an operator from a list of operators, and a property value. 

▪ To filter by values, select the Values tab. For numeric values, enter the From/To values of the 

data you want to view. For text values, select the check boxes of the data you want to view. All 

other data will be filtered, i.e., temporarily hidden.  

▪ If you want to clear the filter, click Clear Filter. 

 Click Close. The applied filter(s) are listed at the top of the panel, e.g., 

  

 If you want to clear all filters that were applied, click Clear Columns Filter . 

Filter Editor 

You can use the Filter Editor to add and remove conditions. A search expression can consist of more the 

one condition. In this case, you need to insert a connector between the conditions to specify their 

relations. In addition to AND, you can use the OR, NOT and [] connectors to define the relations between 

conditions. 

 

To access additional sorting commands, right-click any column header. Select any of the following 

commands: 

Command Description 

Sort Ascending Sort all data in the table by this column in 
ascending order. 
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Sort Descending Sort all data in the table by this column in 
ascending order. 

Group by This Column Group the data by this column.  

Note: If you want to clear the grouping, right click 
above the column headers, and select 
Clear Grouping. 

Show Group by Box Display boxes, above the photo table, indicating 
how the data is grouped in the table. 

Note: If you want to clear the Group by boxes, 
right click above the column headers, and 
select Hide Group by Box. 

Hide This Column Hide the selected column 

Column Chooser Customize which columns show in the table. Drag 
and drop columns to and from the Customization 
dialog box. 

Best Fit Adjust the selected column’s width for the best fit 
for its contents.  

Best Fit (all columns) Adjust the all the table’s column widths for the 
overall best fit. 

Filter Editor Open the Filter Editor to edit the table filter. 

Show Auto Filter Row Display a row with a filter option for each of the 
columns. 

 

Right-Click Shortcut Menus 

Each project item type displays a unique menu of options when you right-click it in the Project Tree. 

Photo Collection Menu 

To open a Photo Collection’s shortcut menu: 

▪ In the Project Tree, right-click the required collection. 

  

Collection Shortcut Menu 

The Collection menu has the following options: 

Note: Only the Copy Properties option is available when in Review mode. 



 

92 

PhotoMesh User Guide 

Option Description 

Copy Properties Copy the collection’s properties. 

Paste Properties Paste the previously copied collection properties to this collection. 

Add Photo Add photo to collection. 

Include in Project Include collection in project. 

Exclude from Project Exclude collection from project. 

Rename Rename collection in Project Tree. 

Delete Delete the collection from the project.  

 

Photo Menu 

To open a Photo’s shortcut menu: 

▪ In the Photos list, right-click the required photo. 

  

Photo Shortcut Menu 

The Photo menu has the following options: 

Option Description 

Fly To Fly to the photo. 

Note: This option is only available when all position parameters 
(X, Y, and Altitude) were provided.  

Jump To Jump to the photo. 

Open in Photo Viewer Open the photo in Photo Viewer. 

Set Path Set the photo's directory. 

Note: This option is not available in Review mode. 

Delete Delete the photo from the project.  

Note: This option is not available in Review mode. 

 

Tile (AT or Reconstruction) Menu 

To open a Tile's shortcut menu: 

▪ In the Tile list, right-click the required tile. 
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Tile Shortcut Menu 

The Tile menu has the following options: 

Option Description 

Fly To Fly to the selected tile. 

Jump To Jump to the selected tile. 

Save Selection Save the selection information (which tiles were selected) to a 
.select text file. 

Load Selection Load a tile's .select text file with selection information (which tiles 
should be selected).  

Export Selected Tiles Export the selected tiles with all their information (e.g., status, 
photo count) to an SQLite file. 

Note: The exported tiles can be reviewed in TerraExplorer or 
other standard geospatial applications, and user status 
and comments added, and then reimported to PhotoMesh. 

Import Tile Status Reimport a tile from an SQLite file (generally after the tile was 
reviewed in TerraExplorer or another standard geospatial 
application, and user status and comments were added). 

Clear Selection Clear all selections. 

 

Control Point Menu 

To open the Control Point shortcut menu: 

▪ In the Project Tree, right-click the Control Points group. 

 

Control Point Shortcut Menu 

The general Control Point menu has the following options: 
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Option Description 

Create Ground Control Point Create a ground control point. Its position parameters can then be 
set from its property sheet. 

Create Ground Control Point 
from Terrain 

Create a ground control point from identifiable location on the 
terrain. 

Import Control Points Import control point data in a .gcp (text format) file. 

Export Control Points Export control point data to a .gcp (text format) file. 

 

To open a specific control point’s shortcut menu: 

▪ In the Project Tree, right-click the required control point. 

 

Specific Control Point’s Shortcut Menu 

The Control Point menu has the following options: 

Option Description 

Fly To Fly to the control point. 

Jump To Jump to the control point. 

Exclude from project Exclude the control point from the project.  

Rename Rename the control point in the Project Tree. 

Delete Delete the control point from the project.  

Edit Opens the Control Point Editor to mark control points in the photos. 
(See “Marking Control Points in Photos” in the “Control Points” 
chapter for information).  

Objects and Layers Menu 

To open an Objects and Layers shortcut menu: 

▪ In the Project Tree, right-click the required terrain object or layer. 
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Objects and Layers Shortcut Menu  

The Objects and Layers menu has the following options for objects and layers: 

Option Description 

Fly To Fly to the terrain object. 

Jump To Jump to the terrain object. 

Refresh Reloads the layer (This option is only displayed for layers). 

Delete Delete the terrain object from the project.  

Properties Open the terrain object’s property sheet to edit or view its 
properties.  

Outputs Menu 

To open an Outputs shortcut menu: 

▪ In the Project Tree, right-click the required build output. 

 

Outputs Shortcut Menu 

The Outputs menu has the following options: 

Option Description 

Open with TerraExplorer Open the output in TerraExplorer (This option is only available for 
3DML, AT Calculated Photos, AT Tiles, DSM, DTM, and 
Orthophoto ). 

Open Folder Location Open the location of the project’s output folder to view all outputs. 

Export to LAS Export DSM to LAS with Orthophoto colors (This option is only 
available for DSM). 

Export to LAZ Export DSM to LAZ with Orthophoto colors (This option is only 
available for DSM). 

Delete Delete the output from the project. 

Properties Open a property sheet with various properties for the output.  



 

96 

PhotoMesh User Guide 

 

Water Polygon Menu 

To open the water polygon layer general shortcut menu: 

▪ In the Project Tree, right-click the Retouch Layers group.  

   

Retouch Layers General Shortcut Menu 

The shortcut menu has the following options:  

Option Description 

Import Water Polygon Layer Import a water polygon from a shapefile or KML layer. 

 

To open an individual water polygon layer’s shortcut menu: 

▪ In the Project Tree, right-click the required imported water polygon layer or the manually created 

water polygon layer. 

 

The water polygon layer shortcut menu has the following options:  

Option Description 

Exclude from/Include in 
Project 

Exclude/Include the polygon layer from the project. 

Export Layer Export the polygon layer to a shapefile. 

Delete Delete the polygon layer from the project. 

Note: This option is only available for an imported water polygon 
layer. 

 

To open a specific water polygon’s shortcut menu: 

▪ In the Project Tree, select the water polygon layer, and in the Polygon List, right-click the required 

polygon. 
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Water Polygon Shortcut Menu  

The Water Polygon menu has the following options: 

Option Description 

Fly To Fly to the water polygon. 

Jump To Jump to the water polygon. 

Edit Edit the polygon’s shape.  

Select Tiles Select the intersecting tiles. 

Delete Delete the water polygon from the project.  

 

Retouch Layers Menu 

To open a specific manual retouch operation's shortcut menu: 

▪ In the Project Tree, select the Manual Retouch group, and then in the Manual Retouch list, right-

click the required retouch polygon (i.e., row). 

 

Manual Retouch Shortcut Menu 

The Manual Retouch menu has the following options: 

Option Description 

Edit Edit the polygon.  

Fly To Fly to the polygon. 

Jump To Jump to the polygon. 

Export Export the retouch polygon layer with the selected retouch 
polygons to an SQLite file. The layer can be modified in external 
software and reimported to PhotoMesh. 
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Import Reimport a retouch layer from an SQLite file (generally after 
modification in external software). 

Delete Delete the selected retouch polygons from the project.  

 

Lidar Menu 

To open a Lidar shortcut menu: 

▪ In the Project Tree, select the Lidars group, and then in the Lidars list, right-click the required Lidar. 

   

Lidar Shortcut Menu 

The Lidar menu has the following options: 

Option Description 

Fly To Fly to the Lidar point cloud. 

Jump  Jump to the Lidar point cloud. 

Show Point Cloud Show the Lidar point cloud on the terrain.  

Style Point Cloud Open the Lidar point cloud's property sheet to set point size, color, 
visibility, etc. See Lidar Point Cloud Properties Dialog Box” in the 
"Lidar Management" chapter. 

Show Trajectory Show the Lidar point cloud's trajectory. The trajectory is the path of 
the scanner’s position while capturing the Lidar point cloud. See 
"Associating a Lidar Point Cloud with its Trajectory Data" in the 
"Lidar Management" chapter for information.  

Refresh Trajectory Refresh trajectory data. 

Edit Trajectory Open the trajectory data file in a text editor, so you can edit its 
data. See "Associating a Lidar Point Cloud with its Trajectory Data" 
in the "Lidar Management" chapter for information. 

Delete Delete the Lidar point cloud from the project.  
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Reference Project Menu 

To open a reference project's collection shortcut menu: 

▪ In the Project Tree, right-click the required reference project collection. 

 

Reference Project Collection Shortcut Menu 

The reference project collection menu has the following options: 

Option Description 

Copy Properties Copy the collection’s properties. 

Paste Properties Paste the previously copied collection properties to this collection. 

Add Photo Add photo to collection. 

Include in Project Include collection in project. 

Exclude from Project Exclude collection from project. 

Rename Rename collection in Project Tree. 

Delete Delete the collection from the project.  

 

Reference Photo Menu 

To open a shortcut menu for a reference project's photos: 

▪ In the Reference Photos list, right-click the required reference project photo. 

 

Reference Photo Shortcut Menu 

The reference photo menu has the following options: 
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Option Description 

Fly To Fly to the photo. 

Note: This option is only available when all position parameters 
(X, Y, and Altitude) were provided.  

Jump To Jump to the photo. 

Open in Photo Viewer Open the photo in Photo Viewer. 

Set Path Set the photo's directory. 

Note: This option is not available in Review mode. 

Delete Delete the photo from the project.  

Note: This option is not available in Review mode. 

 

 

Project Tree Symbols 

Symbol Meaning 

Strikethrough font Excluded from project.  

Note: If a collection is marked in strikethrough font, this indicates 
that all the collection’s photos are excluded from the project. 

 orange question mark ▪ On a collection – Missing one or more of the camera properties 
that are used to set the focal length. (These properties vary 
depending on the Focal Length Normalization property setting 
set in the Collection property sheet. See “Collection Property 
Sheet” in the “Photo Management” chapter for information.) The 
missing property field is also marked in the Property Sheet with 
an orange question mark.  

 red exclamation mark ▪ On a collection – One or more photos is missing required 
properties. The missing property fields are also marked in the 
Property Sheet with a red exclamation mark. 

▪ On a control point – The control point is marked in fewer than 
three photos. The missing property fields are also marked in the 
Property Sheet with a red exclamation mark. 

▪ On the Lidars group – The coordinate system is missing from 
one of the Lidars. This Lidar is excluded from the project. 

Note: The missing property fields are also marked in the Property 
Sheet with a red exclamation mark. 

[#calculate / #total] Number of included photos/Total 
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CHAPTER 10  PHOTO MANAGEMENT 

About Photo Management 

This chapter deals with basic photo management tasks:  

▪ Loading of new photos in a project 

▪ Excluding/removing a photo from the project 

▪ Modifying photo and photo collection properties 

Photo Requirements 

See “About Imagery Acquisition” in the “Imagery Acquisition” chapter for a list of requirements and 

recommendations for the photos from which the model will be generated.  

Loading Photos 

Load photos into your project using any of the following methods: 

▪ Load photo files from disk. 

▪ Load an Excel/XML file with a list of photos, their file paths, and all photo and photo collection 

information.  

▪ Extract individual frames from video and save them as image files. 

▪ Load a PhotoMesh project. When a PhotoMesh project (.PhotoMeshXML) is loaded into a second 

project, only the project’s photos and photo and collection parameters are loaded. 

Photos can only be loaded when Review mode is off. See "About Reviewing Your Build" in the 

"Reviewing Your Build" chapter for more information about Review mode. 

Loading Photo Files from Disk  

For optimal performance, photographs should be divided into one or more collections, homogeneous 

groups of photographs, all taken by the same physical camera with identical focal length and principal 

point.  

To select photo files from your local disk: 

 On the Home tab, in the Add group, click the arrow next to Photos, and select one of the following: 

▪ Load Files – To add selected files. 

▪ Load Folder – To add an entire folder. 

 Browse to the required folder/file(s) and click Open. 

 If you are adding a folder of photos, PhotoMesh automatically creates a group (collection) in the 

project tree and places all photos under the folder in this group. If you are adding a folder with sub-

folders, a dialog box is displayed asking if you want to create a project sub-group for each sub-folder. 

Click Yes to create sub-groups for the sub-folders. 

Note: If a folder is added with photos that were taken by different cameras or with different focal 

lengths and principal points, PhotoMesh will automatically place the photos in different 

collections as long as the required metadata (e.g., Exif) is encoded in the photo files.  
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Defining Collection Properties with collectionProperties.xml  

You can define collection properties and override those included in the metadata (e.g., Exif) encoded in 

photo files by creating a file named collectionProperties.xml with the required collection properties. This 

saves you the trouble of creating a full Excel or XML file that contains a list of all the photos. The 

collectionProperties.xml file is commonly used to add band information, focal length, or other collection 

level properties. Each collectionProperties.xml file can only contain data for a single collection, so a 

separate file must be created for each collection for which you want to provide supplementary information 

and placed in the corresponding collection folder.  

There are several mandatory properties in the collectionProperties.xml file. If you want to use the values 

in the metadata encoded in the photo files, for these properties, set the required property in the 

collectionProperties.xml file equal to 0, e.g. “Width = 0”.  

A sample collectionProperties.xml follows below. Property descriptions are in the comments <! ….>. 

<?xml version="1.0" encoding="UTF-8"?> 

<BlocksExchange version="2.2">  

 

<!-- Block definition --> 

<Block> 

 

<Collections> 

<!-- A collection is a homogeneous group of photographs, all taken by the 

same physical camera with identical focal length and principal point.--> 

<Collection> 

<!-- Name of the collection --> 

<Name>NIR</Name> 

 

<!-- (Mandatory) Width and height of the photos, in pixels. If you do not 

want the collectionProperties.xml to override the width or height 

information in the metadata encoded in the photo files, set their values 

equal to 0. --> 

<ImageDimensions> 

<Width>0</Width>  

<Height>0</Height> 

</ImageDimensions> 

 

<!-- Optional Parameters. Don’t include if you do not want the 

collectionProperties.xml to override the information in the metadata 

encoded in the photo files. --> 

 

<!-- (Optional) Bands in comma delimited string format, e.g., 

(Red,Green,Blue,NIR). Possible values are: Grayscale, Red, Green, Blue, 

NIR, InfraRed, RedEdge, Alpha, Pan, SWIR_1, SWIR_2, TIR_1, TIR_2, Costal, 

Custom_0, Custom_1, Custom_2, Custom_3, Custom_4, Custom_5, Custom_6, 

Custom_7, Custom_8, Custom_9, Exclude (This band will be ignored.) --> 



   

 103 

PhotoMesh User Guide 

<Bands>Red,Green,Custom_1</Bands> 

 

<!-- (Optional) Focal length in millimeters. --> 

<FocalLength>80.0</FocalLength> 

 

<!-- (Optional) Size of a physical pixel on the camera sensor in 

millimeters. --> 

<PixelSize>0.0052</PixelSize> 

 

<!—(Optional) Origin and units of the principal point. The possible values 

are: topleftpixels topleftmm centerpixels centermm --> 

<PrincipalPointReferenceMethod>centerpixels</PrincipalPointReferenceMethod

> 

 

<!— (Optional) PrincipalPoint x and y values, in the units set by 

PrincipalPointReferenceMethod. --> 

<PrincipalPoint> 

 <x>7360</x> 

 <y>4912</y> 

</PrincipalPoint> 

 

<!—Use yaw, pitch, roll values for orientation --> 

</UseYPR> 

 

<!-- (Optional) Offset along the Phi axis in degrees.--> 

<PhiOffset>90</PhiOffset> 

 

<!-- (Optional) Offset along the Kappa axis in degrees.--> 

<KappaOffset>-180</KappaOffset> 

 

<!-- (Optional) Offset along the Omega axis in degrees. --> 

<OmegaOffset>0.0</OmegaOffset> 

 

<!-- (Optional) Offset from the current altitude value in the coordinate 

system units. If Lat-Long, use meters. --> 

<AltitudeOffset>-10.0</AltitudeOffset> 

 

<!-- (Optional) Flips the Phi axis.--> 

<FlipPhi>false</FlipPhi> 

 

<!-- (Optional) Flips the Kappa axis.--> 
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<FlipKappa>false</FlipKappa> 

 

<!-- (Optional) Flips the Omega axis.--> 

<FlipOmega>false</FlipOmega> 

 

<!-- (Optional) Boolean that determines whether to include this collection 

in the point cloud.--> 

<UseInDpc>false</UseInDpc> 

 

<!-- (Optional) Boolean that determines whether to include this collection 

in the textured model.--> 

<UseInModelTexture>true</UseInModelTexture> 

 

<!-- (Optional) Boolean that determines whether to include this collection 

in the orthophoto. --> 

<UseInOrthoTexture>true</UseInOrthoTexture> 

 

<!-- (Optional) Radial and tangential distortion coefficients calculated 

using the Brown-Conrady model. See 

https://en.wikipedia.org/wiki/Distortion_(optics)#Software_correction for 

more information. --> 

 

<Distortion> 

 

 <!-- (Optional) Defines the 1st radial distortion coefficient. --> 

 <K1>0.0</K1> 

 <!-- (Optional) Defines the 2nd radial distortion coefficient. --> 

 <K2>0.0</K2> 

 <!-- (Optional) Defines the 3rd radial distortion coefficient. --> 

 <K3>0.0</K3> 

 <!-- (Optional) Defines the 1st tangential distortion coefficient. --> 

 <P1>0.0</P1> 

 <!-- (Optional) Defines the 2nd tangential distortion coefficient. --> 

 <P2>0.0</P2> 

</Distortion> 

 

</Collection> 

</Collections> 

</Block> 

</BlocksExchange> 

 

https://en.wikipedia.org/wiki/Distortion_(optics)#Software_correction
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To define collection properties using a collectionProperties.xml file: 

 Place the collectionProperties.xml file in the corresponding collection folder. 

 Load the collection folder. See “Loading Photo Files from Disk” in this chapter for information.  

Loading a Photo List File  

Instead of manually entering all photo and photo collection information (e.g., sensor width, focal length, 

and aerotriangulation data), you can load an Excel or ContextCapture XML file that references the photos 

and includes this data. You also have the option to load a CSV file that includes more limited photo 

information: only XYZ and OPK/YPR data. The photo list file can reference photos stored locally or on an 

HTTP or HTTPS server, or Amazon S3. The path in the photo list file can be relative or absolute, e.g., 

s3://skyline-data/Frederick_xlsx/CF012316.tif OR http://www.skylineglobe.com/Photos_Lidars/Photos/tux-

1771.jpg 

Note: Photos that are stored on HTTP or HTTPS servers, or Amazon S3 can only be loaded using a 

photo list file. In the photo list file, the photos' path should point directly to the photos' path on the 

server or S3. The photo list file itself, must be located on and loaded from a local or shared drive. 

A sample Excel (PhotoMeshSample.xlsx) file is included in the installation folder, which can serve as a 

template for creating such a file as well as provide basic property definitions (in the Excel’s notes). You 

can also see “Collection Property Sheet” and “Photo List” in this chapter for a description of the 

Excel/XML/CSV parameters. 

The Excel file should include the following sheets: 

▪ The first sheet named Collections should detail the group properties for each of the “collections”, i.e., 

groups of photos. For optimal performance, each collection should include only photographs taken by 

the same physical camera with identical focal length and principal point. These group properties are 

the same as the properties that are listed in the Collection property sheet. See “Collection Property 

Sheet” in this chapter. Each row after the heading row (with all the property names) represents a 

different collection. 

▪ A separate sheet for each of the collections, listing the properties of each photo in the collection. The 

name of each collection sheet must be identical to the collection name defined in the Name field of 

the Excel’s Collections sheet. The photo properties are the same as the properties in the Photo 

property sheet. See “Photo List” in this chapter. 

 

Excel File – Collection Property Sheet 

https://aws.amazon.com/s3/
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Excel File – Photo Property Sheet for Specific Collection 

 

 

CSV File – Photo Properties for Multiple Collections 

 

To add photo files using an Excel or XML file: 

 On the Home tab, in the Add group, click the arrow next to Photos, and select Load from List. The 

Load a Photo List File dialog box is displayed. 

 Browse to the Excel or XML file. The photo files are loaded into the project.  

To add photo files using a CSV file: 

 On the Home tab, in the Add group, click the arrow next to Photos, and select Load a Photo List 

File. The Load a Photo List File dialog box is displayed. 

 Browse to the CSV file. The CSV/TXT Importer dialog box is displayed. 
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CSV/TXT Importer 

 Enter the row at which to start import, and select a Delimiter. 

 In the Mapping Table, select an Orientation Method. 

 Select the CSV column that corresponds to each of the photo properties. 

 Click Import. 
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Loading Photos from a Video 

PhotoMesh can extract individual frames from video and save them as photo files. Supported video 

formats include: MPEG, AVI, MOV, and WMV. 

To load photos from a video: 

 On the Home tab, in the Add group, click the arrow next to Photos, and select Load Video (FMV). 

The Load Video dialog box is displayed. 

 Browse to the video file, and click Open. The Load Video Editor is displayed. 

 

Load Video Editor 

 Enter the following information: 

Start Start time from which video frame extraction should begin. Type in the 
time or drag the Start marker of the Video Cropping bar to the required 
position. 

End End time for video frame extraction. Type in the time or drag the End 
marker of the Video Cropping bar to the required position. 

Frame Every Sampling interval, i.e., every how many seconds a frame should be 
captured. 

Focal Length 
Normalization 

Camera properties used to set the focal length. 

Select one of the following options: 

▪ Focal length and sensor width 

▪ Focal length and pixel size 

▪ Focal length 35 

Focal Length Focal length in millimeters. 

Sensor Width Size of the camera sensor in millimeters.  

Pixel Size Size of a physical pixel on the camera sensor in millimeters. 

Zoom How the video was captured: 

▪ Fixed - Select if the video was captured with a fixed zoom. In this 
case, PhotoMesh will ensure that all intrinsic parameters for all the 
video frames are the same.  



   

 109 

PhotoMesh User Guide 

▪ Not Fixed - Select if the zoom level varied over the course of the 
capture, e.g. by using auto-zoom. In this case, PhotoMesh will 
calculate intrinsic parameters per frame. 

 Click Load. The video frames are loaded into the project as photo files into a single photo collection.  

Loading a PhotoMesh Project 

When a PhotoMesh project (.PhotoMeshXML) is loaded into a second project, only the project’s photos 

and photo and collection parameters are loaded. Other project information (e.g. terrain objects, control 

points, and other project parameters) is not loaded.  

To load a PhotoMesh project: 

 On the Home tab, in the Add group, click the arrow next to Photos, and select select Load a Photo 

List File. The Load a Photo List File dialog box is displayed. 

 Browse to the required PhotoMesh project file. The project’s photos and photo and collection 

parameters are loaded into the project. 

Importing Photos with Metadata 

Import photos of different data types into the project with their metadata (e.g., sensor width, focal length, 

and aerotriangulation data). When importing Inpho or Bingo results in a Cartesian coordinate system, 

such as ENU or ECEF, the AT step of the build process can be skipped (by selecting “Fully trusted input,” 

in the Camera Position Accuracy AT setting). Imported AT data in a projected coordinate system such as 

UTM, however, may be unreliable either due to earth curvature or earth curvature corrections performed 

in the other system. This is particularly true for datasets that contain oblique photos or large frames, or 

cover a large geographic area. For data of this type, aerotriangulation should be re-performed in 

PhotoMesh, i.e., use Reliable instead of Fully trusted for the Camera Position Accuracy AT setting.  

▪ Importing Inpho Data 

▪ Importing Bingo Data 

▪ Importing Stellacore Data 

Importing Inpho Data 

When importing Inpho results, the AT step of the build process can sometimes be skipped. See 

“Importing Photos with Metadata” in this chapter for more information. 

To import Inpho Data: 

 On the Home tab, in the Add group, click the arrow next to Photos, and select Import Tool. The 

Import Tool dialog box is displayed. 

Note: The fields displayed vary depending on the type of data selected. 
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Import Tool 

 Enter the following information: 

Field Description 

Data Type Select the data type. 

Import Project File Click Browse. Then in the Import Project File dialog box, browse 
to the required file, and click Open. 

Image Folder Click Browse. Then in the Import Image Folder dialog box, 
browse to the required folder, and click Select Folder. 

Image Search Method Select one of the following options: 

▪ Recursive – To include image files in all subdirectories 

▪ Top Directory Only – To include image files only from the top 
level directory 

 Click Import. 

Importing Bingo Data 

When importing Bingo results, the AT step of the build process can sometimes be skipped. See 

“Importing Photos with Metadata” in this chapter for more information. 

To import Bingo Data: 

 On the Home tab, in the Add group, click the arrow next to Photos, and select Import Tool. The 

Import Tool dialog box is displayed. 

Note: The fields displayed vary depending on the type of data selected. 
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Import Tool 

 Enter the following information: 

Field Description 

Data Type Select the data type. 

Import Project File Click Browse. Then in the Import Project File dialog box, browse 
to the required file, and click Open. 

Image Folder Click Browse. Then in the Import Image Folder dialog box, 
browse to the required folder, and click Select Folder. 

Image Search Method Select one of the following options: 

▪ Recursive – To include image files in all subdirectories 

▪ Top Directory Only – To include image files only from the top 
level directory 

Angle Units Select the data’s angle units (Gons or Degrees). 

Rotation Order Select the rotation order (Phi-Omega-Kappa or Omega-Phi-
Kappa). 

WKT/ESPG Click Set to set the data’s coordinate system. See “Coordinate 
System” in the “Basic Concepts” chapter for more information. 

Camera Definition For each camera in the BINGO project file, enter the following 
information: 

▪ Camera ID – Camera name as it appears in the BINGO 
project file. This field is automatically filled in after the Import 
Project File is selected. 
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▪ Columns – Number of pixel columns in a photo taken with 
this camera (image width). 

▪ Rows – Number of pixel rows in a photo taken with this 
camera (image height). 

▪ PixelSize – Camera sensor’s pixel size.  

▪ GridFile (Optional): File with camera distortion information 
that may be supplied by your data provider together with the 
BINGO file. This information can be applied during import to 
reduce image distortion. Click the button to open the Select 
Grid Calibration File dialog box. Then browse for the grid file. 

 Click Import. 

Importing Stellacore Data 

To import Stellacore Data: 

 On the Home tab, in the Add group, click the arrow next to Photos, and select Import Tool. The 

Import Tool dialog box is displayed. 

Note: The fields displayed vary depending on the type of data selected. 

 

Import Tool 

 Enter the following information: 

Field Description 

Data Type Select the data type. 

Image Folder A folder containing the images. Click Browse. Then in the Select 
Image Folder dialog box, browse to the required folder, and click 
Select Folder. 
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Select one of the following search options: 

▪ Recursive – To include image files in all subdirectories 

▪ Top Directory Only – To include image files only from the top 
level directory 

EO Folder  A folder containing the external orientation information. Click 
Browse. Then in the Import EO Base Folder dialog box, browse 
to the required folder, and click Select Folder. 

Select one of the following search options: 

▪ Recursive – To include files in all subdirectories 

▪ Top Directory Only – To include files only from the top level 
directory 

Camera IO Folder A folder containing the camera’s internal orientation information. 
Click Browse. Then in the Import Camera IO Base Folder dialog 
box, browse to the required folder, and click Select Folder. 
Select one of the following search options: 

▪ Recursive – To include files in all subdirectories 

▪ Top Directory Only – To include files only from the top level 
directory 

 Click Import. 

Excluding a Photo 

To exclude a photo from the project: 

Note: Photos can only be excluded when Review mode is off. See "About Reviewing Your Build" in the 

"Reviewing Your Build" chapter for more information about Review mode. 

 In the Project Tree, select the required photo collection, and then in the Photo List, select the 

required photo. 

 On the Photo tab, in the Selection group, click Exclude. When a photo is excluded, the Exclude 

check box is selected in the photo list. 

Deleting a Photo 

To delete a photo from the project: 

Note: Photos can only be deleted when Review mode is off. See "About Reviewing Your Build" in the 

"Reviewing Your Build" chapter for more information about Review mode. 

Note: When a photo is deleted from a project, the photo is no longer available for inclusion within the 

same project. 

 In the Project Tree, select the required photo collection, and then in the Photo List, select the 

required photo. 

 On the Photo tab, in the Selection group, click Delete. The photo is deleted from the photo list. 
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Modifying Photo and Photo Collection Properties  

Photo data can be viewed and modified in the photo collection property sheet and photo list. Information 

displayed in the property sheet refers to the collection that is currently selected in the collection list, while 

information in the photo list is specific to each photo.  

Information about the photo collections and photos (e.g., coordinate system, sensor width, focal length, 

photo position information) is generally read from a loaded Excel or XML file that includes this 

information. These parameters can then be adjusted in the collection property sheet and photo list.  

 

To display and modify photo collection properties: 

 In the Project Tree, select the collection, and click the Properties tab. 

 In the collection property sheet, modify the property value as required. See “Collection Property 

Sheet” in this chapter for more information. 

To display and modify photo properties: 

 In the Project Tree, select the collection, and click the Photo List tab. 

 In the Photos list, select the required photos, and modify their properties as required. See "Photo 

List" in this chapter for information. 

Note: You can also search the list for the required photos. See “Selecting Items Using the Item 

List” in the “Basic Concepts” chapter for information. 
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Collection Property Sheet 
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Property Description 

Collection 

Name Name of the collection in the Project Tree. 

Calculate Camera Parameters Method of calculating the camera’s intrinsic parameters. 

▪ Entire collection – Calculate the AT so that the camera 
intrinsic properties are the same for all photos in the 
collection.  

▪ Per photo – Calculate the camera intrinsics individually for 
each photo in the collection. 

Note: Parameters should be calculated per photo when not all 
of a collection’s photos were taken by the same physical 
camera with identical focal length and principal point. 

Coordinate System Coordinate system of the collection. Click Select  to set a 
different coordinate system. See “Coordinate System” in the 
“Basic Concepts” chapter for more information. 

Ignore Orientation Ignore the orientation value. 

Orientation Method Select which system to use to set orientation: OPK (Omega, Phi, 
Kappa) or YPR (Yaw, Pitch, and Roll). This selection determines 
which fields are displayed in the Advanced Position section of the 
property sheet. 

Camera 

Focal Length Normalization Camera properties used to set the focal length. 

Select one of the following options: 

▪ Focal length and sensor width 

▪ Focal length and pixel size 

▪ Focal length 35 

Sensor Width  Size of the camera sensor in millimeters.  

Pixel Size  Size of a physical pixel on the camera sensor in millimeters. 

Focal Length Focal length in millimeters.   

Focal Length 35 Equivalent focal length in millimeters for a 35 mm film camera.  

Principal Point Reference Origin and units of the principal point. Select either: 

▪ Top left in pixels – Positive x-direction is to the right and 
positive y-direction is downwards. 

▪ Top left in mm – Positive x-direction is to the right and 
positive y-direction is downwards. 

▪ Center in pixels – Positive x-direction is to the right and 
positive y-direction is upwards. 

▪ Center in mm – Positive x-direction is to the right and positive 
y-direction is upwards. 
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Principal Point X Principal point X value in pixels or mm according to principal point 
reference.  

Principal Point Y Principal point Y value in pixels or mm according to principal point 
reference.  

Width Width of photo in pixels. 

Height Height of photo in pixels. 

Gamma Brightness of the photo’s colors.  

Effective Range Maximum distance from the camera position for which photo 
information is considered valid for the aerotriangulation.  

Calculated Effective Range Whenever the Effective Range parameter value is not provided, 
PhotoMesh calculates the maximum distance from the camera for 
which photo information is considered valid for the 
aerotriangulation, and then displays and uses this value. 

Crop Area Percentage of the photo to use in the project. Blurry or obstructed 
areas on the edges of a photo will be cropped based on this 
property value. 

Use in Textured Model Select the check box to include this collection in the textured 
model. 

Use in Orthophoto Select the check box to include this collection in the orthophoto. 

Use in Point Cloud Select the check box to include this collection in the point cloud 
output. 

Bands – Hyperspectral 

Hyperspectral bands in the collection’s photos. These bands can be used in texturing the 3D 
model and in generating the orthophoto. See “Setting Reconstruction Parameters” and “Setting 
Output Formats” in the “Building” chapter. 

Note: The band information is retrieved from the collection information in the photo list Excel or 
XML, the collectionProperties XML, or from the first photo in the collection. See “Loading 
an Excel or ContextCapture XML Photo List File” and “Loading Photo Files from Disk” in 
the “Photo Management” chapter. You can manually set the value for each band in the 
property sheet.    

1 Select the first band. 

2 Select the second band. 

3 Select the third band. 

Camera Distortion (Optional) 

Radial and tangential distortion calculated using the Brown-Conrady model. See 
https://en.wikipedia.org/wiki/Distortion_(optics)#Software_correction for more information. 

K1 Defines the 1st radial distortion coefficient. 

K2 Defines the 2nd radial distortion coefficient. 

K3 Defines the 3rd radial distortion coefficient. 

P1 Defines the 1st tangential distortion coefficient. 

P2 Defines the 2nd tangential distortion coefficient. 

Advanced Position (Either OPK or YPR offset and flip values will be displayed, depending on 
your selection above for Orientation Method) 

https://en.wikipedia.org/wiki/Distortion_(optics)#Software_correction
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Altitude Offset Offset from the current altitude value. 

Omega Offset Offset along the Omega axis in degrees. 

Phi Offset Offset along the Phi axis in degrees. 

Kappa Offset Offset along the Kappa axis in degrees. 

Flip Omega Flips the Omega axis. 

Flip Phi Flips the Phi axis. 

Flip Kappa Flips the Kappa axis. 

Yaw Offset Offset along the Yaw axis in degrees. 

Pitch Offset Offset along the Pitch axis in degrees. 

Roll Offset Offset along the Roll axis in degrees. 

Flip Yaw Flips the Yaw axis. 

Flip Pitch Flips the Pitch axis. 

Flip Roll Flips the Roll axis. 

Secondary Yaw Rotation Additional rotation along the Yaw axis in degrees, that is 
performed in YPR order after the photos' OPK or YPR orientation 
and offsets were applied. 

Secondary Pitch Rotation Additional rotation along the Pitch axis in degrees, that is 
performed in YPR order after the photos' OPK or YPR orientation 
and offsets were applied. 

Secondary Roll Rotation Additional rotation along the Roll axis in degrees, that is 
performed in YPR order after the photos' OPK or YPR orientation 
and offsets were applied. 

 

Photos List 

In the Photos list, you can view and set photo properties, as well as set photo visibility and inclusion in the 

project. When calculated camera positions are displayed, you can also view calculated property 

information for a selected photo. See “About the Item List” in the “Using the Project Tree and Item List” 

chapter for information on working with the Photos list.  
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Photo List 

To open the Photos list: 

▪ In the Project Tree, select a Photos collection. The Photos list lists all the photo files in the 

collection, with the following information/options:  

 

Property Description 

Selection Select the photos on which to perform an action, e.g., create tie 
point, show/hide camera symbol, exclude, delete. 

Collection Name of the photo collection (Read-only). 

Name  Name of the photo. 

Visible Select the check box to show the photo in the 3D Window. 

Exclude Select the check box to exclude the photo from the project. This 
option is not available in Review mode. 

Project Original Select the check box to project the photo on the terrain in its 
original camera position. A photo can be projected on the terrain 
to see if it fits the terrain imagery or to better understand the 
position of the photo. Only photos that have positioning (XY 
coordinates and altitude) and orientation (Omega, Phi, and 
Kappa) information can be projected. 

Note: Projecting multiple photos simultaneously can take 
several minutes. 

X East-west coordinate of the camera. (Required) 

Y North-south coordinate of the camera. (Required) 

Altitude  Altitude of the camera in meters. (Required)  

Omega Omega Euler angle in degrees. 

Phi Phi Euler angle in degrees. 

Kappa Kappa Euler angle in degrees. 
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Yaw Direction angle of the camera along the vertical axis relative to 
north. 

Pitch Tilt angle of the camera along its lateral axis relative to the 
horizon. 

Roll Roll angle of the camera along its longitudinal (front-to-back) axis. 

Path Full path of the photo.  

K1 Defines the 1st radial distortion coefficient. 

K2 Defines the 2nd radial distortion coefficient. 

K3 Defines the 3rd radial distortion coefficient. 

P1 Defines the 1st tangential distortion coefficient. 

P2 Defines the 2nd tangential distortion coefficient. 

Calculated Cameral Position Information (Additional columns)  

Note: If you want to view calculated information for a selected photo, click the Calculated button 
on the Tile tab. 

Project Calculated Select the check box to project the photo on the terrain in its 
calculated camera position. 

Median Error   Median of the triangulation errors of all the features in the photo. 
The triangulation error is the distance, in pixels, for each of the 
features in the photo, between the automatically identified feature 
and its projected triangulation position. 

X Calculated Calculated east-west coordinate of the camera. 

Y Calculated Calculated north-south coordinate of the camera.  

Altitude Calculated Calculated altitude of the camera in meters.  

Omega Calculated Calculated Omega Euler angle in degrees. 

Phi Calculated Calculated Phi Euler angle in degrees. 

Kappa Calculated Calculated Kappa Euler angle in degrees. 

K1 Calculated Calculated 1st radial distortion coefficient. 

K2 Calculated Calculated 2nd radial distortion coefficient. 

K3 Calculated Calculated 3rd radial distortion coefficient. 

P1 Calculated Calculated 1st tangential distortion coefficient. 

P2 Calculated Calculated 2nd tangential distortion coefficient. 
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CHAPTER 11  LIDAR MANAGEMENT 

About Lidar Management 

Lidar (light imaging, detection and ranging) is a remote sensing method that uses pulsed laser light to 

measure terrain and objects. This data together with other information recorded by the sensor system is 

used to generate a densely spaced point cloud of highly accurate geo-referenced points.  

Lidar data can be loaded into a PhotoMesh project and integrated with project photos to refine and 

enhance the 3D model, producing cleaner results and preventing artifacts, while increasing the level of 

accuracy of the complete PhotoMesh process: 

▪ Lidar improves the precision of the mesh geometry, since Lidar has less noise-to-signal ratio than 

image-based correlation. This means smoother and cleaner roads, facades, and other planar 

surfaces. 

▪ Lidar helps in areas that are very homogenous and don’t have a lot of texture to produce image 

correlation points (wide roadways with no markings, white rooftops, repetitive vegetation like crops or 

grass, etc.). 

▪ Lidar makes it easier to get into tight angles in urban areas, since Lidar only needs a single ray to 

reach the bottom of a building or inside an alley in order to have it measured, whereas with image 

correlation two images with enough angular disparity are required to reach a feature and to be able to 

correlate depth in that point. 

▪ Lidar enhances street level data, providing points underneath vegetation and where trees get close to 

buildings. 

▪ Lidar improves fine details of complicated features such as scaffolding, tops of towers, draw bridges, 

cranes, etc. 

▪ Lidar provides a geographic control to achieve a high level of absolute accuracy in the final 3D mesh 

and additional geospatial products. 

The Lidar data's proper alignment with the project's photos can be verified and corrected using ground 

control points and through projection of the photos on the Lidars. See "Projecting a Photo on the Terrain" 

in the "Preparing the Project" chapter and "Creating Ground Control Points from Identifiable Locations on 

the Terrain" in the "Control Points" chapter for more information.  

 

This chapter deals with basic Lidar management tasks:  

▪ Loading of Lidar data 

▪ Modifying Lidar properties 

▪ Associating a Lidar point cloud with its trajectory data 

▪ Showing Lidar point cloud on terrain 

▪ Navigating to a Lidar 

▪ Excluding/deleting Lidar files from the project 

 



 

122 

PhotoMesh User Guide 

Loading Lidar Data 

Lidar data can be loaded into a PhotoMesh project and integrated with project photos to supplement 

project data and increase model accuracy. PhotoMesh supports Lidar data in .las, .laz or .e57 formats. To 

improve the reconstruction of the model, Lidar data can be loaded together with a trajectory file that 

provides information about the scanner’s position while capturing the point cloud. Some .e57 files include 

internal trajectory information and therefore do not require an external one. Lidar are converted to CPT, 

PhotoMesh's internal format, during the build's data preparation step or by Showing Point Cloud. See 

“About Building” in the “Building” chapter and “Showing a Lidar Point Cloud on the Terrain” in this chapter 

for more information.   

If Lidar files are loaded after aerotriangulation is performed and reconstruction has already started, all 

reconstruction tiles that intersect with the new Lidar’s bounding box are restored to the point cloud step. 

This ensures that all necessary processing is performed when the Build Start From step is set to Auto. 

See "Setting Build Steps" in the "Building" chapter for more information.  

To load Lidar files from your local disk: 

 On the Home tab, in the Add group, click the arrow next to Lidar, and select one of the following: 

▪ Load files – To add selected files. 

▪ Load folder – To add an entire folder. All supported Lidar files in the folder are loaded. 

 Browse to the required folder/file(s) and click Open. 

 Set the Lidar’s coordinate system including its vertical datum.  

Note: If incorrect coordinate system information is entered, the *.CPT created for Lidar will need 

to be manually deleted from the project directory: PM_project\cpts\ 

 Add a trajectory file and modify Lidar properties, as required, in the Lidars list. See “Modifying Lidar 

Properties” and “Associating a Lidar Point Cloud with its Trajectory Data” in this chapter for 

information.  

Modifying Lidar Properties  

Lidar data can be viewed and modified in the Lidars list and point cloud properties dialog box. This dialog 

box is accessed from a right-click menu as described below.  

To display and modify Lidar point cloud properties: 

 In the Project Tree select the Lidars group, and then in the Lidars list, select the required Lidar. 

 For basic properties such as path and coordinate system, in the Lidars list, select the check boxes of 

the required Lidar, and modify their properties as required. See “Lidar List” in this chapter for more 

information.  

Note: You can also search the list for the required Lidar. See “Selecting Items Using the Item 

List” in the “Basic Concepts” chapter for information. 

 For point styling properties and other properties relating to how the point cloud is displayed, right-click 

the required Lidar, and select Style Point Cloud. The Point Cloud Properties dialog box is displayed. 

See “Lidar Point Cloud Properties Dialog Box” in this chapter for more information.  

Note: A Lidar must be converted to CPT, PhotoMesh's internal format before it can be styled. 

You can convert the Lidar by performing the build's data preparation step or by Showing 

Point Cloud. See “About Building” in the “Building” chapter and “Showing a Lidar Point 

Cloud on the Terrain” in this chapter for more information.  
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Lidar Point Cloud Properties Dialog Box 

Property Description 

Style 

Point Size Size, in pixels, of each of the Lidar point cloud’s points. If you want 
to base the point size on attribute fields, click the Field by 

Attribute button . In the Field by Attribute dialog that opens, 
select the attribute on which to base point size. Then for each 
attribute value, type the value and the corresponding point size. 

Point Color Color of the Lidar point cloud points. This can be set to either of 
the following: 

▪ A set color value for all the points. To select a color, click Edit 
and select a color.  

▪ Based on a specific attribute field - To base each point of the 
point cloud’s color on a specific attribute field’s value, click the 

Field by Attribute button . In the Field by Attribute dialog 
that opens, select the attribute on which to base point color. 
Then for each attribute value, type the value and the 
corresponding point color, e.g., color each point of the point 
cloud according to the CPT’s RGB attribute values or 
according to the CPT’s intensity attribute values. 

Point Visibility Determines if the Lidar point cloud’s points are visible. To set the 
visibility of points based on their attribute values, click the Field by 

Attribute button . In the Field by Attribute dialog that opens, 
select the attribute on which to base visibility. Then for each 
attribute value, type the value and the corresponding visibility 
setting.  

Intensity Blend Determines how much the Lidar point cloud’s intensity value is 
factored in colorizing the point cloud, where 0% colorizes the point 
cloud model by point color only, and 100% colorizes by intensity 
only. 

Oversampling The Lidar point cloud’s Level of Detail (LOD). When set to Normal, 
PhotoMesh determines the optimal quality to performance balance 
based on the current view. The “High” and “Best” settings will load 
more points but are also more resource-intensive. 

Flatten Underlying Terrain Determines if the terrain under the model is leveled to the model’s 
elevation value. 

This option is enabled only if the Altitude Method property in the 
point cloud property sheet is set to Absolute. 

Hide Underlying Terrain Hides the terrain texture under the Lidar point cloud model (the 
terrain appears as a black image). 
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Lidar List 

In the Lidar list, you can view and set the Lidar’s coordinate system, path and trajectory path, as well as 

set Lidar visibility and inclusion in the project. See “About the Item List” in the “Using the Project Tree and 

Item List” chapter for information on working with the Lidars list.  

 

Lidar List 

To open the Lidars list: 

In the Project Tree, select the Lidars group. The Lidars list displays all the Lidar files in the project, and 

the following information:  

 

Property Description 

Selection Select the check box to select the Lidar in the 3D Window. 

# Number of the Lidar. 

Excluded Select the check box to exclude the Lidar point cloud from the 
project.  

Box Select the check box to show the Lidar's bounding box. 

Name Name of Lidar file. 

Point Cloud Select the check box to show a Lidar point cloud on the terrain. 

Path Full path to the Lidar point cloud. 

Coordinate System Coordinate system of the Lidar point cloud. Click Select  to set 
a different coordinate system. See “Coordinate System” in the 
“Basic Concepts” chapter for more information. 

Trajectory Path Full path to file that provides information about the scanner’s 
position while capturing the point cloud. See “Associating a Lidar 
Point Cloud with its Trajectory Data" in this chapter for more 
information on trajectory files. 
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Tag Free text about the Lidar 

 

Associating a Lidar Point Cloud with its Trajectory Data  

Trajectory data provides information about the scanner’s position while capturing the Lidar point cloud. 

The scanner positions should be ordered chronologically in the file. 

Note: Some .e57 files include internal trajectory information and therefore do not require an external 

one. 

Trajectory data can be imported in a tab delimited .trjt (text format) file that includes the following lines:  

▪ First line: Define the Lidar version (Should always be 1.0) 

#version=1.0 

▪ Second line: Define the Lidar’s coordinate system in WKT format.  

wkt=…… 

Note: The WKT information must be in a single line without any line breaks. You can use the 

Coordinate System Generator to generate a WKT string defining the required coordinate 

system. See “Coordinate System” in the “Basic Concepts” chapter for more information. 

▪ Third line (optional): Indicates a time offset that should be added to the GPS time field in each record 

(default is 0).  

#timebase=  

▪ For each known scanner position, add a separate line with the scanner’s position (X, Y, Altitude) and 

the time the position was recorded (GPS Time) in tab delimited format. The scanner positions should 

be ordered chronologically. 

[x coordinate] <TAB> [y coordinate] <TAB> [altitude] <TAB> [GPS time] 

Note: The GPS Time is the double floating point time tag value at which the scanner’s position 

was recorded. This data must be in the same units and offset as the time data in the Lidar 

file.  

Example: 

#version=1.0 

wkt=GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS 

84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],AUTHORITY["EPSG","6326

"]],PRIMEM["Greenwich",0,AUTHORITY["EPSG","8901"]],UNIT["degree",0.0174532

925199433,AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]] 

#timebase=0 

 

9.63390819201651 <TAB> 47.4233597051724 <TAB> 401.463806152344 <TAB> 

583.161876711994 

9.63390818337074 <TAB> 47.4233597019402 <TAB> 401.463793239556 <TAB> 

583.161876711994 

9.63390817652904 <TAB> 47.4233597069347 <TAB> 401.463349871528 <TAB> 

583.161876711994 

9.63390818337074 <TAB> 47.4233597019402 <TAB> 401.463407984571 <TAB> 
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583.160397257656 

To associate a Lidar file with its trajectory file: 

▪ In the Project Tree select the Lidars group, and then in the Lidars list, select the required Lidar and 

type the trajectory file's path in the Trajectory Path field.  

 

Showing a Lidar Point Cloud on the Terrain 

A Lidar can be shown on the terrain to see if it fits with the project's photos, other Lidar, ground control 

points, etc.  

Note: The Lidar data's proper alignment with the project's photos can be verified and corrected using 

ground control points and through projection of the photos on the Lidars. See "Projecting a Photo 

on the Terrain" in the "Preparing the Project" chapter and "Creating Ground Control Points from 

Identifiable Locations on the Terrain" in the "Control Points" chapter for more information. 

To show a Lidar on the terrain: 

 In the Project Tree select the Lidars group, and then in the Lidars list, select the Point Cloud check 

box for each of the Lidars you want to display. The Lidar (contextual) tab is displayed.  

Note: If a particular Lidar wasn’t converted previously to CPT, PhotoMesh’s internal format, it will 

first be converted and then shown on the terrain.  

Note: If you want to show more than one Lidar point cloud on the terrain, it is generally 

recommended to build the project, performing only the Data Preparation step since the 

conversion to CPT performed via View > Point Cloud may take a long time. 

 If you want to show a Lidar's trajectory data, select the Lidar and then on the Lidar tab, in the View 

group, toggle on Trajectory. 

 If you want to hide a Lidar’s bounding box, select the Lidar and then on the Lidar tab, in the View 

group, toggle off Bounding Box. 

Navigating to a Lidar 

To fly or jump to a Lidar: 

 In the Project Tree select the Lidars group, and then in the Lidars list, select the required Lidar. 

 On the Lidar tab, in the Navigation group, select Fly to/ Jump to.  

Excluding a Lidar File 

To exclude a Lidar file from the project: 

 In the Project Tree select the Lidars group, and then in the Lidars list, select the required Lidar. 

 On the Lidar tab, in the Selection group, click Exclude. When a Lidar is excluded, its Excluded 

check box is selected in the Lidars list. 

Deleting a Lidar File 

To delete a Lidar from the project: 

 In the Project Tree select the Lidars group, and then in the Lidars list, select the required Lidar. 

 On the Lidar tab, in the Selection group, click Delete. The Lidar is deleted from the Lidars list. 
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CHAPTER 12  PREPARING THE PROJECT 

About Preparing the Project 

After photos have been loaded, do any of the following to prepare for the build: 

Set display of photos 

▪ Select the photos for which symbols are displayed 

▪ Select the size and color coding of the camera symbols that display for each photo 

Study photos and modify photo properties 

▪ Navigate to a photo 

▪ View photos in the photo viewer 

▪ Project photos on the terrain to see if they fit the terrain imagery or to better understand their position 

▪ Show a color-coded map analyzing photo coverage in every point of the AT area 

▪ Show a color-coded connection map that indicates the level of photo interconnection   

▪ Modify photo and photo collection properties (in “Photo Management” chapter)  

▪ Use ground control points to position the model by associating specific locations (x, y, altitude) on the 

terrain with corresponding locations (in pixels) in three or more photos (in “Control Points” chapter) 

▪ Use tie points to establishing a correspondence between project photos and improve 

aerotriangulation results through identification of the same physical point in three or more photos (in 

“Control Points” chapter) 

Generate a flat surface with correct texturing over a user-defined water body 

▪ Create a water body polygon 

▪ Import a water body polygon 

Set the aerotriangulation and reconstruction areas 

▪ Set the AT area 

▪ Set the reconstruction area 

Displaying and Studying Photos 

Displaying Camera Symbols 

Each photo’s camera position and orientation (if known) can be displayed on the terrain using camera 
symbols. The symbol’s color also indicates either the photo’s collection or its status ((in original position, 
in calculated position, failed to calculate, or excluded by user). You can show all photos or you can filter 
which photos are displayed: 

▪ Display only the photos individually selected in the Photos list or the collections selected in the 

Project Tree.  

▪ Display only photos that cover a selected point on the terrain. 
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▪ Display only photos that were not excluded from the project. 

To select specific photos from the Project Tree for viewing on the terrain, do any of the following: 

▪ In the Project Tree, select the check boxes of the collections you want to display. All of the selected 

collections' photos will be displayed. 

▪ In the Project Tree, select the required photo collection, and then in the Photos list, select the 

Visible check box of the required photos. 

▪ In the Project Tree, select the required photo collection, and then in the Photos list, select the 

required photos, and on the Photo tab, in the Selection group, toggle off Hide Symbol. 

To select photos for viewing that cover a selected point on the terrain, do the following: 

 Do either of the following: 

▪ If you want to display all photos that intersect with a selected point based on original photo 

positions, on the Home tab, in the Photos group, click the arrow under Show Photos in Point 

and select Show Original Photos in Point. 

▪ If you want to display all photos that intersect with a selected point based on aerotriangulation 

calculations, on the Home tab, in the Photos group, click the arrow under Show Photos in Point 

and select Show Calculated Photos in Point. 

 In the 3D Window, click the point of interest. All photos that cover the selected point are displayed.  

 To (re)display all photos, on the Home tab in the Photo group, click Show All Photos.  

To display only photos that were not excluded from the project: 

 On the View tab, in the Photos group, select Do not show excluded. All excluded photos and 

photos outside the currently defined AT area are hidden. See “Excluding a Photo” in the “Photo 

Management” chapter for information about excluding photos. 

 To (re)display excluded photos, on the View tab, in the Photos group, select Show excluded. 

Selecting Camera Symbol Size and Color Coding 

To select a camera symbol size: 

▪ On the View tab, in the Photos group, in the Symbol size drop-down, select a size for the camera 

symbols that display for each photo. 

To select a camera color coding option: 

▪ On the View tab, in the Photos group, in the Photo color drop-down, select either of the following: 

▪ Color by status – Camera symbols are color coded based on photo status (in original position, in 

calculated position, failed to calculate, or excluded by user), according to the colors defined in 

Options’ settings. See “Setting PhotoMesh Options” in the “Basic Concepts” chapter for more 

information. 

▪ Color by collection – Camera symbols are color coded according to collection, with a random 

color assigned to each collection’s camera symbol. 

Navigating to a Photo 

To fly or jump to a photo: 

 In the Project Tree, select the required photo collection, and then in the Photos list, select the 

required photo. 
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 On the Photo tab, in the Navigation group, select Fly to/ Jump to.  

Note: You can also fly to the selected photo by double-clicking it in the Photos list. 

Viewing Photos in the Photo Viewer 

To view a photo in the Photo Viewer: 

 In the Project Tree, select the required photo collection, and then in the Photos list, select the 

required photo. Only one photo can be viewed in the Photo Viewer at a time. The Photo tab is 

displayed. 

 In the View group, click Photo Viewer. The Photo Viewer opens with the selected photo displayed. 

 Use the Photo Viewer ribbon commands to zoom in and out or Fit to Window. 

 If you want to see how many other photos have each of the features automatically identified in this 

photo, click Show Features. The photo’s features are color coded according to the number of other 

photos in which they appear:  

▪ Gray – Feature wasn’t found in any other photo (no match)  

▪ Yellow – Feature was found in one other photo 

▪ Green – Feature was found in two or more photos  

Note: This information is only available in Review mode after aerotriangulation was completed. 

See “Setting Build Parameters and Processing the Build” in the “Building” chapter. Build 

steps after aerotriangulation do not need to be completed to view this information. 

 

Show Features 
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Projecting a Photo on the Terrain 

A photo can be projected on the terrain (including Lidar) to see if it fits the terrain imagery or to better 

understand the position of the photo. The projection of the photo can be based either on its original 

position or its calculated position. Only photos that have positioning (XY coordinates and altitude) and 

orientation (Omega, Phi, and Kappa) information can be projected based on original positions.  

To project a photo on the terrain in its original camera position: 

 In the Project Tree, select the required photo collection, and then in the Photos list, select the 

required photo. The Photo (contextual) tab is displayed. 

 On the Photo tab, in the View group, select Project Original. The photo is shown on the terrain, and 

the photo's Project Original check box is selected in the Photos list. 

To project a photo on the terrain from the camera position calculated through aerotriangulation: 

 On the Home tab, in the Photos group, click the arrow under Show Photos in Point and select 

Show Calculated Photos in Point. 

 In the 3D Window, click the point of interest. All photos that cover the selected point are displayed. 

 In the 3D Window, select the required photo. The Photo (contextual) tab is displayed. 

 On the Photo tab, in the View group, select Project Calculated. The photo is shown on the terrain, 

and the photo's Project Calculated check box is selected in the Photos list. 

Clearing Review Data from the Terrain 

To clear review data: 

▪ On the Home tab, in the Review group, click Clean Review Data. This clears any photo projections 

from the terrain. 

Showing the Coverage Map 

The coverage map is a color-coded map displaying photo coverage in every point of the defined AT area. 

This enables you to identify which areas of the project have sufficient coverage and which require more. 

The AT area can be defined to include all the project’s photos or restricted to only the photos within a 

specific area on the terrain. See “Setting the AT (Aerotriangulation) Area” in this chapter for more 

information. 

The map can display coverage based on either the original positions of the project’s photos or their 

calculated positions.  

Note: The coverage map may take some time to display the first time it is shown or after making 

changes to the project as PhotoMesh (re)calculates the photo coverage. 

 

To show a coverage map: 

▪ On the Home tab, in the Photos group, click the arrow next to Coverage Map. and select one of the 

following: 

▪ Coverage Map from Original 

▪ Coverage Map from Calculated 
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Coverage Map and Legend 

In the coverage map, the AT area is color coded based on directionality and coverage. 

▪ Green – Best coverage from all 5 directions: nadir and 4 oblique. 

▪ Yellow – Sufficient coverage of 4 directions. 

▪ Orange – Three coverage directions, the minimum required. 

▪ Red – Two coverage directions. 

▪ Purple – One coverage direction. 

▪ Black – No coverage.  

 

▪  

Showing the Connection Map 

The connection map is a color-coded map that enables you to evaluate the quality of the AT. In the 

connection map, each point in the defined AT area is colored based on the level of interconnection of the 

photos that intersect with this point. A group of photos is considered interconnected if each photo in the 

group was directly or indirectly matched with every other photo. Even photos that do not precisely 

intersect  with the point in the defined AT area can be used to create an indirect connection, as long as 

they come close to intersecting with the point (i.e., if photos A and D precisely intersect with the point in 

the AT area, and photos B and C nearly intersect with the point, photo A can be connected to photo D via 

photos B and C, where A intersects with B which intersects with C, which intersects with D).  
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▪ Green – All of the photos that intersect with this point are interconnected.  

▪ Red – 50% of the photos that intersect with this point are interconnected 

Each point in the defined AT area is colored on the gradient between green and red, based on the 

percentage of photos that intersect with the point. 

If the connection map indicates that insufficient photo matches were generated for certain points in the AT 

area, tie points can be used to manually create matches for these points. See “About Control Points” in 

the "Control Points" chapter for information. 

You can also display the number of matches for each photo by selecting Number of Matches as the color 

coding option for the photos. See “Displaying Calculated Camera Positions for Tiles” in the “Reviewing 

Your Build” chapter for more information. 

To show a connection map: 

▪ On the Home tab, in the Photos group, click the arrow next to Coverage Map. and select 

Connection Map from Calculated. 

 

Setting the AT (Aerotriangulation) Area 

Setting the AT area defines the area of the project on which PhotoMesh should perform aerotriangulation. 

Aerotriangulation is the process for determining the correct position and orientation of each of the project 

photos, based on inputted photo information, ground control points and tie points. If a project’s photos do 

not have fully trusted camera positioning and orientation information, this process must be performed 

before generation of the 3D mesh model. PhotoMesh uses the highest-performance photogrammetry, 

computer vision, and computational geometry algorithms in performing aerotriangulation. 

The defined AT area can include all the project’s photos or be restricted to only the photos within a 

specific area on the terrain. This enables you to perform aerotriangulation on a small subset of the project 

to validate camera parameters and build settings and check the resulting AT and reconstruction tiles 

before building the full project. The area for the aerotriangulation can be defined by either drawing or 

importing an AT polygon. 

If project photos have no positioning information, you should manually set an initial AT area based on an 

estimation of the geographical area of the project, which will then be adjusted by PhotoMesh in the 

aerotriangulation step. 

There are two indicators in the 3D Window that photos are outside the current aerotriangulation area: 

▪ When photos are “colored by status” (See “Selecting Camera Symbol Size and Color” in this chapter), 

the camera symbols for these photos will be colored in grey. 

▪ When “Do not show excluded” is selected (See “Displaying Camera Symbols” in this chapter), the 

camera symbols for these photos are not displayed. 

Note: Photos that are outside the currently defined AT area are still considered part of the project and 

therefore the Exclude check box remains cleared in the Photos list.  

Setting the AT Area to Include All Photos 

PhotoMesh can automatically calculate the AT area based on the polygon that includes all the project’s 

photos plus a buffer. The automatic AT area’s buffer can be based on the collections’ largest effective 

range, i.e., the maximum distance from the camera for which photo information is considered valid for 

aerotriangulation, or on a buffer you set. 
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To set the AT area to include all the project’s photos: 

 On the Home tab, in the Area group, click the arrow under AT Area and select Change Automatic 

Setting. The Automatic Area Setting dialog box is displayed. 

 

Automatic Area Setting Dialog Box 

 Select one of the following options: 

▪ Photo collections' effective range - Calculate the AT area based on the positions of all the 

project’s photos plus a buffer that is based on the collections’ largest effective range. 

▪ Use buffer of - Calculate the AT area based on the positions of all the project’s photos plus the 

buffer that you set. 

 On the Home tab, in the Area group, click the arrow under AT Area and select Automatic Using 

Effective Range/Automatic Using Buffer. The option that is displayed corresponds to the option 

selected in step 2.   

Drawing a New AT Area 

To set an AT area within a specific area of interest, do the following: 

Note: An AT Area polygon can only be redrawn when Review mode is off. See "About Reviewing Your 

Build" in the "Reviewing Your Build" chapter for more information about Review mode. 

 On the Home tab, in the Area group, click the arrow under AT Area and select Redraw AT Area. 

 In the 3D Window, draw an AT Area polygon around the required area by clicking in the required 

locations. You must place at least three points. Right-click to finish the polygon creation. 

Importing an AT Area Polygon 

To import an AT area polygon; 

 On the Home tab, in the Area group, click the arrow under AT Area, and select Import. The Import 

Aerotriangulation Area Polygon Layer dialog box is displayed. 

 Browse to the shapefile with the required polygon, and click Open. 

Note: The first polygon found in the file is used as the aerotriangulation area polygon. 

Editing an AT Area Polygon 

To edit the current AT area: 

Note: An AT Area polygon can only be edited when Review mode is off. See "About Reviewing Your 

Build" in the "Reviewing Your Build" chapter for more information about Review mode. 

 On the Home tab, in the Area group, click the arrow under AT Area and select Edit AT Area. 
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 In the 3D Window, place the cursor over one of the nodes of the AT Area polygon. The node turns 

blue, and the cursor changes to Move mode . 

 Click the node and drag it to the required location.  

 Release the mouse button to set the node at the current location. 

 Red dots on the polygon’s line segments indicate where a node can be added. Click to add a node, 

and then drag it to the required location. 

 Right-click to finish editing the polygon. 

Navigating to the AT Area 

To fly or jump to the AT area: 

▪ On the Home tab, in the Area group, click the arrow under AT Area and select Fly to Area/Jump to 

Area. 

Setting the Reconstruction Area 

Setting the reconstruction area defines the area of the project on which PhotoMesh should perform the 

reconstruction steps of the build process, namely: point cloud creation, model creation, model texturing, 

and project output. The reconstruction area can be defined before building the project (after identifying 

which areas of the project have sufficient coverage using the coverage map) and also after the build is 

complete if modifications to the build area are necessary. The same area set for the aerotriangulation can 

be automatically set for the reconstruction area, or a different area can be defined by either drawing or 

importing a reconstruction polygon.  

Setting a Reconstruction Area Equal to the AT Area 

To set a reconstruction area that is the same as the AT area: 

▪ On the Home tab, in the Area group, click the arrow under Reconstruction Area, and select Same 

as AT Area. 

Drawing a New Reconstruction Area 

To draw a reconstruction area polygon: 

 On the Home tab, in the Area group, click the arrow under Reconstruction Area, and select Redraw 

Reconstruction Area. 

 In the 3D Window, draw a reconstruction area polygon around the required area by clicking in the 

desired locations. You must place at least three points. Right-click to finish the polygon creation.  

Importing a Reconstruction Area Polygon 

To import a reconstruction area polygon; 

 On the Home tab, in the Area group, click the arrow under Reconstruction Area, and select Import. 

The Import Reconstruction Area Polygon Layer dialog box is displayed. 

 Browse to the shapefile or KML with the required polygon, and click Open. 

Note: The first polygon found in the file is used as the reconstruction area polygon. 
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Editing a Reconstruction Area Polygon 

To edit a current reconstruction area polygon: 

 On the Home tab, in the Area group, click the arrow under Reconstruction Area, and select Edit 

Reconstruction Area. 

 In the 3D Window, place the cursor over one of the nodes of the reconstruction area polygon. The 

node turns blue, and the cursor changes to Move mode . 

 Click the node and drag it to the required location.  

 Release the mouse button to set the node at the current location. 

 Red dots on the polygon’s line segments indicate where a node can be added. Click to add a node, 

and then drag it to the required location. 

 Right-click to finish the polygon editing. 

Exporting a Reconstruction Area Polygon 

To export a reconstruction area polygon: 

 On the Home tab, in the Area group, click the arrow under Reconstruction Area, and select Export. 

The Export Reconstruction Area Polygon dialog box is displayed. 

 Browse to the location you want to save to and click Save. 

Navigating to the Reconstruction Area 

To fly or jump to the reconstruction area: 

▪ On the Home tab, in the Area group, click the arrow under Reconstruction Area and select Fly to 

Area/Jump to Area.  
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CHAPTER 13  CONTROL POINTS 

About Control Points 

PhotoMesh provides three types of control points: 

▪ Ground control points (GCP) – Improve the accuracy of the model’s position by associating real-

world X, Y, Z coordinates (generally obtained through surveying or sampling methods) with 

corresponding locations (in pixels) in photos. In order to enable your control points to be fully utilized 

in the AT process, it is recommended to add at least 3-5 control points per AT tile. When only two 

control points are provided, simple vertical adjustment, scaling and rotation are performed. When only 

one control point is provided, only vertical adjustment is performed. 

▪ Check points – Ground control points that do not affect the AT calculation and are only used to 

sample the AT accuracy in the result. The point is included in the build report and shows calculated 

errors for accuracy validation purposes. 

▪ Tie points – Establish a correspondence between project photos and improve aerotriangulation 

results through identification of the same physical point in three or more photos. The XYZ position of 

the physical point is not necessarily known. Generally, it is recommended to run an initial 

aerotriangulation to identify photos that either weren’t calculated in AT or that have high median 

errors, as well as areas of insufficient matches between groups of photos. 

When a control point is added, a control point symbol is displayed in the 3D Window in the place where it 

was added. When selected, the control point turns to purple.  

    

Control Point Symbol 

 

Do any of the following: 

▪ Create control points: 

▪ Ground control points 

▪ Tie points 

▪ Navigate to a control point 

▪ Edit a control point 

▪ Mark a control point in photos 

▪ Hide a control point symbol 

▪ Exclude a control point 
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▪ Delete a control point  

▪ Export control point data to a tab delimited .gcp (text format) file  

▪ Import control point data in a tab delimited .gcp (text format) file 

▪ Use control point as a check point to sample the AT accuracy in the result 

The capabilities listed above (except for the export of control point data) are available from the Control 

Point contextual tab and also from the control point shortcut menu. See “Control Point Menu” in the 

“Using the Project Tree and Item List” chapter for more information. Control point data is exported from 

the Control Points command on the Home tab. 

Recommendations for Ground Control Point Placement 

The following guidelines are recommended for placement of control points in your AT tiles: 

▪ Distribute control points uniformly across the AT tile. 

▪ Make sure to add control points in the tile areas with the highest and lowest altitudes. 

▪ Begin control point creation by adding control points around the perimeter of the tile. 

▪ Control points should be created on a flat terrain or mesh that has no obstructions close by. 

Creating Ground Control Points 

Ground control points can be created/added in any of the following ways: 

▪ Create a control point at a known precise position, generally a surveyed point 

▪ Create a control point by clicking on an identifiable location on the terrain or Lidar (e.g. road 

intersection or street corner)  

▪ Import a tab delimited .gcp (text format) file with control point information 

After creating a ground control point, you mark it in the relevant photos using the Control Point Editor. 

See “Marking Control Points in Photos” in this chapter for information.     

Creating Ground Control Points at Known Coordinates 

To create a ground control point at known coordinates:  

 On the Home tab, in the Add group, click the arrow under Control Points and select Create Ground 

Control Point. The Control Point Editor is displayed with the newly-created control point selected in 

the control point table at the bottom of the Editor.  

Note: You can also create a control point at known coordinates from the Control Point Editor: On 

the Home tab of the Control Point Editor, in the Control Point group, click Add New.  

 Set the control point coordinates and properties. See “Editing Control Points” in this chapter for 

information. 

 Mark the control point in the relevant photos, and then save the project. See “Marking Control Points 

in Photos” in this chapter for information.  
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Creating Ground Control Points from Identifiable Locations on the Terrain 

To create a ground control point from a specific location on the terrain (including Lidar): 

 On the Home tab, in the Add group, click the arrow under Control Points and select Create Ground 

Control Point from Terrain.  

 Click in the 3D Window to define the control point’s location. The Control Point Editor is displayed 

showing a photo viewing window, a photos panel, a control point table, and a sampled photos panel - 

that gradually becomes populated with photo thumbnails as you mark the control point in photos.  

 Mark the control point in the relevant photos. See “Marking Control Points in Photos” in this chapter 

for information. 

 Modify the control point properties as required, and then save the project. See “Editing Control 

Points” in this chapter for information. 

Creating Tie Points 

Tie points can be created in either of the following ways:  

▪ By selecting in the Photos list the photos between which you want to establish a correspondence. 

The Control Point Editor opens with the Photos panel populated by the selected photos. You can also 

select photos after opening the Editor. See “Creating Tie Points in Selected Photos” in this chapter for 

information. 

▪ By creating a tie point from an easily identifiable location on the terrain. The Control Point Editor 

opens with the Photos panel populated by the photos whose frustum intersects with the created point. 

See “Creating Tie Points from Identifiable Locations on the Terrain” in this chapter for information. 

After creating a tie point, you mark it in the relevant photos using the Control Point Editor. See “Marking 

Control Points in Photos” in this chapter for information.     

 

Creating Tie Points in Selected Photos 

To create a tie point in selected photos:  

 In the Project Tree, select the required photo collection, and then in the Photos list, select the 

required photos.  

 On the Photo tab, in the Tie Point group, click Create Tie Point. The Control Point Editor is 

displayed with the newly-created tie point selected in the control point table at the bottom of the 

Editor, and with a Custom selection in the Photos panel that includes all the photos selected in the 

Project Tree. 

Note: You can also create tie points and filter the photos for sampling from the Editor itself: On 

the Home tab, in the Add group, click the arrow under Control Points and select Open 

Control Point Editor. Then on the Home tab of the Control Point Editor, in the Control 

Point group, click the arrow under Add New and select Add New Tie Point. See “Marking 

Control Points in Photos” in this chapter for information on filtering the photos for sampling. 

 Set the tie point properties. See “Editing Control Points” in this chapter for information. 

 Mark the tie point in the relevant photos, and then save the project. See “Marking Control Points in 

Photos” in this chapter for information. The Sampled Photos panel gradually becomes populated with 

photo thumbnails as you mark the tie point in photos. 
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Creating Tie Points from Identifiable Locations on the Terrain  

To create a tie point from a specific location on the terrain: 

 On the Home tab, in the Add group, click the arrow under Control Points and select Create Tie 

Point from Terrain.  

 Click in the 3D Window to define the tie point’s position. The Control Point Editor is displayed with 

the Photos panel populated by photos whose frustum intersects with the tie point created.   

 Mark the tie point in the relevant photos. See “Marking Control Points in Photos” in this chapter for 

information. The Sampled Photos panel gradually becomes populated with photo thumbnails as you 

mark the tie point in photos.  

 

Navigating to a Control Point 

To fly or jump to a control point: 

 In the Project Tree, select the required control point. 

 On the Control Point tab, in the Navigation group, click Fly To/ Jump To. 

Editing Control Points 

To edit a control point: 

 Do either of the following: 

▪ In the Project Tree, select the required control point. The control point’s properties are displayed 

in the Property Sheet panel.  

Note: To set the same properties for multiple control points, use CTRL-click or SHIFT-click to 

multi-select the points in the Project Tree. Then set the properties as required. 

▪ In the Project Tree, right-click the required control point, and select Edit from the shortcut menu. 

The Control Point Editor opens with this control point selected in the control point table at the 

bottom of the Editor.  

Note: When a control point is edited in either the Control Point Editor or property sheet, its 

properties are dynamically updated also in the other. Many of the control point properties 

below are also included in the Add New Control Point dialog box (that is displayed when 

adding a new control point from the Control Point Editor). See “Marking Control Points in 

Photos” in this chapter for information. 

 Set the control point properties, and then save the project. 

Parameter Definition 

General 

Excluded Select the check box to exclude the control point from the project. See 
“Excluding Control Points” in this chapter for more information. 

Name Name of the control point as it appears in the Project Tree. 

Type Select the point type: control point, tie point, or check point. 

Horizontal Accuracy 
(meters) 

Accuracy of the control point’s X and Y coordinates. The AT is adjusted 
to the control point within the specified accuracy tolerance. This field is 
not displayed in the Add New Control Point dialog box. 
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Vertical Accuracy 
(meters) 

Accuracy of the control point’s altitude. The AT is adjusted to the control 
point within the specified accuracy tolerance. This field is not displayed 
in the Add New Control Point dialog box 

Check Point Select the check box to use this control point as a check point. Check 
points do not affect the AT calculation and are only used to sample the 
AT accuracy in the result. The point is included in the build report and 
shows calculated errors for accuracy validation purposes.  

Horizontal Error This field is only displayed in the Control Point Editor. If the horizontal 
error is greater than the horizontal accuracy, this field is marked in red. 

Vertical Error This field is only displayed in the Control Point Editor. If the vertical 
error is greater than the vertical accuracy, this field is marked in red. 

Sampling Error This field is only displayed in the Control Point Editor. If the sampling 
error is greater than 1 pixel, this field is marked in red. 

Position 

Coordinate System Coordinate system of the control point. Click Select  to set a different 
coordinate system. See “Coordinate System” in the “Basic Concepts” 
chapter for more information. 

X East-west coordinate of the control point. 

Y North-south coordinate of the control point. 

Altitude Altitude of the control point in meters. 

Marking Control Points in Photos 

Control points are marked in photos using the Control Point Editor. In addition to the ribbon, the Control 

Point Editor includes a photo viewing window, a photos panel, a control point table, and a sampled photos 

panel - that gradually becomes populated with photo thumbnails as you mark the control point in photos. 

The photos panel displays the photos from which to select the photos for marking control points, either as 

thumbnails or in table format with relevant photo information. You can also manually add photos to this 

list as described in the steps below. Mark the control point in a few photos from each collection or photo 

direction. It is recommended to have at least 10 sampled photos for each control point. 

Note: In order to enable your ground control points to be fully utilized in the AT process, it is 

recommended to add at least 3-5 ground control points per AT tile. When only two ground control 

points are provided, simple vertical adjustment, scaling and rotation are performed. When only 

one ground control point is provided, only vertical adjustment is performed.  

Note: Any control point marked in fewer than three photos will be marked with an exclamation mark in 

the Project Tree, and in red in the Control Point Editor.  

To mark a control point in photos: 

 Create the control point. See “Creating Ground Control Points” and “Creating Tie Points” in this 

chapter for information. In the Project Tree, select the required control point. 

 On the Control Point tab, in the Manage group, click Edit. The Control Point Editor is displayed.  

 From the Photos filter, select which photos should be listed or displayed in the Photos panel: 

▪ All in frustum (Calculated) – All the photos whose calculated frustum intersects the control 

point. 

▪ All in range (Calculated) – All photos with the selected control point in their calculated range 

(according to their Effective Range). 
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▪ All in project (Original) – All photos in project (up to 2000 photos). 

▪ All in range (Original) – All photos with the selected control point in their range (according to 

their Effective Range). 

Note: This option is only available if photos have positioning information. 

▪ All in frustum (Original) – All the photos whose frustum intersects the control point. 

Note: For photos with positioning and orientation information, this is determined based on 

frustum, and for photos with only positioning, according to the effective range set (See 

“Collection Property Sheet” in the “Photo Management” chapter for information).  

▪ Custom selection – All photos selected in the Photos list before creating the tie point from the 

Photo tab. See “Creating Tie Points in Selected Photos” in this chapter for more information.  

 Select a viewing format for the Photos panel: 

▪  – View as thumbnails 

▪  – View in table format with information about distance, sampling error, etc. for each photo 

 If viewing the photos in table format, select the column by which you want to sort the table (in 

ascending order). Select the column a second time to switch to descending order. For filtering and 

advanced sorting options, see “Filtering Data in the Control Point Editor” in this chapter for 

information. 

 In the Photos panel, select the photo on which you want to mark the position of the selected control 

point. The photo is displayed in the photo viewing window with a white cross hairs indicating the 

projected location of the control point that PhotoMesh automatically calculated. You can type ‘n’ to 

select the next photo, or ‘p’ to select the previous one. 

Note: Any photo thumbnails that are outside of the current build area are displayed in 

strikethrough font.  

 Find the correct position in the photo in which to mark the control point. Use the mouse to zoom in 

and out and pan in the photo or use the ribbon commands: 

Zoom In Zooms in. 

Zoom Out Zooms out 

Zoom to Mark Zoom in to the marked control point. This command is only available 
after a control point was marked in the photo. 

Fit to Window Resizes the photo to fit in the window. 

Actual Size Displays the photo at actual size.  

 On the Home tab of the Control Point Editor, in the Control Point group, click Sample in Photo, and 

then click on the photo where you want to set the position of the control point. You can also type ‘s’ 

on the keyboard to toggle between navigation and sampling modes. A red crosshairs is displayed 

where you clicked in the 3D Window and in the corresponding position on the photo thumbnail which 

is added to the “Sampled Photos” panel. The photo’s XY pixel coordinates are displayed in the Mark 

X and Mark Y fields on the Control Point Editor ribbon in the Control Point group. If the Photos panel 

is displayed in table format, the check box in the Marked column is selected (If displayed as 

thumbnails, a check is displayed on top of the reviewed photo). The following information is displayed 

in the 3D Window:  
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User sample for position of control point. 

 
Projected location of control point. 

 
Projected triangulation – Projection of the triangulation center 
(adaptive weighted median of all ray intersections) back to the 
photos. 

 
Sampling error - RMS 

Sampling Error - Photo Distance, in pixels, between the projected triangulation and the 
user sample in this photo. 

Sampling Errors - RMS Root mean square (RMS) of all distances, in pixels, between the 
projected triangulation and the user sample in all photos. 

Horizontal Error Horizontal distance, in meters, between the projected triangulation 
and the control point position.  

Vertical Error Vertical distance, in meters, between the projected triangulation 
and the control point position. 

 If you want to modify the photo’s XY pixel coordinates, on the Control Point Editor ribbon’s Control 

Point group, in the Mark X and Mark Y fields, type the required values. 

 If you want to clear the previously marked position of a control point, in the Control Point Editor, in the 

Control Point group, click Clear from Photo. The photo is removed from the “Sampled Photos” 

panel and the check is cleared from that photo thumbnail in the Photos panel.  

Note: Only one position can be marked in each photo. If an additional position is marked, the 

previously marked position is automatically deleted and replaced by the new position. 

 Repeat steps 5-9 for each of the photos in which you want to mark the selected control point. 

 If you want to mark the position of the control point in a photo that does not appear in the Photos 

panel, you can either change the Photos filter to include that photo or do the following: 

a. On the Home tab of the Control Point Editor, in the Photos group, click Add Photo by Name. 
The Enter search term dialog box is displayed. 

b. Type a search term by which to identify the required photo, and click Ok. The Photos in Area 
section is populated with all photos that match the search term. 

c. Perform steps 5-9 above.  

 If you want to edit another control point in the Control Point Editor, in the Control Points table on the 

bottom of the Control Point Editor, select the required control point, and then perform steps 3-9 

above. Type ‘N’ to select the next control point in the Control Points table, or ‘P’ to select the previous 

control point. 

 If you want to add a new ground control point, do the following: 

a. On the Home tab of the Control Point Editor, in the Control Point group, click Add New. The 
Add New Control Point dialog box is displayed. 
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Add New Control Point Dialog Box 

b. Enter the control point information, and click Add. See “Editing Control Points” for a description 
of the control point fields. 

c. Perform steps 3-9 above.  

 If you want to add a new tie point, on the Home tab of the Control Point Editor, in the Control Point 

group, click the arrow under Add New, and select Add New Tie Point. The tie point is added to the 

control point table. 

Filtering Data in the Control Point Editor 

To filter control point lists in the Control Point Editor: 

 Point to the column by which you want to filter, and click the Filter icon . See "Filtering Data"  and 

"Filter Editor" in the "Using the Project Tree and Item List" chapter for information.  

 Click Close. The applied filter(s) are listed at the bottom of the Photos panel, e.g., 

. 

Click X to remove a filter. 

 To access additional sorting commands, right-click any column header. Select any of the following 

commands: 

Command Description 

Sort Ascending Sort all data in the table by this column in ascending order. 

Sort Descending Sort all data in the table by this column in ascending order. 

Clear All Sorting If multiple columns were sorted, this option is displayed to clear all. 

Group by This Column Group the data by this column.  

Note: If you want to clear the grouping, right click above the 
column headers, and select Clear Grouping. 

Show Group by Box Display boxes, above the photo table, indicating how the data is 
grouped in the table. 
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Note: If you want to clear the Group by boxes, right click above 
the column headers, and select Hide Group by Box. 

Hide This Column Hide the selected column 

Column Chooser Customize which columns show in the table. Drag and drop 
columns to and from the Customization dialog box. 

Best Fit Adjust the selected column’s width for the best fit for its contents.  

Best Fit (all columns) Adjust the all the table’s column widths for the overall best fit. 

Filter Editor Open the Filter Editor to edit the table filter.  

You can use the Filter Editor to add and remove conditions. A 
search expression can consist of more the one condition. In this 
case, you need to insert a connector between the conditions to 
specify their relations. In addition to AND, you can use the OR, 
NOT and [] connectors to define the relations between conditions. 

Show Find Panel Show a Find panel to search for a specific text.  

Note: To hide the Find panel, click the X next to it. it. 

Show Auto Filter Row Display a row with a filter option for each of the columns. 

Control Point Editor Keyboard Shortcuts 

The following keyboard shortcuts are available: 

Shortcut Description 

s Toggle between navigation and sampling modes. 

n Selects the next photo in the Photos panel and displays it in the photo viewing 
window.  

p Selects the previous photo in the Photos panel and displays it in the photo viewing 
window.  

N Selects the next control point in the Control Points table.  

P Selects the previous control point in the Control Points table.  

 

Hiding Control Point Symbols 

To hide a control point symbol: 

▪ Clear its check box in the Project Tree. 

Excluding Control Points 

To exclude a control point from the project: 

 In the Project Tree, select the required control point. 

 On the Control Point tab, in the Selection group, click Exclude. When a control point is excluded, it 

is displayed in strikethrough font in the Project Tree and the Excluded property check box is selected 

in its property sheet. 
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Deleting Control Points 

To delete a control point: 

 In the Project Tree, select the required control point. 

 On the Control Point tab, in the Selection group, click Delete.  

Exporting Control Points 

Control point data can be exported to a .gcp (text format) file. 

Note: All control points are exported in EGM96 geoid vertical coordinate system even if they were 

defined in "WGS84ELLIPSOID".  

To export a project’s control point data: 

 On the Home tab, in the Add group, click the arrow under Control Points and select Export. The 

Export Control Points dialog box is displayed. 

 Type a name for the .gcp (text format) file and browse to the required location in which to save the 

file. 

 Click OK. 

Importing Control Points 

Control point data can be imported in a tab delimited .gcp (text format) file: 

▪ First line (optional): Define the control points’ coordinate system in WKT format. (Default: geographic 

Lat-Long WGS84.) 

wkt=…… 

Note: The WKT information must be in a single line without any line breaks. You can use the 

Coordinate System Generator to generate a WKT string defining the required coordinate 

system. See “Coordinate System” in the “Basic Concepts” chapter for more information. 

▪ Second line (optional): Indicate the number of control points. If this information is not provided, each 

subsequent line in the file is interpreted as providing positioning information for a distinct control point. 

If the file includes this information, all lines after the number of lines in cp=[number] are interpreted as 

mapping between control points and photos.  

cp=[number]  

▪ For each control point, set the control point’s position on the terrain (X, Y, Altitude (Optional), Name 

(Optional), Type (Optional; Possible values: 1-control; 2-check; 3-tie) in tab delimited format.  

[x coordinate] <TAB> [y coordinate] <TAB> [altitude] <TAB> [name] <TAB> 

[type]  

Note: The Type parameter can only be passed together with the Name parameter. 

Note: The altitude base is assumed to be "GEOID”. If you want to change the altitude base, you 

can select all the control points after import and change the altitude base value in their 

property sheet.  

▪ Specify the position (in pixel coordinates) in a specified photo to associate with a particular control 

point (referenced by index).  

[control point index] <TAB> [photo file path] <TAB> [x pixel coordinate] 

<TAB> [y pixel coordinate]  
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Example: 

wkt=GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS 

84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],AUTHORITY["EPSG","6326

"]],PRIMEM["Greenwich",0,AUTHORITY["EPSG","8901"]],UNIT["degree",0.0174532

925199433,AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]] 

cp=2 

9.63390819201651 <TAB> 47.4233597051724 <TAB> 401.463806152344 <TAB> 

Control point1 

9.63390818337074 <TAB> 47.4233597019402 <TAB> 401.463793239556 <TAB> 

Control point2 

0 <TAB> C:\Photos\1.tif <TAB> 384 <TAB> 5456 

0 <TAB> C:\Photos\2.tif <TAB> 7689 <TAB> 4761 

0 <TAB> C:\Photos\3.tif <TAB> 8738 <TAB> 4340 

1 <TAB> C:\Photos\4.tif <TAB> 388 <TAB> 5450 

1 <TAB> C:\Photos\5.tif <TAB> 7690 <TAB> 4761 

1 <TAB> C:\Photos\6.tif <TAB> 8741<TAB> 4326 

To import control points: 

 On the Home tab, in the Add group, click the arrow under Control Points and select Import. The 

Import Control Point File dialog box is displayed. 

 Browse to the required .gcp file and click Open. 

 Modify the control point properties as required, and then save the project.  

Adding a Reference Project to Use in Aerotriangulation 

Georeferencing a project is the process of adjusting photos in your project to the geographic location of 

photos of the same geographic area in a different project. When building a project that overlaps partially 

or entirely with a different project that will be overlaid on the same map in a client viewer, it is important to 

ensure that matching areas align properly. This can be achieved by adding the older "base" project as a 

reference project for the new "target" project. After adding the base project, it is listed in the Project Tree 

under Reference Projects, but its photos are not displayed in the 3D Window. When building the new 

project, PhotoMesh establishes a correspondence between points in the reference project and target 

project, so that the positions of identified features in the target project match the geographic positions of 

the same features in the reference project.  

To add a reference project: 

 On the Home tab, in the Add group, click the arrow under Control Points and select Add Reference 

Project. The Add Reference Project dialog box is displayed. 

 Browse to the required reference project, i.e., the calculated AT of that build (atResult_v12.sqlite), 

and click Open. When the aerotriangulation step of the build process is performed, the project will be 

automatically aligned to the reference project. 
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CHAPTER 14  FUSERS 

About Fusers 

PhotoMesh can take advantage of computer clusters to accelerate database creation. Fusers allow you to 

share the demanding processing requirements of the different build steps (data preparation, AT, point 

cloud, mesh model, texture, 3DML/other outputs) between several computers on the same network. The 

master computer utilizes the computing power of the network’s client computers by connecting to 

PhotoMesh fusers on the client machines.  

The fuser remains idle until used by the master computer on the network. Once started, the fuser runs on 

the client machines, with only an icon in the system tray that opens a status log and a dialog to stop or 

suspend fusers. You can install the PhotoMesh Fuser on the same computer with the PhotoMesh Build 

Manager and/or on other computers. 

In addition to standard fuser use, PhotoMesh also offers two options for auto-scaling of fusers to enable 

dynamic allocation of fusers based on project requirements:  

▪ Amazon Web Services (AWS) Fusers – AWS fuser instances can be dynamically launched 

whenever there are unassigned pending fuser tasks, to further accelerate model creation. 

▪ Fusers Pool – Fusers can be shared between several PhotoMesh Build Managers in your 

organization, enabling each machine running PhotoMesh to use the combined resources of all the 

machines in the pool. A distributed management approach is used to manage the pool fusers, 

whereby each PhotoMesh Build Manager manages its own fuser needs and resources by requesting 

fusers from the pool when generating a build and returning the fusers when they are no longer 

needed. 

When beginning the build process the PhotoMesh Build Manager application determines what build steps 

are required and assigns them to the different fusers. PhotoMesh Build Manager continuously monitors 

the fusers’ progress and assigns new processing tasks based on fuser availability. 

Both PhotoMesh Build Manager and the PhotoMesh fusers require read-write access to the working and 

project folders.  
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Fuser Management (on the Master computer) 

All available fusers are listed in the Fusers section of PhotoMesh Build Manager. As the build process is 
progressing, PhotoMesh Build Manager displays fuser information (which fusers are in use, which aren’t, 
etc.). See “Monitoring a Build” in the “Building” chapter for more information. 

 

Setting the Working Folder on the Master Computer 

The working folder is the folder that PhotoMesh Build Manager (on the Master computer) and PhotoMesh 

fusers use to communicate: to deposit and collect pending tasks, and share information about fuser 

availability, status and progress.  
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The working folder should be set to a network folder with read-write access permissions, for both the 

master and client computers. It is recommended to use UNC format (\\[UNC Master] 

\folder\WorkingFolder, e.g.: \\Machine1\c\PhotoMesh7.0\WorkingFolder), though a mapped network drive 

can also be used as long as the same letter is mapped to the same share on all computers. 

Note: When using fusers, the project must also be created in a network folder with read-write access 

permissions, for both the master and client computers. It is recommended to use UNC format 

(\\[UNC Master] \folder\ProjectFolder, e.g.: \\Machine1\c\PhotoMesh\ProjectFolder), though a 

mapped network drive can also be used as long as the same letter is mapped to the same share 

on all computers. See "Creating and Opening a PhotoMesh Project" in the "Project Management" 

chapter for more information. 

The working folder must be on a device that supports the number of concurrent network connections you 

require, e.g., Windows 10 limits the number of supported concurrent connections to 20. 

It is recommended to create the working folder on a on a fast drive that is different from the one used for 

the project data, most preferably on a local solid-state drive (SSD) on the master machine that is shared 

with the other fuser machines. 

To set the working folder on the master computer, do either of the following: 

▪ In the Options dialog box, set the working folder. See “Setting PhotoMesh Options” in the “Basic 

Concepts” chapter for more information. 

OR 

▪ In PhotoMesh Build Manager, next to the Working Folder field, click Browse. Then browse to the 

required location. 

Using Fusers 

To use fusers on the master computer: 

 In PhotoMesh Build Manager, select the required fusers. 

 If you want PhotoMesh Build Manager to automatically use any new fusers that connect to the 

project’s working folder, select Automatically use new available fusers from the drop-down list. 

 If there are no available fusers, a dialog box is displayed asking if you want to start a local fuser. Click 

Yes to start a local fuser. Click No to start the build without adding a fuser. Processing will begin 

automatically when fusers are added.  

 If you want to change the working folder that PhotoMesh Build Manager and PhotoMesh fusers use to 

communicate (to deposit and collect pending tasks, and share information about fuser availability, 

status and progress), click Browse. Then browse to the required location. 

Note: The working folder in the PhotoMesh Fuser dialog box on the client computer should be set 

to the same location as the location set here. See “Fuser Management (on the client 

Computer)” in this chapter for information. 

Fuser Management (on the client computer) 

The owner of the fuser computer has full control over fuser usage. For information on installing and 

uninstalling fusers, see “Installing PhotoMesh Fusers” and “Uninstalling PhotoMesh Fusers” in the 

“Getting Started” chapter. Fusers can be installed locally, or run from a shared network path. 

file://///Machine1/c/PhotoMesh7.0/WorkingFolder
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Setting the Working Folder on a Client Computer 

The working folder is the folder that PhotoMesh Build Manager (on the master computer) and PhotoMesh 

fusers use to communicate: to deposit and collect pending tasks, and share information about fuser 

availability, status and progress.  

The working folder on each of the client computers must be set to the same network folder as was set for 

the master computer. See "Setting the Working Folder (on the Master Computer)" in this chapter for more 

information.  

To set the working folder on the client computer: 

 In the PhotoMesh Fuser dialog box, click Change. The Select Folder dialog box is displayed. 

 Browse to the required folder and click Select Folder. 

Note: If the working folder is changed during processing, processing is stopped.  

Starting Fusers  

Once a fuser is started on a client computer, it is added to the list of available fusers on the master 

computer. Fusers can be installed locally, or run from a shared network path. 

To start a fuser: 

▪ Click Start > Skyline PhotoMesh > PhotoMesh Fuser. A PhotoMesh fuser icon is placed in the 

Windows system tray. 

Note: In the full PhotoMesh installation, the name of the folder containing the fuser application is 

Skyline PhotoMesh, while in the standalone fuser installation, the folder name is Skyline 

PhotoMesh Fuser.  

Fuser Log 

To open the fuser log: 

 In the system tray, click the PhotoMesh Fuser icon, and then click Open PhotoMesh Fuser. The 

PhotoMesh Fuser dialog box is displayed, showing the fuser log in the lower half of the dialog box. 

 If you want to clear the log, click Clear Log. 

 If you want to stop the log from automatically scrolling to the last line of the log, click Scroll Lock.  

Disabling a Fuser 

Fusers can be temporarily disabled. 

To disable a fuser: 

▪ Click the PhotoMesh Fuser icon, and then click Disable. When you want to restart the fuser, click 

the PhotoMesh Fuser icon and then click Enable. 

Note: The Master computer reattempts to use the fuser every five minutes. The fuser is used 

only if its owner has enabled it.  

Exiting a Fuser 

You can permanently exit a fuser.  

To exit a fuser: 

▪ Click the PhotoMesh Fuser icon, and then click Exit.  
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PhotoMesh Fuser Log 

Running Fusers Upon Login  

You can schedule fusers to be run automatically upon login, either individual fusers or the fuser service 

(PMFuserService.exe), if using a fusers pool. See "Fusers Pools" in this chapter for information. 

To run fusers upon logon using the Task Scheduler 

 Right-click Task Scheduler Library and select Create Task. 

 General > Name: Start PM Fuser OR Start PM Fuser Service. 

Note: If using a fusers pool, then start the fuser service (PMFuserService.exe) rather than a 

fuser. See "Fusers Pools" in this chapter for information. 

 Triggers: 

a. Click New. 

b. Begin the task: Select At log on. 

c. Settings: Specific user. 

d. Click OK. 

 Actions: 

a. Click New.  

b. Program/script: \\10.0.0.10\d\PhotoMesh\fuser\PhotoMeshFuser.exe OR 
\\10.0.0.10\d\PhotoMesh\fuser\PMFuserService.exe.  

file://///10.0.0.10/d/PhotoMesh/fuser/PhotoMeshFuser.exe
file://///10.0.0.10/d/PhotoMesh/fuser/PMFuserService.exe
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Note: If using a fusers pool, then run the fuser service (PMFuserService.exe) rather than a 

fuser. See "Fusers Pools" in this chapter for information. 

c. Click OK. 

 Settings: 

a. Select if the task fails, restart every, and keep the default 1 minute and 3 times. 

 Click OK. 

If you want to log in automatically upon start up, do the following: 

 Click the Start  button, type "cmd", and then select Command Prompt from the list. In the 

command prompt window type the following: 

control userpasswords2 

 Select the user that you want automatically logged in, e.g., Administrator, and clear the Users must 

enter a user name and password to use this computer checkbox, and click OK. 

 Enter and confirm the password for the fuser computer. 

Fuser Auto-Scaling  

PhotoMesh offers two options to scale project production up and down based on resource needs: 

▪ Amazon Web Services (AWS) Fusers – AWS fuser instances can be dynamically launched whenever 

there are unassigned pending fuser tasks, to further accelerate model creation. 

▪ Fusers Pool – Fusers can be shared between several PhotoMesh Build Managers in your 

organization, to dynamically allocate and free fusers based on each project’s resource needs.  

These options can be used together or separately. When either option is used, PhotoMesh Build Manager 

continuously monitors the fusers’ progress and status and the processing requirements, and allocates or 

frees fusers as required. 

Using Amazon Web Services (AWS) Fusers 

PhotoMesh can work with Amazon Web Services to scale project production up and down based on 

resource needs. AWS fuser instances can be dynamically launched whenever there are unassigned 

pending fuser tasks, to further accelerate model creation. PhotoMesh Build Manager continuously 

monitors the fusers’ progress and status and the processing requirements of the current step, adding and 

terminating AWS fusers as required. See "Getting Started with AWS" for more information. 

To use AWS fusers: 

 In the Build Manager, toggle on Use AWS Instances. You can also access these settings from the 

Tools tab (AWS Instance Settings command) and from the Start page's Automation Dashboard. 

Note: The Automatically use new available fusers check box must also be selected, so that 

PhotoMesh will use the AWS fuser instances after they are launched.  

 If PhotoMesh Build Manager is running on a local computer, and this is the first time connecting to the 

AWS fusers, the AWS Security dialog box is displayed. Enter your AWS security information, and 

click OK. 

Note: If PhotoMesh Build Manager is running on an AWS instance with an IAM (Identity and 

Access Management role), security credentials are not required. See "Creating an IAM 

User for Running PhotoMesh Project Using an On-Premises Master" in the "Getting started 

with AWS" chapter for information.  



   

 153 

PhotoMesh User Guide 

 

AWS Security Dialog Box 

Access Key ID Token that allows PhotoMesh to communicate with your AWS 
account.  

Note: You can find your Secret Access Key on the My Security 
Credentials link in the AWS Management Console. 

Secret Access Key Token that allows PhotoMesh to communicate with your AWS 
account.  

Note: You can find your Secret Access Key on the My Security 
Credentials link in the AWS Management Console. 

Region Select an AWS region. 

Remember my credentials Select this option to save the password. The password will be 
saved and will be displayed using asterisks the next time the 
dialog box is opened. 

 In the Auto-Scaling Fusers Settings dialog box, select the Use AWS Instances check box, and 

then enter the following information: 

Maximum Price per Spot 
Instance 

Set the maximum price you want to pay for an EC2 fuser spot 
instance.  

Maximum Instances Set the maximum number of fuser instances to launch. 

Launch Rate Set the maximum number of fuser instances to launch per minute, 
e.g. if Maximum Instances was set to 200, and the Launch Rate to 
50, the Build Manager will spread the launch of the fusers over 4 
minutes. This prevents a potential bottleneck that could be caused by 
a large number of fusers attempting to read the build data at the 
same time.  

Terminate AWS 
instances when build 
finished 

Select the check box if you want to terminate AWS fuser instances 
when the build is complete. 

Select fuser instance launch parameters 

http://aws.amazon.com/
http://aws.amazon.com/
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Region The region the master is running in, or the region set in the AWS 
Security dialog box (Read-only). 

Configuration Name Name of the JSON configuration file to use. The JSON file contains 
an array of fuser instance types that PhotoMesh should use, ordered 
based on preferability. During production, PhotoMesh iterates over 
the elements of the array, beginning with the first instance type, until 
it finds an available instance. PhotoMesh will always attempt first to 
launch instances from one of the subnets listed in the Subnet ID 
(below), before it moves to the next machine type listed. 

Select based on the steps that require processing and other relevant 
factors. Click Edit to edit the JSON file. You can also open and edit 
the file in a text editor See "Recommendations Based on PhotoMesh 
Step" in the "Getting Started with AWS" chapter for information. 

Additional JSON configuration files can be created and placed under 
../photomesh/AWSConfigurations where the two example JSON files 
are also saved.  

Each instance object in the JSON file's array has three properties: 
ami, instanceType, and demandType. The ami is the ID of the 
Amazon Machine Image (AMI). The instanceType defines the 
hardware of the host computer used for your instance. Each instance 
type offers different compute, memory, and storage capabilities. The 
demandType determines the pricing arrangement: on-demand or 
spot.  

Build Priority Select either Choose all listed options, to use all machine types 
listed in the JSON file, with priority based on the order they are listed 
in the file, or select a specific machine.  

Security Group ID Select the instance’s security group ID. Security groups control 
inbound and outbound traffic using rules. 

Subnet ID Select the subnet of the virtual private cloud (VPC) dedicated to your 
AWS account, into which to launch your fuser instances. If you want 
to use additional subnets, click Additional Subnets, and type a list of 
all the subnet ID's you want to use. See "Building a PhotoMesh 
Project Using the Master Instance" in the "Getting Started with AWS" 
chapter for more information. 

Key Pair Name The name of the Key Pair used to configure the PhotoMesh AWS 
fuser Amazon Machine Images (AMI's). Key Pairs are used to encrypt 
and decrypt login information.  

Additional Per Project Fuser Instance Tags 

Add tags to help you easily identify a fuser instance in the Amazon EC2 console after it is 
launched. These tags are saved in the JSON configuration file. 

Customer Name of customer who commissioned the project. 

Description Free text describing the project. 

Shutdown inactive fuser 
instance… 

Select one of the options for shutting down inactive fuser instances: 

▪ Shut down inactive fuser instances before the next billing hour 

▪ Shut down inactive fuser instances after XX minutes 

 If you want to use another account, click Use another AWS account, and enter the AWS security 

information (see step 2 for more information).  
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 If you also want to use pool fusers, toggle on the Use Fusers Pool link, and enter the required 

information. See “Using a Fusers Pool” in this chapter for information. 

 Click OK. 

Fusers Pools 

The fusers pool is used to share fusers between several PhotoMesh master computers in your 

organization. When working with a pool, the PhotoMesh master computer’s Build Manager requests 

fusers from the pool, and returns them when they are no longer needed. A distributed management 

approach is used to manage the pool fusers, whereby each PhotoMesh master computer manages its 

own fuser needs and resources. Fusers are allocated on a first come first served basis, i.e., to the first 

PhotoMesh Build Managers that request fusers from the pool. If a manager submits a request for a user, 

but no fusers are currently available in the pool, the manager continually checks the fusers pool for a 

fuser that was returned to the pool, at which point it assigns the fuser to its project’s working folder.   

Fuser allocation can be manually set from the Pool Manager page. From this page, you can monitor and 

manage all the fusers in the pool, e.g., assign fusers to specific projects’ working folders and prevent their 

being returned to the pool. 

Running the Fuser Service 

The PMFuserService.exe should be run on all fuser computers in the pool since it is responsible for 

running the required fuser (PhotoMeshFuser.exe) version for the requesting manager and assigning it to 

the manager’s working folder. This enables different PhotoMesh versions to use the same fusers pool. 

The PMFuserService.exe can be run from the fuser folder under the installation folder (.\Application 

Files\Fuser\PhotoMeshFuser.exe) or from a file share or network drive that is accessible to all fuser 

computers. It is recommended to run the fuser service on startup using auto-logon. See "Running Fusers 

Upon Login" in this chapter for information. 

 

Creating a Fusers Pool 

To create a fusers pool: 

 Designate a pool directory which will hold the pool.json file created in the next step as well as the 

working folders that will be created automatically for each of the projects using the fusers pool.  

Note: If you are also using local fusers for a project, the working folder must be the one 

automatically created in the pool directory. It is recommended to create the working folder 

on a fast drive that is different from the one used for the project data, most preferably on a 

solid-state drive (SSD) that is shared with the master machine and other fuser machines. 

 Create a pool.json file with the name and IP of all fusers in the pool. Use the following structure and 

syntax in creating the file:  

▪ Create an array called “Pool” (enclosed in square brackets). 

▪ Enclose within curly braces each of the fuser objects. Each fuser object is composed of two 

name/value pairs separated by a comma: Name: FuserName, and IP: FuserIP.   

{ 

"Pool": [         

        { 

            "Name": "pm-020", 

            "IP": "http://192.168.204.20:8085" 

        }, 
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        { 

            "Name": "pm-021", 

            "IP": "http://192.168.204.21:8085" 

        } 

    ], 

    "Name": "ProductionPool"  

} 

 

Managing a Fusers Pool 

Fusers are allocated on a first come first served basis, i.e., to the first PhotoMesh Build Manager that 

requests fusers from the pool. If a subsequent manager submits a request for a user, but no fusers are 

currently available in the pool, the manager continually checks the fusers pool for a fuser that was 

returned to the pool, at which point it assigns the fuser to its project’s working folder. If you want to 

manually allocate fusers, you can do so from the Pool Manager page. From this page, you can monitor 

and manage all the fusers in the pool, e.g., assign fusers to specific projects’ working folders and prevent 

their being returned to the pool. 

 

To manage a fusers pool: 

 In the Build Manager dialog box, in the Auto Scaling section, click the Pool Manager link. The 

PhotoMesh – Pool Manager page is displayed, with information on all the fusers in the pool. You can 

also access the Pool Manager from the Tools tab and from the Start page's Automation Dashboard. 

You can set any of the following for either selected or all fusers: 

▪ Assign to a project 

▪ Modify their idle timeout 

▪ Set private or public status 

▪ Add a comment 

 If you want to manually assign fusers to a project’s working folder, do the following: 

a. Select the fusers’ check boxes, and click Assign. The Assign Fusers dialog box is displayed. 

 

Assign Fusers 

b. Enter the working folder and fuser folders.  

c. If you want to prevent these fusers from being restored to the pool after completing their current 
tasks, select the private check box. 
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d. Click OK. 

 If you want to modify the idle timeout set for certain fusers, select the fusers’ check boxes, and click 

Set Idle Time. Then enter the time in seconds, and click OK. 

 

Set Idle Time 

 Fusers can be made available to all master computers in a pool or restricted to a specific project's 

working folder. If you want to change fusers’ availability in the pool, i.e., to either make them available 

in the pool (public) or restrict their use to a specific project (private), select the fusers’ check boxes, 

and click Private/Pool. Then select the private check box to make them private (or clear to make 

them public), and click OK.  

Note: Private fusers are not restored to the pool even after completing their current tasks. If you 

want to assign fusers to a specific project’s working folder, but have them returned to the 

pool after they complete their tasks, clear this check box, and see step 3. 

 

 If you want to write a comment for certain fusers, select the fusers’ check boxes, and click Comment. 

Then type the comment, and click OK. 
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Using a Fusers Pool 

The PhotoMesh master should be run from a shared network drive that is accessible to all fuser 

computers, to enable the PMFuserService.exe to launch a fuser that is the same version as the master. 

To use a fusers pool: 

 Copy the PhotoMesh application files from the PhotoMesh master computer to a shared network 

drive that is accessible to all fuser computers, to enable the PMFuserService.exe to launch a fuser 

that is the same version as the master. Then run PhotoMesh from that path on the master computer.   

 In the Build Manager, toggle on Use Fusers Pool. The Auto Scaling Fusers Settings dialog box is 

displayed. You can also access these settings from the Tools tab (Fuser Pool Settings command). 

Note: The Automatically use new available fusers check box must also be selected, so that 

PhotoMesh will use the pool fusers when they become available.  

 Select the Use Fusers Pool check box, and enter the following information: 

Fusers Pool Folder Click Change to browse to the location of the pool folder. The 
pool folder must contain the pool.json file. See “Creating a Fusers 
Pool” in this chapter for more information. 

Note: If you are also using local fusers for a project, the working 
folder for the entire project, i.e. for both the local and pool 
fusers must be located in the pool directory.  

Fuser Folder Click Change to browse to the location of the fuser folder. This 
folder is set, by default, to the UNC path of the folder from where 
PhotoMesh is running so that the Fuser service launches the fuser 
version required by the master. Make sure that this path is 
accessible to all the fusers, e.g., by running PhotoMesh from a file 
share or network drive that is accessible to all fuser computers. 

Return inactive fuser to pool 
after 

Set the number of seconds after which inactive fusers should be 
returned to the pool. 

Maximum Fusers Type the maximum number of fusers to run. If fusers are available 
in the pool, PhotoMesh Build Manager adds pool fusers up to the 
maximum number set.   

Note: Make sure your pool limit does not exceed your license 
fuser limit, to avoid rejection of your fuser request by the 
pool. 

 If you also want to use AWS fusers, select the Use AWS Instances check box, and then enter the 

required information. See “Using Amazon Web Services (AWS) Fusers” in this chapter for 

information. 

 Click OK. 



   

 159 

PhotoMesh User Guide 

 If you want to monitor and manage all pool fusers, e.g., assign fusers to specific projects’ working 

folders and prevent their being restored to the pool, in the Build Manager dialog box, click the Pool 

Manager link. See “Managing a Fusers Pool” in this chapter for information. You can also access the 

Pool Manager from the Tools tab. 

Launching Multiple Fusers 

PhotoMesh supports an experimental feature of running multiple fusers on powerful machines for 

potentially enhanced performance. To run multiple fusers, a computer requires a high number of CPU 

cores (16 or more) and a large amount of RAM (32 GB or more). It is recommended that a minimum of 16 

GB RAM and 8 cores be available per fuser. Multiple fusers on the same machine cannot be currently 

used when using Auto-Scaling AWS instances or a Fusers Pool. 

As a general guideline, the optimal number of PhotoMesh fusers per machine can be calculated by taking 

the lower of – the total number of CPU cores in the machine divided by 8 and the total RAM (in GB) 

divided by 16 (rounded down). It is highly recommended, however, to perform tests with different 

numbers of fusers since various factors such as I/O speed, network, memory cache can affect 

performance. 

 

To launch multiple fusers: 

▪ Add a unique ID parameter to the PhotoMeshFuser.exe command line.  

Example: 

To launch three PhotoMesh fusers in parallel on one machine, run these command lines: 

>"C:\Program Files\Skyline\PhotoMesh\Fuser\PhotoMeshFuser.exe" 1 

>"C:\Program Files\Skyline\PhotoMesh\Fuser\PhotoMeshFuser.exe" 2 

>"C:\Program Files\Skyline\PhotoMesh\Fuser\PhotoMeshFuser.exe" 3 
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CHAPTER 15  GETTING STARTED WITH AWS 

Overview 

PhotoMesh is designed and built to fully exploit computer clusters and cloud computing. Cloud computing 

provides the flexibility to quickly scale up and down based on resource needs - even within a single 

project. Projects (or even steps within a single project) with demanding processing requirements can be 

run simultaneously on hundreds of virtual fuser machines (instances), vastly accelerating mesh model 

creation, while for less demanding projects (or project steps), users can quickly scale down. Users only 

pay-per-use, thus avoiding any significant upfront investment or wasted resources. 

Amazon Web Services (AWS) is a secure cloud services platform that provides a perfect fit for 

PhotoMesh users interested in leveraging cloud products for scalable processing power with only minimal 

investment in infrastructure.  

The general workflow involves the following steps: 

▪ Step 1: Setting up an Amazon Virtual Private Cloud (VPC). 

▪ Step 2: Creating the Master PhotoMesh machine, by launching and customizing a Windows instance 

from an existing Amazon Machine Image (AMI) and setting up storage on Amazon EBS Volumes.  

▪ Step 3: Creating a Linux AMI for a fuser computer by launching and customizing an instance from an 

existing AMI, and then creating a new AMI from the instance. 

▪ Step 4: Building a PhotoMesh project by using the configured environment to create and then build a 

project. 

The workflow outlined below is intended only as a recommendation for a typical workflow, and it can be 

modified based on other AWS and IT knowledge and preferences. 

Note: The steps below based on Amazon’s AWS documentation, adapted for PhotoMesh’s specific 

requirements.  

Step 1: Create a Virtual Private Cloud (VPC)  

To create a Virtual Private Cloud for PhotoMesh production, configure a VPC and then create a security 
group. 

See: What is Amazon VPC in Amazon’s AWS documentation for more information. 

Configuring a VPC 

 Open the Amazon VPC console at https://console.aws.amazon.com/vpc/. 

 On the dashboard choose Launch VPC Wizard. 

 Choose the first option, VPC with a Single Public Subnet, and then choose Select. 

Note: If you want to use multiple subnets, they should be configured in this step. 

 On the configuration page, enter the following information: 

a. VPC name: PM VPC. 

b. Public subnet’s IPv4 CIDR: Change X.X.X.X/24 to X.X.X.X/22 (E.g., The default 10.0.0.0/22). 
This allows up to 1019 instances on your network. 

c. Subnet name: PM Subnet. 

 Click Create VPC. 

 In the navigation pane, choose Subnets. 

https://aws.amazon.com/what-is-aws/
http://docs.aws.amazon.com/AmazonVPC/latest/UserGuide/VPC_Introduction.html
http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/Creating_EBSbacked_WinAMI.html
http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/AMIs.html
http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/EBSVolumes.html
https://docs.aws.amazon.com/index.html
https://docs.aws.amazon.com/vpc/latest/userguide/getting-started-ipv4.html#getting-started-create-vpc
https://console.aws.amazon.com/vpc/
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 Select PM subnet, choose Actions, and then Modify Auto-Assign IP Settings. 

 Select the Enable Auto-assign Public IPv4 address check box. 

 Click Save. 

Creating a Security Group 

See: Create a Security Group in Amazon’s AWS documentation for more information. 

 Open the Amazon VPC console at https://console.aws.amazon.com/vpc/. 

 In the navigation pane, choose Security Groups. 

 Choose Create Security Group. 

 In the Security group name field, enter PM_SG as the name of the security group, and type a 

description.  

 Select the ID of your PM VPC from the VPC menu, and then choose Create. 

 Select the PM_SG security group that you just created (you can view its name in the Group Name 

column). 

 Click Actions and then select Edit inbound rules. 

 On the Inbound Rules tab, click Add rule and input the parameters as follows below. Click Save 

Rules when you're done: 

a. Select RDP (Remote Desktop Protocol) from the Type list, and enter your network's public IP 
address range in the Source field. If you don't know this address range, you can use 0.0.0.0/0. 

b. Choose Add Rule, and select SSH from the Type list. Then enter your network's public IP 
address range in the Source field. If you don't know this address range, you can use 0.0.0.0/0. 

c. Choose Add Rule, select Custom TCP Rule from the Type list, and enter 5900-5901 (default 
VNC ports) in the Port Range field. Then enter your network's public IP address range in the 
Source field. If you don't know this address range, you can use 0.0.0.0/0. 

Note: For the rules above, when you use 0.0.0.0/0 for the Source field, you enable all IP 

addresses to access your instance using RDP, SSH, or VNC. This is suitable for a short 

exercise, but it is unsafe for production environments. In production, you will want to 

authorize only a specific IP address or range of addresses to access your instance. 

d. Choose Add Rule, select Custom TCP Rule, from the Type list, and enter 445 in the Port 
Range field. In the Source field, start typing sg, and select the group ID of your security group. 

Note: You can also add another identical rule for your network’s IP address range, to allow file 

sharing directly from your computer. If you don't know this address range, you can use 

0.0.0.0/0, but keep in mind that this will enable all IP addresses to access your instance 

using file sharing. This is suitable for a short exercise, but it is unsafe for production 

environments. In production, you will want to authorize only a specific IP address or 

range of addresses to access your instance. 

Step 2: Create a Master Instance 

Creating an Amazon Machine Image (AMI) for the master computer is a multi-part step that entails: 

launching an instance from an existing AMI and customization of the instance.  

https://docs.aws.amazon.com/vpc/latest/userguide/getting-started-ipv4.html#getting-started-create-security-group
https://console.aws.amazon.com/vpc/
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To create a master Instance, follow the steps below. For more information, see: Getting Started with 
Amazon EC2 Windows Instances in Amazon’s AWS documentation. If you are using a hybrid cloud 
architecture and running your PhotoMesh Manager locally, there is no need to create a master instance. 

Creating an IAM Policy and Role 

 Open the IAM console at https://console.aws.amazon.com/iam/. 

 In the navigation pane on the left, choose Policies. 

If this is your first time choosing Policies, the Welcome to Managed Policies page appears. Choose 

Get Started. 

 Choose Create policy. 

 Choose the JSON tab. 

Note: You can switch between the JSON and Visual editor tabs any time and add each of the 

permissions below individually. 

 Paste the following JSON policy document: 

{ 

    "Version": "2012-10-17", 

    "Statement": [ 

        { 

            "Sid": "VisualEditor0", 

            "Effect": "Allow", 

            "Action": [ 

                "ec2:DescribeInstances", 

                "ec2:TerminateInstances", 

                "ec2:RequestSpotInstances", 

                "ec2:DescribeTags", 

                "ec2:CreateTags", 

                "ec2:DescribeRegions", 

                "ec2:RunInstances", 

                "s3:ListBucket", 

                "ec2:DescribeSpotInstanceRequests", 

                "ec2:DescribeSecurityGroups", 

                "ec2:DescribeSpotPriceHistory", 

                "ec2:DescribeImages", 

                "ec2:CancelSpotInstanceRequests", 

                "s3:GetObject", 

                "iam:CreateServiceLinkedRole", 

                "ec2:DescribeSubnets", 

                "ec2:DescribeKeyPairs", 

                "ec2:DescribeInstanceStatus" 

            ], 

            "Resource": "*" 

        } 

    ] 

} 

 When you are finished, choose Review policy. 

http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/EC2_GetStarted.html
http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/EC2_GetStarted.html
https://console.aws.amazon.com/iam/
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 On the Review policy page, enter PM_RUNFUSER_POLICY. Review the policy Summary to see 

the permissions that are granted by your policy. Then choose Create policy to save your work. 

 In the navigation pane, choose Roles, and then choose Create role. 

 For Select type of trusted entity, choose AWS service. 

 For Choose a use case, choose EC2. Then choose Next: Permissions. 

 In the list of policies, select the PM_RUNFUSER_POLICY policy. You can use the Filter menu 

to filter the list of policies. 

 Choose Next: Tags. 

 Choose Next: Review. 

 In the Role name, enter PM_RUNFUSER_ROLE. 

 Review the role and then choose Create role. 

Launching an Initial Instance and Creating Storage 

To launch an initial instance and create storage: 

 Open the Amazon EC2 console at https://console.aws.amazon.com/ec2/. 

 From the Amazon EC2 console dashboard, choose Launch Instance. 

 On the Choose an Amazon Machine Image (AMI) page, choose the following AMI from the AWS 

Marketplace list: NVIDIA Gaming PC - Windows Server 2019, and then choose Select. 

 On the Choose an Instance Type page, select the g4dn.xlarge type, and choose Next: Configure 

Instance Details. 

Note: Only instance types that match the NVIDIA AMI are available. If you want to use a different 

instance type, select a different AMI in step 3 of "Launching an Initial Instance and 

Creating Storage", e.g., Windows Server 2019. Make sure to install any graphics drivers 

that are required for your instance.  

Note: Using a GPU instance is recommended for normal operation of PhotoMesh Master over 

RDP connection. For productions with hundreds of fusers, other types can be used such as 

g4dn.8xlarge, which has faster network performance. For more information, see Instance 

Types in Amazon’s AWS documentation. 

 On the Configure Instance Details page, enter the following information:  

a. Network: Choose the PM VPC VPC created in step 4 of "Configuring a VPC".   

b. IAM role: Choose the PM_RUNFUSER_ROLE created in step 14 of "Creating an IAM Policy and 
Role".  

c. Enable termination protection: Select the check box.  

d. Network Interfaces: Set the Primary IP of eth0 to 10.0.0.10.   

e.  Choose Next: Add Storage. 

 On the Add Storage page, enter the following information: 

a. Keep the default volume types. 

b. Click Add New Volume. Then set Size based on your expected need (E.g. 100 GiB). This is the 
EBS storage that will hold your data, projects, PM files, etc.  

Note: The EBS volumes will incur additional charges. For more information, see Amazon EBS 

Volumes in Amazon’s AWS documentation. 

https://console.aws.amazon.com/ec2/
http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/instance-types.html
http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/instance-types.html
http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/EBSVolumes.html
http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/EBSVolumes.html
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c. Volume Type: Choose a volume type based on your expected need (e.g., General Purpose SSD 
(gp2)). For more information, see Amazon EBS Volume Types. 

d. Choose Next: Add Tags. 

 On the Add Tags page, tag your instance to help you identify it in the Amazon EC2 console after you 

launch it. Enter the following information: 

a. Select Add Tag. 

b. Key: Name. 

c. Value: PM Master. 

d. Click Next: Configure Security Group. 

 On the Configure Security Group page, do the following: 

a. Choose Select an existing security group. 

b. Select the PM_SG group. 

c. Choose Review and Launch. 

 On the Review Instance Launch page, check the details of your instance, and make any necessary 

changes by clicking the appropriate Edit link. When you are ready, choose Launch. 

 In the Select an existing key pair or create a new key pair dialog box, create a new key pair.  

a. Choose Create a new key pair. 

b. Key pair name: PM_KeyPair. 

c. Choose Download Key Pair.  

Note: Store the file in a secure and accessible location since you will need the contents of the 

private key to connect to your instance after it is launched.  

d. Choose Launch Instances. 

 To launch your instance, select the acknowledgment check box, and then choose Launch Instances. 

Connecting to the Instance  

See: Connecting to Your Windows Instance Using RDP in Amazon’s AWS documentation for more 
information. 

 Open the Amazon EC2 console at https://console.aws.amazon.com/ec2/ 

 In the navigation pane, choose Instances. 

 Select the instance, and then choose Connect. 

 In the Connect To Your Instance dialog box, choose Get Password (it will take a few minutes after 

the instance is launched before the password is available). 

 Choose Choose File and navigate to the private key file you created when you launched the 

instance. Select the file and choose Open to copy the entire contents of the file into the contents box. 

 Choose Decrypt Password. The console displays the default administrator password for the 

instance in the Connect To Your Instance dialog box, replacing the link to Get Password shown 

previously with the actual password. 

 Record the default administrator password, or copy it to the clipboard. You need this password to 

connect to the instance. 

 Choose Download Remote Desktop File. Your browser prompts you to either open or save the .rdp 

file. Either option is fine. When you have finished, you can choose Close to dismiss the Connect To 

Your Instance dialog box. 

https://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/EBSVolumeTypes.html
http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/connecting_to_windows_instance.html
https://console.aws.amazon.com/ec2/


   

 165 

PhotoMesh User Guide 

 You may get a warning that the publisher of the remote connection is unknown. Choose Connect to 

connect to your instance. 

 When prompted, log in to the instance, using the administrator account for the operating system and 

the password that you recorded or copied previously. If your Remote Desktop Connection already 

has an administrator account set up, you might have to choose the Use another account option and 

enter the user name and password manually. 

 Due to the nature of self-signed certificates, you may get a warning that the security certificate could 

not be authenticated. Choose Yes or Continue to continue. 

 A Windows Networks message is displayed asking if “you want to allow your PC to be discoverable 

by other PCs and devices on this network?” Click Yes. 

 After you connect, we recommend that you change the administrator password from the default 

value. You change the password while logged on to the instance itself, just as you would on any other 

Windows Server.  

Note: Due to the Remote Desktop Protocol (RDP), the recommended method for changing the 

password is to press CTRL+ALT+END, and then select Change a password.  

Customizing the Instance  

See: Making an Amazon EBS Volume Available for Use on Windows and Windows GPU Instances in 
Amazon’s AWS documentation for more information. 

 While connected to the Master instance using RDP, start Windows File Explorer. 

 Start the Disk Management utility. On the taskbar, open the context (right-click) menu for the 

Windows logo and choose Disk Management.  

 Open the context (right-click) menu for the right panel for Disk 1 and choose New Simple Volume. 

Complete the wizard with the default settings. 

 Give share permissions with Full Control to Everyone on the D drive. 

 Install PhotoMesh using the standard installation to D:\PhotoMesh.  

 Create the folder D:\PMWorkingFolder, and then then the subfolder A directly below it, so that you 

have the directory structure: D:\PMWorkingFolder\A. 

 Create the folder D:\PMProjects. 

 Start PhotoMesh from “\\10.0.0.10\D\PhotoMesh\PhotoMesh.exe". 

 Click the PhotoMesh button, and then click Options (F9). 

 Change the Working Folder to \\10.0.0.10\D\PMWorkingFolder\A. 

 Click OK and then close PhotoMesh. 

Step 3: Create a Fuser AMI (Linux) 

Creating a Linux AMI for a fuser computer is a multi-part step that entails: launching an instance from an 

existing AMI, customizing the instance, and finally creating a new AMI from the instance.  

To create a fuser AMI, follow the steps below. For more information, see: Getting Started with Amazon 
EC2 Linux Instances in Amazon’s AWS documentation.  

Linux fuser AMI’s are generally recommended over Windows AMI’s since Linux instances are more cost 
effective to run.  

Launching an Initial Instance  

 Open the Amazon EC2 console at https://console.aws.amazon.com/ec2/. 

https://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/ebs-using-volumes.html
http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/using_cluster_computing.html
https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/EC2_GetStarted.html
https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/EC2_GetStarted.html
https://console.aws.amazon.com/ec2/
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 From the Amazon EC2 console dashboard, choose Launch Instance. 

 On the Choose an Amazon Machine Image (AMI) page, choose the following AMI from the Quick 

Start list: Ubuntu Server 18.04 LTS (HVM), SSD Volume Type, and then choose Select. 

 On the Choose an Instance Type page, select the g4dn.xlarge type, and choose Next: Configure 

Instance Details.  

Note: The instance type selected here depends on the fusers you intend to use to build the 

project. The g4dn.xlarge instance type should be used to create an AMI for G4 and G3 

instances.  

 On the Configure Instance Details page, enter the following information: 

a. Network: Choose the PM VPC VPC created in step 4 of "Configuring a VPC". 

b. IAM Role: Choose the IAM role "PM_RUNFUSER_POLICY" created in "Creating an IAM Policy 
and Role". 

c. Choose Next: Add Storage. 

 On the Add Storage page, enter the following: 

a. Change the default Root volume Size to at least 16 GiB. 

Note: The EBS volumes will incur additional charges. For more information see Amazon EBS 

Volumes in Amazon’s AWS documentation. 

b. Choose Next: Add Tags. 

 On the Add Tags page, enter the following information: 

a. Select Add Tag. 

b. Key: Name. 

c. Value: PM Linux Fuser Initial. 

d. Choose Next: Configure Security Group when you are done. 

 On the Configure Security Group page: 

a. Choose Select an existing security group. 

b. Select the PM_SG group. 

c. Choose Review and Launch. 

 On the Review Instance Launch page, review the details of your instance, and make any necessary 

changes by clicking the appropriate Edit link. When you are finished, choose Launch. 

 In the Select an existing key pair or create a new key pair dialog box:   

a. Choose Choose an existing pair. 

b. Key pair name: PM_KeyPair. 

c. Choose Launch Instances. 

 To launch your instance, select the acknowledgment check box, and then choose Launch Instances.  

Convert Your Private Key Using PuTTYgen  

See: Connecting to Your Linux Instance from Windows Using PuTTY in Amazon’s AWS documentation 
for more information. 

Note: For information on additional ways to connect to your Linux instance, see: 

https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/AccessingInstances.html 

http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/EBSVolumes.html
http://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/EBSVolumes.html
https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/putty.html
https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/AccessingInstances.html
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 Download and install PuTTY from the PuTTY download page. If you already have an older version of 

PuTTY installed, we recommend that you download the latest version. Be sure to install the entire 

suite. 

 From the Start menu, choose All Programs, PuTTY, PuTTYgen. 

 Under Type of key to generate, choose RSA. If you're using an older version of PuTTYgen, choose 

SSH-2 RSA.  

 Choose Load. By default, PuTTYgen displays only files with the extension .ppk. To locate your .pem 

file, choose the option to display files of all types. 

 Select your .pem file for the key pair that you specified when you launched your instance and choose 

Open. PuTTYgen displays a notice that the .pem file was successfully imported. Choose OK. 

 To save the key in the format that PuTTY can use, choose Save private key. PuTTYgen displays a 

warning about saving the key without a passphrase. Choose Yes. 

Note: A passphrase on a private key is an extra layer of protection. Even if your private key is 

discovered, it can't be used without the passphrase. The downside to using a passphrase 

is that it makes automation harder because human intervention is needed to log on to an 

instance, or to copy files to an instance. 

 Specify the same name for the key that you used for the key pair (for example, PM_KeyPair) and 

choose Save. PuTTY automatically adds the .ppk file extension. 

Your private key is now in the correct format for use with PuTTY. You can now connect to your 

instance using PuTTY's SSH client. 

Connecting to the Instance  

To connect: 

 Start PuTTY (from the Start menu, choose All Programs, PuTTY, PuTTY). 

 In the Category pane, choose Session and complete the following fields: 

a. In the Host Name box, to connect using your instance's public DNS, enter 
ubuntu@public_dns_name. 
You can get the public DNS for your instance using the Amazon EC2 console. Check the Public 
DNS (IPv4) column. If this column is hidden, choose the Show/Hide icon and select Public DNS 
(IPv4). 

b. Ensure that the Port value is 22. 

c. Under Connection type, select SSH.  

 (Optional) You can configure PuTTY to automatically send 'keepalive' data at regular intervals to keep 

the session active. This is useful to avoid disconnecting from your instance due to session inactivity. 

In the Category pane, choose Connection, and then enter the required interval in the Seconds 

between keepalives field. For example, if your session disconnects after 10 minutes of inactivity, 

enter 180 to configure PuTTY to send keepalive data every 3 minutes. 

 In the Category pane, expand Connection, expand SSH, and then choose Auth. Complete the 

following: 

a. Choose Browse. 

b. Select the .ppk file that you generated for your key pair and choose Open.  

c. (Optional) If you plan to start this session again later, you can save the session information for 
future use. Under Category, choose Session, enter a name for the session in Saved Sessions, 
and then choose Save. 

https://www.chiark.greenend.org.uk/~sgtatham/putty/
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d. Choose Open. 

 If this is the first time you have connected to this instance, PuTTY displays a security alert dialog box 

that asks whether you trust the host to which you are connecting. Choose Yes. A window opens and 

you are connected to your instance. 

Customizing the Instance  

See: Linux Accelerated Computing Instances in Amazon’s AWS documentation for more information. 

 To download and install the Nvidia drivers and update the operating system, in the PuTTY terminal 

window, type: 

a. wget http://us.download.nvidia.com/tesla/440.33.01/NVIDIA-Linux-x86_64-440.33.01.run 

b. sudo apt-get update 

c. sudo apt-get -y install gcc make xserver-xorg libglu1-mesa-dev freeglut3-dev mesa-common-dev 
libxmu-dev libxi-dev mesa-utils x11vnc xfce4 dkms xvfb 

d. sudo apt-get remove xscreensaver 
Type Y when asked to continue. 

e. sudo apt-get remove xscreensaver-data 
Type Y when asked to continue. 

f. chmod +x NVIDIA-Linux-x86_64-440.33.01.run 

g. sudo ./NVIDIA-Linux-x86_64-440.33.01.run 
Click Yes when asked to register the kernel module. Click OK when prompted to do so during the 
installation. 

h. sudo reboot 
The following message is displayed: “Remote side unexpectedly closed network connection”. 
Click OK. 

 Right-click the title bar of the PuTTY window, and select Restart Session. 

 To configure the GPU and start the X window system, in the PuTTY terminal window, type: 

a. nvidia-xconfig --query-gpu-info | grep BusID 
Copy the value that is outputted. E.g., if the output is “PCI BusID : PCI:0:30:0”, select and copy 
“PCI:0:30:0”. 

b. sudo nvidia-xconfig -a --virtual=1280x1024  --busid=<BUSID> 
Where <BUSID> is replaced with the value from 2c above, e.g., sudo nvidia-xconfig -a --
virtual=1280x1024  --busid=PCI:0:30:0. 

Note: If a warning is displayed that the xconfig file was not located/opened, click OK. 

c. sudo /usr/bin/X :0 & 

d. export DISPLAY=:0 

 (Optional) To configure VNC in order to verify X runs properly, in the PuTTY terminal window type: 

a. x11vnc -storepasswd 
Then type and verify the password  

b. y  
This confirms writing the password to /home/Ubuntu/.vnc/passwd. 

c. x11vnc -rfbauth ~/.vnc/passwd & 

d. xfce4-session & 

https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/accelerated-computing-instances.html
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 (Optional) Connect with VNC client using your instance's public DNS and the password set in step 4 

above. 

You can get the public DNS for your instance using the Amazon EC2 console. Check the Public DNS 

(IPv4) column. If this column is hidden, choose the Show/Hide icon and select Public DNS (IPv4). 

 To install and configure Wine, do the following:  

a. Open the Start menu and search for cmd to start a command prompt. 

b. Type pscp -i <.ppk file> <wineinst.tar full path>  ubuntu@<fuser IP>:/home/ubuntu/wineinst.tar 
Where <.ppk file> is replaced with a full path to the ppk file created in "Convert Your Private Key 
Using PuTTYgen"; <wineinst.tar full path> is replaced with the full path to the wineinst.tar that is 
included in the zip folder that can be downloaded from here; and <fuser IP> is replaced with the 
Public DNS (IPv4) of the instance. 

c. In the PuTTY terminal window, type: 

i. tar -xvf  wineinst.tar 

ii. sh fuser.sh 

Note: This process can take a few minutes to complete.   

 In the Amazon EC2 console, right-click the instance, point to Instance State, and select Stop.  

 After the instance has stopped, right-click the instance, point to Instance Settings, and select 

Change Instance Type. The Change Instance Type dialog box is displayed. 

 From the Instance Type drop-down list, select g4ad.4xlarge.  

 Restart the instance by right-clicking the instance in the Amazon EC2 console, pointing to Instance 

State, and selecting Start. 

 Reconnect to the instance via PuTTY by performing the steps in "Connecting to the Instance". 

 To download and install AMD drivers, in the PuTTY terminal window type: 

a. sudo apt  install awscli 

i. Y to continue 

b. aws s3 cp --recursive s3://ec2-amd-linux-drivers/latest/ . 

c. tar -xf amdgpu-pro*ubuntu*.xz 

d. sudo apt install linux-modules-extra-$(uname -r) -y 

e. Change to the folder of the extracted driver: 

i. Type the following (without pressing ENTER): cd amd 

ii. Press tab once. 

iii. Press ENTER. 

f. cat RPM-GPG-KEY-amdgpu | sudo apt-key add - 

g. ./amdgpu-pro-install -y --opencl=pal,legacy 

h. sudo reboot  

 The following message is displayed: “Remote side unexpectedly closed network connection”. Click 

OK. 

 Right-click the title bar of the PuTTY window, and select Restart Session. 

 Test that the installation was successful: 

a. dmesg | grep amdgpu 

https://www.winehq.org/
https://ftp2.skylinesoft.com/products/pm/PM-AWS-Files_78.zip
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b. Check the response and look for "Initialized amdgpu". This indicates that the installation was 
successful. 

Saving a Fuser AMI 

See: Creating an Amazon EBS-Backed Linux AMI in Amazon’s AWS documentation for more information.  

 In the navigation pane, choose Instances and select the PM Linux Fuser Initial instance. Choose 

Actions, Image, and Create Image. 

 In the Create Image dialog box, specify values for the following fields, and then choose Create 

Image. 

▪ Image name: PM Linux Fuser Image. 

 While your AMI is being created, you can choose AMIs in the navigation pane to view its status. 

Initially, this is pending. After a few minutes, the status should change to available. 

 Record the AMI ID of the created AMI, or copy it to the clipboard. You need this AMI ID for 

PhotoMesh to launch fuser instances. 

 In the navigation pane, choose Instances and select the PM Linux Fuser Initial instance. 

 Choose Actions, select Instance State, and then choose Terminate. 

  

https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-ebs.html
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Step 4: Build a PhotoMesh Project 

This step outlines the workflow for building a PhotoMesh project. The option to run the entire PhotoMesh 

production with only cloud resources is the main workflow discussed above, and then in "Building a 

PhotoMesh Project Using the Master Instance" below. It is also possible to apply a hybrid cloud 

architecture that mixes cloud and on-premises computing power and storage solutions. This option is 

covered in "Creating an IAM User for Running PhotoMesh Project Using an On-Premises Master" and 

"Building a PhotoMesh Project Using an On-Premises Master and Storage".  

There are a number of variables involved in the selection of fuser instances to process a build: 

▪ CPU/GPU  – The hardware of the host computer used for your instance determines its compute, 

memory, storage, and graphic capabilities. GPU-based instances provide access to NVIDIA GPUs to 

accelerate processing. The need for GPUs is generally determined based on build step. See the table 

below. 

▪ Price/Performance – Optimized balance between machine price and its computing power. See here 

for more information: https://aws.amazon.com/ec2/pricing/. See the table below for Skyline 

recommendations (based on our experience in the US East – N. Virginia region). 

▪ Availability Zones-Subnets – The availability of the required number of instances and their price 

should be considered when selecting an availability zone. Since you are also charged for data 

transfer from one availability zone to another, if you require many fusers, it is recommended to launch 

the master in an availability zone with good spot availability to avoid significant cross-availability zone 

charges. A subnet must be created for each availability zone. For more information, consult the 

Amazon EC2 console as described below.  

▪ On-Demand/ Spot – On-demand instances provide guaranteed compute resources, while spot 

instances are dependent on the availability of unused instances: spot instances will only be launched 

if an instance is available and instance use may be interrupted unexpectedly if capacity is no longer 

available. On-demand instances also have a static price, while spot instance price varies based on 

demand. For more information see Amazon EC2 Using Spot Instances in Amazon’s AWS 

documentation.  

Analyzing the price history of spot instances in Amazon EC2 console's Pricing History can help you 

determine availability of different spot instance types in different availability zones. Price is generally 

determined by the law of supply and demand, so if the price for a particular instance type is low in a 

specific zone, this usually indicates higher availability of spot instances of that type in the zone. No price 

is listed for a particular zone if there are no spot instances of that specific machine type in this zone.  

See the chart below for our recommendations for each PhotoMesh step. 

Recommendations Based on PhotoMesh Step 

PhotoMesh 
Step 

I/O (Disk 
IOPS and 
Network 
bandwidth) 

CPU GPU Recomm
ended # 
of fusers 
/ 1Gbps 

Recommended 
Machine Types 

Preferred 
Method for 
Hybrid 

Data 
Preparation 

Intensive Intensive Low 5 M5dn.4xlarge 

M5d.4xlarge 

M5.4xlarge 

Local 

AT Intensive Intensive No 20 M5dn.4xlarge 

M5d.4xlarge 

Local 

https://aws.amazon.com/ec2/pricing/
https://eu-west-1.console.aws.amazon.com/ec2sp/v1/spot/home?region=eu-west-1
https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/ec2-on-demand-instances.html
https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/using-spot-instances.html
https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/using-spot-instances.html
https://eu-west-1.console.aws.amazon.com/ec2sp/v1/spot/home?region=eu-west-1
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M5.4xlarge 

Point Cloud Low High No 200 M6i.2xlarge 

M5.2xlarge 

M5dn.2xlarge 

AWS 

Model Low High No 200 M6i.2xlarge 

M5.2xlarge 

M5dn.2xlarge 

AWS 

Texture 
Mesh 

High Low High 50 G4ad.4xlarge 

G4dn.4xlarge 

G3.4xlarge 

G4dn.2xlarge 

AWS 

Output High Low High 20 G4ad.4xlarge 

G4dn.4xlarge 

G3.4xlarge 

G4dn.2xlarge 

Local 

 

Building a PhotoMesh Project Using the Master Instance 

To use the configured environment to produce PhotoMesh projects, follow the steps below: 

 Connect to the PM Master instance.  

Note: If the PM Master instance is not already running, choose Actions, select Instance State, 

and then choose Start. 

 Create the directory: “D:\PhotoMesh\AWSConfigurations", and then copy the JSON files 

(“DataPrep_AT.json”, “Reconstruction_CPU.json”, and “Reconstruction_GPU.json”) from the zip file 

downloaded in step 6b of "Customizing the (Fuser) Instance" to this directory.  

 Start PhotoMesh, and create a project. 

Note: The project must be created in a location that is accessible to both master and fuser 

instances. It is recommended to organize all projects and sources in the 

\\10.0.0.10\D\PMProjects\ directory. 

 On the Home tab, in the Build group, click Build, then enter the Build Parameters and click Build. 

 In the PhotoMesh Build Manager dialog box, toggle on Use AWS Instances (Change). 

 In the Auto-Scaling Fusers Settings dialog, do the following: 

a. Check the Use AWS Instances check box. 

b. Maximum Price Per Spot Instance: Set the maximum price you want to pay per EC2 spot 
instance. For more information, see Amazon EC2 Spot Instance Pricing in Amazon’s AWS 
documentation. 

c. Maximum Instances: Set the number based on the number of EC2 instances you want to run. 

d. Launch Rate: Set the maximum number of fuser instances to launch per minute, e.g. if Maximum 
Instances was set to 200, and the Launch Rate to 50, the Build Manager will spread the launch of 
the fusers over 4 minutes. This prevents a potential bottleneck that could be caused by a large 
number of fusers attempting to read the build data at the same time. 

e. Terminate AWS instances when build finished: Select the check box if you want to terminate 
AWS fuser instances when the build is complete. 

https://aws.amazon.com/ec2/spot/pricing/
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f. Build Priority: Select either Choose all listed options, to use all machine types listed in the 
JSON file, with priority based on the order they are listed in the file, or select a specific machine. 

g. Security Group ID: Select PM_SG. 

h. Subnet ID: Click Additional Subnets... and type a list of all the subnet ID's you want to use. 
These were created in "Configuring a VPC". A subnet must be created for each availability zone. 
Since you are charged for data transfer from one availability zone to another, it is recommended 
to launch the master in an availability zone with good spot availability. PhotoMesh will always 
attempt first to launch instances from the same availability zone as the master, and only if no 
instances are available, will it launch an instance from a different zone. See the overview to step 
4 for some of the issues to consider when selecting a subnet/availability zone.  

i. Key Pair Name: Select PM_KeyPair.  

j. Configuration Name: Select based on the current processing step. Select the 
Reconstruction_GPU option if you want to run an entire build without needing to reselect the 
configuration before each build step, since this option can be used for all build steps. 

▪ Reconstruction_GPU – For texture and output steps. 

▪ AT_MultiCoreCPU – Multi-core CPU for data preparation and aerotriangulation steps. 

▪ Reconstruction_CPU – For point cloud and model steps. 

Note:  These configuration options are read from the JSON files copied in step 2 above. Each of 

these JSON files contains an array of instance types that PhotoMesh should use, ordered 

based on preferability. During production, PhotoMesh iterates over the elements of the 

array, beginning with the first instance type, until it finds an available instance.  

Each instance object in the array has three properties: ami, instanceType, and 

demandType. The instanceType defines the hardware of the host computer used for your 

instance. Each instance type offers different compute, memory, and storage capabilities. 

The demandType determines the pricing arrangement: on-demand or spot. See the 

overview to step 4 for some of the issues to consider when selecting instance types. 

k. Click Edit (next to Configuration Name), insert in all fields the AMI ID of the PM Linux Fuser 
Image (created in "Saving a Fuser AMI"), and then click OK.  

l. Select Shutdown inactive fuser instances after and set its value to "1". 

m. Click Edit Startup Script and paste the template script from the zip file downloaded in step 6b of 
"Customizing the (Fuser) Instance" (Startup_Script_awsQG_Template). Edit the script so it 
includes the username and the password of your PM Master machine set in step 13 of 
"Connecting to the (Master) Instance" 13(In the script, replace all <pass> and <user> 
placeholders with the required value. 

n. Click OK. 

 Click Build. 

Note: If a message is displayed that “PhotoMesh’s fuser request was rejected by AWS, since it 

exceeded the instance limit”, you need to request a quota increase for “Spot instance 

requests”. See: Amazon EC2 Service Limits in Amazon’s AWS documentation for more 

information. 

 In the PhotoMesh Build Manager dialog box, you can monitor the creation and automatic use of the 

automatically launched fuser instances. You can also monitor the creation of your instances by 

choosing Instances in the navigation pane of the Amazon EC2 console, and reviewing the custom 

tags added to PhotoMesh launched instances: Build start time, Owner, Project, Type, and Working 

folder. 

 When processing is complete, stop the PM Master instance.  

https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/ec2-resource-limits.html
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Note: Do not terminate the master instance; only stop and start as needed. 

Note: It is recommended to verify that the instances are terminated according to the settings 

defined in the AWS Cloud Settings dialog, particularly the first time they are terminated. 

Creating an IAM User for Running PhotoMesh Project Using an On-Premises Master  

To allow PhotoMesh Master running on an on-premises computer to launch EC2 instances, create an 
IAM user and assign permissions. 

See: Creating IAM Users (Console) in Amazon’s AWS documentation for more information. 

 Open the Amazon IAM console at https://console.aws.amazon.com/iam/. 

 In the navigation pane, choose Users and then choose Add user. 

 Type the user name for the new user. 

 Select the Programmatic access check box. Then choose Next: Permissions. 

 On the Set Permissions page, choose Attach existing policies to user directly.  

 In the list of policies, select the PM_RUNFUSER_POLICY policy. You can use the Filter menu 

to filter the list of policies. 

 Choose Next: Tags. 

 Choose Next: Review. 

 Review the role and then choose Create user. 

 To view the users' access keys (access key IDs and secret access keys), choose Show next to each 

password and access key that you want to see. To save the access keys, choose Download .csv 

and then save the file to a safe location. 

Note: This is your only opportunity to view or download the secret access keys. Save the user's 

new access key ID and secret access key in a safe and secure place. You will not have 

access to the secret keys again after this step. 

Building a PhotoMesh Project Using an On-Premises Master and Storage  

Before beginning a build using an on-premises master and storage, ensure that your fuser machines 
have access to your local storage, e.g., via AWS Direct Connect, Site-to-Site VPN, or Security Group and 
firewall rules. Sufficient bandwidth for the data transfer between your on-premises storage and the fuser 
machines is significantly affects production performance. See the overview to step 4 for some of the 
issues to consider regarding the hybrid architecture. 

To use the configured environment to produce PhotoMesh projects using on-premises storage and a 

PhotoMesh that is installed on an on-premises computer while utilizing AWS fuser instances, follow the 

steps below: 

 Make sure your on-premises computer has PhotoMesh installed.  

Note: File access can be achieved in different ways, e.g. via AWS Direct Connect, Site-to-Site 

VPN, or Security Group and firewall rules. Consult AWS documentation, support, your IT 

person, or Skyline support for more information. 

 Create the directory: ".\PhotoMesh\AWSConfigurations", and copy the JSON files 

(“DataPrep_AT.json”, “Reconstruction_CPU.json”, and “Reconstruction_GPU.json”) from the zip file 

downloaded in step 6b of "Customizing the (Fuser) Instance" to this directory.  

 Start PhotoMesh and create a project. 

Note: The project must be created in a location that is accessible to all fuser instances.  

 On the Home tab, in the Build group, click Build, then enter the Build Parameters and click Build. 

https://docs.aws.amazon.com/IAM/latest/UserGuide/id_users_create.html#id_users_create_console
https://console.aws.amazon.com/iam/
https://aws.amazon.com/directconnect/
https://docs.aws.amazon.com/vpn/latest/s2svpn/VPC_VPN.html
https://aws.amazon.com/directconnect/
https://docs.aws.amazon.com/vpn/latest/s2svpn/VPC_VPN.html
https://docs.aws.amazon.com/vpn/latest/s2svpn/VPC_VPN.html
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 In the PhotoMesh Build Manger dialog box, toggle on Use AWS Instances (Change). 

 In the AWS Security dialog, enter your AWS credentials created in "Creating an IAM User for 

Running PhotoMesh Project Using an On-Premises Master". 

 In the Auto-Scaling Fusers Settings dialog, do the following: 

a. Check the Use AWS Instances check box. 

b. Maximum Price Per Spot Instance: Set the maximum price you want to pay per EC2 spot 
instance. For more information see Amazon EC2 Spot Instance Pricing in Amazon’s AWS 
documentation. 

c. Maximum Instances: Set the number based on the number of EC2 instances you want to run. 

d. Launch Rate: Set the maximum number of fuser instances to launch per minute, e.g. if Maximum 
Instances was set to 200, and the Launch Rate to 50, the Build Manager will spread the launch of 
the fusers over 4 minutes. This prevents a potential bottleneck that could be caused by a large 
number of fusers attempting to read the build data at the same time. 

e. Terminate AWS instances when build finished: Select the check box if you want to terminate 
AWS fuser instances when the build is complete. 

f. Build Priority: Select either Choose all listed options, to use all machine types listed in the 
JSON file, with priority based on the order they are listed in the file, or select a specific machine. 

g. Security Group ID: Select PM_SG. 

h. Subnet ID: Click Additional Subnets... and type a list of all the subnet ID's you want to use. 
These were created in "Configuring a VPC". A subnet must be created for each availability zone.  
See the overview to step 4 for a comparison of on-demand/spot instances and information on 
using pricing history to determine instance availability.  

i. Key Pair Name: Select PM_KeyPair.  

j. Configuration Name: Select based on the current processing step. Select the 
Reconstruction_GPU option if you want to run an entire build without needing to reselect the 
configuration before each build step, since this option can be used for all build steps. 

▪ Reconstruction_GPU – For texture and output steps.  

▪ AT_MultiCoreCPU – Multi-core CPU for data preparation and aerotriangulation steps. 

▪ Reconstruction_CPU – For point cloud and model steps. 

Note: These configuration options are derived from the JSON files copied in step 2 of "Building 

a PhotoMesh Project Using the Master Instance". Each of these JSON files contains an 

array of instance types that PhotoMesh should use, ordered based on preferability. 

During production, PhotoMesh iterates over the elements of the array, beginning with the 

first instance type, until it finds an available instance.  

Each instance object in the array has three properties: ami, instanceType, and 

demandType. The instanceType defines the hardware of the host computer used for your 

instance. Each instance type offers different compute, memory, and storage capabilities. 

The demandType determines the pricing arrangement: on-demand or spot. See the 

overview to step 4 for some of the issues to consider when selecting instance types.  

k. Click Edit (next to Configuration Name), insert in all fields the AMI ID of the PM Linux Fuser 
Image (created in "Saving a Fuser AMI"), and then click OK.  

l. Select Shutdown inactive fuser instances after and set its value to "1". 

m. Click Edit Startup Script and paste the template script from the zip file downloaded in step 6b of 
"Customizing the (Fuser) Instance (Startup_Script_Template.txt). Edit the script so it includes the 
username and the password of your PM Master machine set in step 13 of "Connecting to the 

https://aws.amazon.com/ec2/spot/pricing/
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(Master) Instance" (In the script, replace all <serverip >, <share>, <pass> and <user> 
placeholders with the required value).  

n. Click OK. 

 Click Build. 

Note: A message is displayed informing you that no available fusers are currently running and 

asking if you want to start a local fuser. If you want to start a fuser on the master machine 

to take advantage of its computing resources, click Yes. If you are running many spot fuser 

instances, however, it is recommended to click No to free up computing resources for 

management of the build and file server tasks. 

Note: If a message is displayed that “PhotoMesh’s fuser request was rejected by AWS, since it 

exceeded the instance limit”, you need to request a limit increase for “Spot instance 

requests”. See: Amazon EC2 Service Limits in Amazon’s AWS documentation for more 

information. 

 In the PhotoMesh Build Manger dialog box, you can monitor the creation and automatic use of the 

automatically launched fuser instances. You can also monitor the creation of your instances by 

choosing Instances in the navigation pane of the Amazon EC2 console, and reviewing the custom 

Tags added to PhotoMesh launched instances: Build start time, Owner, Project, Type, and Working 

folder. 

 It is recommended to verify that the instances are terminated according to the settings defined in the 

AWS Cloud Settings dialog, particularly the first time they are terminated. 

 

 

 

https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/ec2-resource-limits.html
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CHAPTER 16   BUILDING  

About Building 

After all photos are added to the project and all properties are set as required, you can begin the build 

process. The build process provides flexibility with regard to the AT area, reconstruction area, build steps 

that are to be completed, and output formats.  

The build process entails a series of sequential steps beginning with data preparation and 

aerotriangulation and followed by three reconstruction steps: point cloud creation, model creation, and 

model texturing, and then project output. The required build steps are selected in the Build Parameters 

dialog box. The final output can be created in any of the following output formats: 3DML (for loading 

directly into TerraExplorer and streaming with SkylineGlobe Server), DAE, OBJ, 3D Tiles, I3S/SLPK, 

OSGB, Orthophoto, DSM, DTM/DEM, and LAS (Point cloud public file format). See “Setting Output 

Formats” in this chapter for information on the different file formats.  

As the build process is progressing, the 3D Window displays the interim build results and PhotoMesh 

Build Manager displays information about the current step and active fusers. 

If a previously built project requires modification, instead of building the entire project again from the first 

step of the build process, you have the option to rebuild, incorporating some of a previous build’s results. 

Rebuilding provides flexibility both with regard to the project section (entire project, only error tiles or 

selected tiles) and project steps that are to be rebuilt. See “Rebuilding” in this chapter for more 

information. 
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Recommended Aerotriangulation Workflow  

For optimal AT results, it is recommended to initially perform only the aerotriangulation step (“AT Only”), 

and then review the results, to ensure a precise AT which includes all project’s photos that intersect with 

the AT area, before proceeding with the rest of the build. If the results of the AT Only were in fact 

satisfactory, you can continue with the rest of the build process. PhotoMesh will automatically determine 

what processing is required to apply the changes to the project, by rebuilding the project from “Auto”. See 

“Rebuilding” in this chapter for more information.  

If the results of the initial AT Only build were unsatisfactory, modify the AT parameters or collection 

properties and/or edit/add control points based on the aerotriangulation result. Then repeat the 

aerotriangulation by selecting AT Only, and review your results. When repeating the aerotriangulation, 

PhotoMesh determines precisely which tiles and which specific AT sub-processes were affected by the 

modification of properties or control points, enabling a much lighter and faster AT process. This iterative 

process should be repeated until satisfactory AT results are achieved. 

The diagram below outlines the recommended aerotriangulation workflow.  
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Defining the Aerotriangulation (AT) Area 

Before starting a build, you should define the aerotriangulation (AT) area. 

To define the aerotriangulation area: 

 If you want to perform aerotriangulation on the entire project, on the Home tab, in the Area group, 

click the arrow under AT Area and select Automatic. 

 If you want to perform aerotriangulation on a subset of the project define the AT area (See “Setting 

the AT Area” in the “Preparing the Project” chapter for more information).  

Note: It is generally recommended to perform aerotriangulation on a preview model of a small 

subset of the project to validate camera parameters and build settings and check the 

resulting AT tiles before building the full project.  

Defining the Reconstruction Area 

By default, the reconstruction area is set to the same as the AT area.  

To define the reconstruction area: 

 If you want to perform reconstruction on the same area as aerotriangulation, on the Home tab, in the 

Area group, click the arrow under Reconstruction Area and select Same as AT Area. 

 If you want to perform reconstruction on a different area than the area set for aerotriangulation, set 

the reconstruction area (See “Setting the Reconstruction Area” in the “Preparing the Project” chapter 

for more information).  

Setting Build Parameters and Processing the Build 

Before PhotoMesh can build the project, build steps and project parameters are set in the Build 

Parameters dialog box. The Build Parameters dialog box includes a list of Build Presets that make it easy 

to automatically set the required parameters to generate the optimum output for the project’s data as well 

as to share user-defined build settings between projects. Presets only include changes from the default 

settings. See “Working with Presets” in this chapter for information. 

To set build steps and parameters and start processing: 

 On the Home tab, in the Build group, click Build. The Build Parameters dialog box is displayed. 
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Build Parameters Dialog Box 

 Select the Build Steps to perform: 

▪ Complete Project – Perform all build steps. The Start From field is automatically set to Auto to 

automatically perform only the steps that are required to complete the project, and Build Until is 

set to Project Output.  

▪ AT Only – Perform only AT so you can review results before proceeding with the rest of the build 

to ensure a precise AT which includes all project’s photos that intersect with the AT area. When 

an AT Only build is performed and then repeated following project adjustments, PhotoMesh 

determines precisely which tiles and which specific AT sub-processes were affected by the 

modification of properties or control points, enabling a much lighter and faster AT process. 

▪ Custom – Perform selected build steps. To select the steps: 

i. In the Start From field, select the step from which you want to start the build. Select "Auto” to 

have PhotoMesh automatically determine what processing must be performed to complete 

the project, avoiding unnecessary rebuilding. E.g., when rebuilding a project after modifying a 

water polygon, only affected tiles are rebuilt from the point cloud step. Similarly, when 

rebuilding after reimporting exported models, only affected tiles are rebuilt, either from the 



   

 181 

PhotoMesh User Guide 

texturing step, if just models were imported, or from the output step, if both models and 

textures were imported. 

ii. In the Build Until field, select the step until which you want to build. 

 If you want to set build parameters automatically by using one of the available presets, click Select 

and Manage Presets. Select the required presets in the Preset Manager that is displayed, and click 

OK. See “Selecting Presets” in this chapter for information. 

 If you want to manually set build parameters, click each of the Build Parameters tabs and set the 

required parameters: 

▪ Build Steps 

▪ AT  

▪ Reconstruction  

▪ Output Formats 

 Click Build. The New build description dialog box is displayed. Enter a build name and click Ok. The 

PhotoMesh Build Manager is displayed.  
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PhotoMesh Build Manager – Starting a Build 

 If you want to change the working folder, in the Working Folder field, click Browse and in the dialog 

box that opens browse to the required folder. See “Setting the Working Folder (on the Master 

Computer)” in the “Fusers” chapter for information. 

 If you want PhotoMesh to automatically use any new fusers that connect to the project’s working 

folder, select Automatically use new available fusers. See “Using Fusers” in the “Fusers” chapter 

for information.  

Note: This setting should generally be selected when using AWS and pool fusers. 

 If you want to use AWS fusers, toggle on Use AWS Instances. See “Using Amazon Web Services 

(AWS) Fusers” in the “Fusers” chapter for information. 

 If you want to use pool fusers, toggle on Use Fusers Pool, and enter the required information. See 

“Using a Fusers Pool” in this chapter for information 
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 Select the required fusers. See “Fuser Management (on the Master computer)” in the “Fusers” 

chapter and “Monitoring a Build” in this chapter for more information on fusers.  

Note: If there are currently no available fusers, a dialog box is displayed asking if you want to 

start a local fuser. Click Yes to start a local fuser. Click No to start the build without adding 

a fuser; processing will begin automatically when fusers are added. If you want to cancel 

the build, click Cancel. 

 Click Build. 

Setting Build Steps 

To set build steps: 

 Click the Steps tab. 
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Build Parameters – Build Steps 

 Select the Build Steps to perform: 

▪ Complete Project – Perform all build steps to generate project output. 

▪ AT Only – Perform only AT so you can review results before proceeding with the rest of the build 

to ensure a precise AT which includes all photos in the project that intersect with the AT area.  

▪ Custom – Perform selected build steps. To select the steps: 

i. In the Start From field, select the step from which you want to start the build. Select "Auto” to 

have PhotoMesh automatically determine what processing must be performed to complete 

the project, avoiding unnecessary rebuilding. E.g., when rebuilding a project after modifying a 

water polygon, only affected tiles are rebuilt from the point cloud step. Similarly, when 

rebuilding after reimporting exported models, only affected tiles are rebuilt, either from the 
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texturing step, if just models were imported, or from the output step, if both models and 

textures were imported. 

ii. In the Build Until field, select the step until which you want to build. 

 Click Next to set AT parameters (see “Setting AT Parameters” in this chapter), or click Build to open 

PhotoMesh Build Manager to start processing (see “Monitoring a Build” in this chapter). 

Setting AT Parameters 

To set AT parameters: 

 Click the AT tab. 
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Build Parameters – AT Parameters 

 Set the parameters on the AT tab:  

Parameter Description 

Project 

Coordinate System Project’s internal coordinate system, in which the 
aerotriangulation and reconstruction are performed. By default, 
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this is set to the coordinate system of the input data. If the 
inputted data uses multiple coordinate systems, or you want to 
use a different coordinate system from your input’s, select the 
required coordinate system.  

Select the Custom option to create a new custom coordinate 
system. See “Setting Output Formats (Coordinate System)” in 
this chapter and “Coordinate System” in the “Basic Concepts” 
chapter for more information. 

Note: Click View to view the full Well-Known Text (WKT) for 
the coordinate system. 

Collections  

Camera Position Accuracy Accuracy of the camera positioning data:  

▪ Fully trusted input (AT Result) ) – PhotoMesh uses 
inputted camera positioning and orientation information 
and camera parameters (including focal length, principal 
point and radial/tangential distortion) without performing 
aerotriangulation. This option is recommended when 
reliable AT data in a Cartesian coordinate system, such 
as ENU or ECEF, is added to PM from other AT systems, 
e.g, Inpho and Bingo. 

Note: AT data in a projected coordinate system such 
as UTM may be unreliable either due to earth 
curvature or earth curvature corrections 
performed in the other system. This is 
particularly true for datasets that contain oblique 
photos or large frames, or cover a large 
geographic area. For data of this type, 
aerotriangulation should be re-performed in 
PhotoMesh, i.e., use the Reliable position and 
orientation option. 

▪ Reliable position and orientation (DGPS and INS) – 
PhotoMesh assigns a strong weight to inputted camera 
positioning. If the inputted camera positions are inaccurate 
or inconsistent with any provided control points, it may be 
advisable to use the Standard GPS option. This option is 
recommended for collections captured by professional 
systems with accurate positioning and orientation 
information (e.g. using DGPS and INS).  

▪ Standard GPS – PhotoMesh performs a robust calculation 
of positioning and orientation information and camera 
parameters. This option is recommended for collections 
using standard GPS with or without orientation information 
(e.g. drones).  

▪ Unreliable or unavailable – PhotoMesh performs a robust 
calculation of positioning and orientation information and 
camera parameters. All AT tiles are then aligned to each 
other before they are aligned as a single block to the 
provided positions. This option is recommended when the 
difference between the input position and the actual 
position may be greater than 50m. In most cases this is 
caused by a lag between the acquisition of the positioning 



 

188 

PhotoMesh User Guide 

information and the photo capture time, or when multiple 
collections are taken at different times with inaccurate 
positioning hardware. 

AT Tiles 

Target Photos per AT Tile Number of photos to be included in each AT tile. The default 
setting of 5,000 photos is recommended for most projects and 
can be safely run on 16 GB computers. In projects where it is 
necessary to have AT tiles with more than 5,000 photos, the 
recommended RAM is as follows. Results may vary depending 
on the type of collection and settings: 

 

Maximum 
Photos / AT Tile 

Recommended Fuser RAM 

7.5K 16 GB 

15K 32 GB 

30K 64 GB 

50K 128 GB 

 

Certain settings or AT-related presets may require more RAM 
than recommended above. E.g., it is recommended to set the 
Target Photos per AT Tile to 30% less than the value 
recommended above in both of the following scenarios: 

▪ When using the aggressive match preset  

▪ When photo overlap is higher than 75% 

When running a large AT, it is highly recommended to leave 
the CPU free of other processes, since the AT process utilizes 
a large percentage of the available processing power. 

PhotoMesh includes photos in an AT tile based on the photos' 
frustum, if orientation information is available, or based on its 
position and effective range in cases where no orientation 
information is provided. If the effective range is large and there 
is a very high overlap of photos, it may be advisable to set the 
orientation filter to Auto. This filter will try to accelerate the AT 
process by filtering out photos after a rough calculation of their 
orientation before proceeding with the remaining 
aerotriangulation steps. See “Collection Property Sheet” in the 
“Photo Management” chapter for information about the 
effective range property. See "Setting AT Parameters" in the 
"Building" chapter for more information about the orientation 
filter 

Larger AT tiles with more photos may be necessary if the 
default AT tiles have fewer than five ground control points that 
fall in or close to each tile, as is recommended for good 
accuracy. See the "Control Points" chapter for more 
information.  

https://skylinesoft.sharepoint.com/sites/PMAutomationILOffice/Shared%20Documents/Documentation/PhotoMesh/PhotoMesh_UserManual_Master.docx#_Collection_Properties_Property
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Note: An AT with a large number of photos may take many 
hours to complete, and if interrupted will need to be 
rebuilt.  

Orientation Filter Determines whether camera positions and orientations are 
quickly approximated to filter out photos that do not intersect 
with the AT tile area. For each AT tile, only photos that 
intersect with it go through the remaining aerotriangulation 
process steps. If you select Auto, the filter is run only if there 
are photos without orientation information in the tile.  

Match Mode Select Auto to dynamically adjust the complexity of the feature 
matching process based on the photos. For difficult datasets, 
select Rigorous to have PhotoMesh perform an intensive 
matching process with a higher success rate. 

Advanced 

Focal Length Select whether to calculate or use the original value provided. 

Radial Distortion Select whether to calculate or use the original value provided. 

Tangential Distortion Select whether to calculate or use the original value provided. 

Note: When using non-professional camera equipment, 
calculation of tangential distortion is recommended.  

Principal Point Select whether to calculate or use the original value provided. 

GPS Factor Weight factor to assign to the photos’ GPS data when 
performing the aerotriangulation. Select Auto to base on 
Camera Position Accuracy where “Unreliable” will assign a 
factor of 0 and only align the block solution to the GPS at the 
end of the aerotriangulation, and all other Camera Position 
Accuracy options will set the GPS factor to 1. 

Ground Control Point Factor Weight factor to assign to the ground control points (0-10000) 
when performing the aerotriangulation. Select Auto to use the 
default value of 1000. 

Calculate Camera 
Parameters 

Select one of the following options for calculating the camera’s 
intrinsic parameters: 

▪ Per collection settings – For each collection, use the 
collection’s Calculate Camera Parameters setting set in its 
property sheet. See “Collection Property Sheet” in the 
“Photo Management” chapter for more information.  

▪ Always per entire collection – For all collections 
(regardless of the collection’s Calculate Camera 
Parameters setting), ensure that all camera intrinsic 
parameters are the same for all photos in each collection.   

▪ Always per photo – For all collections (regardless of the 
collection’s Calculate Camera Parameters setting), always 
calculate intrinsic parameters per photo. This option is 
recommended for photos with variable zoom or video 
collections. 

Multiple AT Groups in Tile Select whether to include only a tile’s largest AT group (photo 
block) or all AT groups in AT Calculated Photos. 
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Align Photos to Camera 
Position 

Select one of the following options: 

▪ Per AT Tile – Each AT tile is aligned separately to its 
camera positions and ground control points. This option is 
recommended for projects with accurate camera positions 
as well as for nadir and corridor (linear) projects (e.g., 
roads or rivers) where the AT tile may come out arched. 

▪ Entire Project – If the tiles have ground control points, 
each AT tile is aligned separately to its camera positions 
and GCP’s, and then aligned to the other tiles. Otherwise, 
each AT tile is aligned separately to its camera positions 
and then the entire project is aligned as a single block to 
the camera positions. This option is recommended for 
projects with unreliable camera position accuracy. 

Skip Data Preparation When this option is selected, PhotoMesh skips the data 
preparation step entirely, saving the time that would otherwise 
be necessary to verify that it had been performed. Only select 
this option if this step was previously performed, and there has 
been no change to the AT area or to the project.  

AT Flags Flags that specify alternate behaviors and settings that 
PhotoMesh should apply. These flags can be obtained from 
Skyline support. 

 Click Next to set reconstruction parameters (see “Setting Reconstruction Parameters” in this 

chapter), or click Build to open PhotoMesh Build Manager to start processing (see “Monitoring a 

Build” in this chapter). 

Setting Reconstruction Parameters 

To set reconstruction parameters 

 Click the Reconstruction tab.  
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Build Parameters – Reconstruction Parameters 

Parameter Description 

Tiles 

Reconstruction Tile Size Size of the reconstruction tiles. This can be set to Auto or to a 
specified size in meters. It is generally recommended to use 
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the Auto option. When tile division results were non-optimal, 
setting a size in meters is recommended.  

If you want to control tile size based on size in meters, three 
factors should be taken into account: RAM, resolution and 
overlap. For projects with standard resolution (5-10 cm photos) 
100-150 meters is recommended on computers with 16 GB of 
RAM. Larger reconstruction tiles require more memory. On 
computers with over 64 GB of RAM, a tile size up to 400 
meters can used be used. As a general rule, the 
reconstruction tile size should be the ground resolution of the 
data multiplied by 2000. For high overlap datasets, the ratio 
between the reconstruction tile size and the ground resolution 
should be lower. 

Note: If point cloud build steps are repeatedly failing, and 
you observe a very high RAM usage towards the end 
of the point cloud step, it is recommended to reduce 
memory requirements or reconstruction tile size. 

Point Cloud 

Point Cloud Quality The resolution of the photos at which 3D points are extracted.  

Min. Number of Matches The minimum number of matches required to generate each 
3D point. When the point cloud generated is sparse with little 
overlap of photos, consider reducing the minimum number of 
matches. When there is noise in the point cloud output, it is 
recommended to increase the minimum number of matches, 
providing there is high overlap of the photos.  

Select Auto to dynamically calculate, for each 3D point in the 
point cloud, the minimum number of matches required to 
generate the point to produce an optimal point cloud from the 
available data. 

Correlation Window Size Size in pixels of the window used to perform the correlation 
between photos and extraction of 3D points from them.  

Select Auto to automatically calculate optimal window size for 
performing the correlation. 

Merge Lidar Points The data to use in creating the point cloud: only Lidar points, 
only points generated from photos, or Auto – supplement Lidar 
with points generated from photos where Lidar information is 
insufficient.  

Lidar Collection Mode The direction of Lidar collection assists in calculating surfaces 
from the point cloud. When there is no trajectory file and the 
Lidar collection is known to be airborne, select Aerial. 
Otherwise, select Auto.  

Point Cloud Collections 
Click the More Options  button to select the collections to 
include in the point cloud. See “Setting the Collections and 
Bands to Include in the Build Outputs” in this chapter for 
information.  

Model 

Mesh Resolution Level of mesh complexity. The Low option will aggressively 
simplify the mesh. 

Smooth Surfaces Determines whether surfaces are flattened. 
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Enhanced Edges Determines whether 2D edges in the project’s photos are 
correlated and 3D edges extracted from them, to produce the 
3D model. This setting produces better-defined 3D models 
with sharper edges, which is important for urban area 
reconstructions and thin structures such as poles and wires. 

Remove Floating 
Components 

Level of removal of small floating components in the mesh 
model (e.g. noise, electric lines, lamp poles).  

Tile Vertical Clipping Buffer Vertical buffer to apply to the tile. Adding a buffer with a 
positive value is useful when there are objects that were cut off 
in a specific tile. A buffer with a negative value can be used to 
crop areas with small floating components. 

Texture 

Color Saturation Vividness of the colors of the textured model. 

Texture Blending Determines whether to use data blended from multiple photos 
in texturing the model, or only data from the optimal photo. 
Select No if blending results in ghosting artifacts. Select Extra 
if Yes produces color patches in areas with strong color 
variance. 

Sharpening Level of image sharpening applied to the final result. 

Texture Bands and 
Collections 

Click the More Options  button to select the bands to 
assign to each RGB of the mesh model texture, and the 
collections to include in generating the texture. See “Setting 
the Collections and Bands to Include in the Build Outputs” in 
this chapter for information.  

Use Lidar Colors The data to use in texturing the model: only color from Lidar 
points, only texturing from photos, or Auto – supplement photo 
textures with color from Lidar points where photo texturing 
information is insufficient. 

Advanced  

Reconstruction Flags Flags that specify alternate behaviors and settings that 
PhotoMesh should apply. These flags can be obtained from 
Skyline support.  

 Click Next to set output formats (see “Setting Output Formats” in this chapter), or click Build to open 

PhotoMesh Build Manager to start processing (see “Monitoring a Build” in this chapter). 

Setting Output Formats 

The available output formats vary depending on your license level. Contact Skyline Support for more 

information. 

To set output formats 

 Click the Output tab. 
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Build Parameters – Output Formats 
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Parameter Description 

Coordinate System Coordinate system of the output: select the required 
coordinate system, or click View to see the full WKT. From the 
Coordinate System drop-down list, select Custom to define a 
custom coordinate system. See “Coordinate System” in the 
“Basic Concepts” chapter for more information. 

Note: 3D Tiles output is always produced in ECEF 
coordinate system and I3S/SLPK output in WGS84 
coordinate system with EGM96 vertical datum, 
regardless of the coordinate system selected here. 

Note: All outputs are saved to the output folder, with a WKT 
to identify the output coordinate system that was 
selected in this parameter and special WKT’s for the 
coordinate systems of the 3D Tiles and I3S/SLPK 
output (Output-WKT_Cesium.txt and WKT_I3S.txt). 

Output Folder Output folder in which the build results are saved (read-only).  

3D Mesh Select all required 3D Mesh output formats:  

▪ 3DML – Stream-optimized, high-resolution 3D Mesh Layer 
database for loading directly into TerraExplorer and 
streaming with SkylineGlobe Server.  

▪ 3D Tiles – Multi-resolution 3D tile textured model for 
streaming to Cesium clients. If you want to reproject the 
elevation values to ellipsoid (as required by the Cesium 3D 
Tiles standard) for compatibility with terrain that uses 
ellipsoid elevation, select Reproject elevation. This option 
should only be selected for terrain providers that use 
TRUE ellipsoid elevation.  

Note: Some applications, e.g., Cesium-based TE4W, 

use a TerrainProvider and other data with 
geoid elevation values even though they are 
declared as ellipsoid when delivered to 
TE4W/Cesium. Thus, they are actually 
compatible without reprojection.  

Note: PhotoMesh outputs can easily be published to 
TE4W as well as other Cesium viewers by 
publishing the resulting 3DML to SGS. SGS will 
then make them available to TerraExplorer 
clients as 3DML as well as to TE4W/Cesium by 
converting them on-the-fly to 3D Tiles. Use the 
3D tiles output if you need to produce a full 3D 
Tiles output for a non-SGS web-server.  

▪ DAE – Textured Collada model per reconstruction tile. 

▪ OBJ – Textured OBJ model per reconstruction tile. 

▪ OSGB – Multi resolution textured model for use in 
OpenSceneGraph.  

Note: The file pyramid \p-00000.osgb is the root of the 
hierarchy that can be used to load all data. 

https://cesium.com/docs/cesiumjs-ref-doc/TerrainProvider.html
http://www.openscenegraph.org/
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Note: If you want to reference the DAE/OBJ/OSGB 
model’s coordinates to the project’s center, 
select Center pivot to project. This setting 
improves the stability of 3D model display in 3rd 
party viewers that are limited regarding display 
of large coordinates. When selected, only DAE, 
OBJ, OSGB can be produced. If you want to set 

a custom pivot, click More Options . See 
“Setting a DAE/OBJ/OSGB Model Pivot” in this 
chapter for information. 
If you need the project center’s coordinate 
information to reference the model in external 
software, this information can be extracted from 
the Output-CenterPivotOrigin JSON file created 
in the build’s output folder when the output is 
generated. The Origin and WKT name/value 
pairs in this file contain the coordinates of the 
project’s center to which the model is 
referenced and their coordinate system WKT.  

▪ I3S/SLPK – ESRI’s Indexed 3D Scene (I3S) Layers 
delivery format used to stream very large 3D geospatial 
datasets to mobile, web and desktop clients. When this 
output format is generated, a tool is also produced in the 
output folder that can convert the I3S output to a 
compressed SLPK package. 

Note: To convert the I3S to SLPK, run the 
“SPKMaker.exe” that is placed in the output 
folder, and browse to the “I3SOut.slpk” file 
created in that folder. The I3S layer is converted 
to SLPK v1.5.  

Note: For I3S/SLPK v1.7, it is recommended to output 
the mesh model as 3DML, and then export the 
mesh to I3S in TerraExplorer Pro. See 
"Exporting 3D Mesh Layers to Other Formats" 
in the TerraExplorer User Manual.  
Alternatively, you can output to I3S v1.5 in 
PhotoMesh and then convert the output to 
SLPK v1.7 using the I3S converter. 

Point Cloud Select the LAS check box to create a Lidar LAS file with X,Y,Z 
position and color information for each point of the point cloud. 
Then select one of the following options: 

▪ Sampled refined 3D model – To create a point cloud by 
sampling the final textured model. Then in the Resolution 
field, enter the density for sampling the model. 

▪ Points from photo correlation - To generate a point 
cloud based on the correlation of points in the photos. 

Raster Select all required raster formats: 

▪ Orthophoto – A true-orthophoto that is created from the 
resulting textured mesh in GeoTiff format. 

https://www.skylinesoft.com/hubfs/KB_Resources/TED/Web%20Help/User%20Guide/index.htm#t=Exporting_3D_Mesh_Layers_to_Other_Formats.htm
https://github.com/Esri/i3s-spec/blob/master/i3s_converter/i3s_converter_ReadMe.md
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▪ Resolution – The raster resolution in meters per pixel. 
Select Auto to have PhotoMesh automatically select 
the optimal resolution based on the inputted data. 

▪ Image Quality – Select the check box to compress 
the orthophoto output, and then enter a JPEG 
compression level (0-100%). Select 99% to apply an 
LZW lossless compression. 

▪ Tile Size – Set the maximum tile size in pixels. For 
orthophotos with RGB bands being processed on 
fuser computers with about 16 GB RAM, tile size 
should not exceed 50,000 pixels.  
The required RAM in bytes for processing can be 
roughly calculated as follows: Tile size (in pixels) * 
Number of bands. E.g., generation of an RGB 
orthophoto with tile size of 50,000 pixels will use about 
7.5 GB (50,000*50,000*3= 7,500,000,000 = about 7.2 
GB). Generating this orthophoto on fuser computers 
with about 16 GB RAM, as recommended above, 
leaves sufficient RAM for other usages. 

▪ Overlap Between Tiles – Overlap in pixels between 
tiles. 

▪ Texture Blending – Determines whether to use data 
blended from multiple photos in texturing the 
orthophoto, or only data from the optimal 
photo.  Select Auto to base this setting on Photo 
Priority, where “Nadir Direction” will set blending to 
No, and “Used in Reconstruction” will set blending to 
Yes. Select No if blending results in ghosting artifacts. 

▪ Photo Priority – Determines what type of photo is 
preferred when selecting the optimal photo for 
texturing the orthophoto. Select “Nadir Direction” to 
give priority to photos photographed from above. This 
option is recommended to avoid objects such as trees 
being textured from multiple photos photographed 
from different directions. Select “Used in 
Reconstruction” to give priority to the photo used to 
reconstruct the mesh for this area. This option is 
recommended when there are moving objects in the 
photos, to avoid having parts of objects appear in 
different areas of the orthophoto. 

▪ No-Data Color – Determines the color to assign to 
areas of the orthophoto for which there is no data or 
which are outside the reconstruction area. 

▪ Bands and Collections – Click the More Options 

 button to select the bands to include in the 
orthophoto, and the collections to include in 
generating the orthophoto. See “Setting the 
Collections and Bands to Include in the Build Outputs” 
in this chapter for information.  

▪ Tile Grid Origin – Set the X and Y coordinates of the 
origin of the tile grid in the output coordinate system. 
This allows you to set a common grid for multiple 
projects. Select Auto to have PhotoMesh 
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automatically select the optimal grid origin based on 
the inputted data. 

▪ DSM (Digital Surface Model) – An elevation model in 
GeoTiff format that includes all elevation data, including 
buildings and reconstructed objects in the mesh. 

▪ Resolution – The raster resolution in meters per pixel. 
Select Auto to have PhotoMesh automatically select 
the optimal resolution based on the inputted data. 

▪ Tile Size – Set the maximum tile size in pixels. For 
DSM being processed on fuser computers with about 
16 GB RAM, tile size should not exceed 45,000 pixels.  
The required RAM in bytes for processing can be 
roughly calculated as follows: Tile size (in pixels) * 
Number of bands. E.g., generation of a DSM with tile 
size of 45,000 pixels will use about 7.7 GB 
(45,000*45,000*4= 8,100,000,000 = about 7.7 GB). 
Generating this DSM on fuser computers with about 
16 GB RAM, as recommended above, leaves 
sufficient RAM for other usages. 

▪ Overlap Between Tiles – Overlap in pixels between 

tiles. 

▪ Tile Grid Origin – Set the X and Y coordinates of the 
origin of the tile grid in the output coordinate system. 
This allows you to set a common grid for several 
projects. Select Auto to have PhotoMesh 
automatically select the optimal grid origin based on 
the inputted data. 

▪ DTM/DEM (Digital Terrain Model /Digital Elevation Model) 
– An elevation model that represents the bare ground 
surface without any objects such as plants and buildings.  

▪ Resolution – The raster resolution in meters per pixel. 
Select Auto to have PhotoMesh automatically select 
the optimal resolution based on the inputted data. 

 To save your building parameters as a Build Preset, click Save as Preset (see “Creating a New 

Preset” in this chapter) or click Build to begin the build (see “Setting Build Parameters and 

Processing the Build” in this chapter). 

Selecting the Collections and Bands to Include in the Build Outputs  

You can select the collections to include when generating the mesh model texture, orthophoto, or point 

cloud, as well as the bands to include in the orthophoto and to assign to each RGB of the mesh model 

texture. See “Setting Reconstruction Parameters” and “Setting Output Formats” in the “Building” chapter 

for more information.  

To select the collections:  

 On the Collections tab, select the collections that you want to include for the particular output. 

 Click OK. 
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To select the bands:  

 On the Bands tab, from the Bands Available section, select a required band, and click Insert  to 

insert it in the Bands Used section. Insert the bands in the required order. If you want to remove a 

band from the Bands Used section, select the band, and click Remove .   

Note: When selecting bands for mesh texture generation, three bands are required. 

 Click OK. 

 

Selecting the Textured Model Collections and Bands 

Setting a DAE/OBJ/OSGB Model Pivot 

Setting the pivot for a DAE/OBJ/OSGB model improves the stability of its display in 3rd party viewers that 

are limited regarding display of large coordinates. A DAE/OBJ/OSGB model’s pivot can be set to the 

project’s center or set to custom coordinates.  
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To set a DAE/OBJ/OSGB model’s pivot: 

 In the Build Parameters dialog box, on the Output tab, in the 3D Mesh section, select Center Pivot 

to Project. 

 If you want to set a custom pivot, click More Options . The Pivot Coordinates dialog box is 

displayed. 

 

Pivot Coordinates Dialog Box 

 If you want to set the pivot to the center of the project, select the check box. 

 If you want to set a custom pivot, enter its coordinates. 

 Click OK. 

Applying Gigapixel Credits  

PhotoMesh Gigapixel (GX) is a licensing mechanism that allows you to apply gigapixel credits towards 

the building of your PhotoMesh projects based on the number of gigapixels in each project. Within a 

single project, multiple build versions in all output types can be created using the same gigapixel credits. 

This mechanism can be implemented by pre-purchasing a bank of gigapixel credits, loading them to your 

local Skyline Floating License Server (SFLS), and then applying them to project photos when building a 

project. You can also send a request to Skyline, using an online form or request file, for gigapixel credits 

to apply to photos in a project.  

If you have a PhotoMesh GX license (see “PhotoMesh License Options” in the Getting Started chapter for 

information), PhotoMesh automatically launches the Apply Gigapixel Credit (GPC) dialog box when 

starting a build process. From this dialog, you can apply the required gigapixel credits to the project’s 

photos, as well as access the License Server (SFLS) to load additional gigapixel credits, if required. 

PhotoMesh calculates the number of gigapixels in the project based on the number of gigapixels in the 

selected AT area. When rebuilding a project that gigapixel credits were already applied to, additional 

credits are only required for photos that were added or if the AT area was expanded to include additional 

photos.  

If you don’t want to apply gigapixel credits to a build, you can instead generate a build with a watermark, 

in only 3DML format. You can later apply gigapixel credits and rebuild without a watermark in any output 

format. 
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Apply Gigapixel Credit Dialog Box 

To apply gigapixel credits: 

 Review the following settings in the Apply Gigapixel Credit (GPC) dialog box: 

Setting Description 

Project Name Name of project. 

Number of Photos in AT Number of photos in the AT area. 

Total Gigapixels in AT Total number of gigapixels in the photos that intersect with the 
AT area.  

GP Credits Already Applied to 
Project 

Number of gigapixel credits already applied to photos in this 
project. Additional credits are only required if photos were 
added to the project or if the AT area was expanded to include 
additional photos. 

GP Credits Required Number of gigapixel credits required to build the project. If 
gigapixel credits were already applied to photos in this project, 
additional credits are only required for photos that were added 
or if the AT area was expanded to include additional photos. 
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 If you want to apply gigapixel credits from the available credits on your Skyline Floating License 

Server (SFLS), to photos in this project, select From Server (SFLS). Then enter the following: 

License Server (SFLS) URL to your Skyline Floating License Server. 

Available GP Credits on 
Server  

Number of gigapixel credits in your server (SFLS) balance, 
that could be applied towards building this project.  

 If you want to send a request to Skyline, using an online form or request file, for gigapixel credits to 

apply to photos in this project, select Send Request. Your request includes a key that includes 

information about the total number of gigapixels in your AT. The following additional fields are 

displayed: 

Company Name Name of company. 

Contact Person Name of contact person in company. 

Email Address Email address. 

Phone Number Phone number. 

Country Location of company. 

GP Credits Request Key A key that includes information about the total number of 
gigapixels in your AT, which is used to request gigapixel 
credits from Skyline. This key is automatically passed to 
Skyline when you use the Save Request File or Fill Online 
Form. The build key is a unique key generated automatically 
based on the current build, and does not contain private data, 
project coordinates, or client or computer information of any 
sort. 

 If you want to submit your request offline, click Save Request File, enter the contact information in 

the fields that are displayed, and send it to Licensing@SkylineGlobe.com. After you receive your build 

license code from Skyline, enter the code in the GP Credits License Key field. 

 If you want to submit your request online, click Fill Online Form, and enter the required contact 

information in the online form that is displayed. After you receive your build license code from Skyline, 

enter the code in the GP Credits License Key field. 

 Click Apply GP Credits. If you don’t want to apply gigapixel credits currently, click Continue to 

Watermark. The build is generated with a watermark, and restricted to only 3DML format. You can 

later apply gigapixel credits and rebuild without a watermark in any output format. 

Working with Presets 

Build parameter presets make it easy to automatically set the required parameters to generate the 

optimum output for the project’s data as well as to share user-defined build settings between projects. 

New presets can easily be created by saving your build settings to a preset file. You have the flexibility to 

save all settings to the preset, or only selected ones. Presets only include changes from the default 

settings. This allows multiple presets to be selected for a build, each of which defines settings for a 

different subset of the build steps. If selected preset files have conflicting properties or flags, the value 

from the last file on the list is applied. Presets are managed (e.g., loaded, deleted, edited, and set as the 

default) from the Preset Manager. 

mailto:Licensing@SkylineGlobe.com
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Selecting Presets 

To select presets for your build: 

 On the Home tab, in the Build group, click Build. The Build Parameters dialog box is displayed.  

 Click Select and Manage Presets. The Preset Manager is displayed.  

 

Preset Manager 

 On the Select Presets tab, on the left side of the Preset Manager is a list of available presets. Select 

one or more presets from this list, and click Add . If you want to change the selected preset(s), 

use the Remove  icon to remove a preset from the Selected Presets side. If selected preset files 

have conflicting properties or flags, the value from the last file on the list is applied. The selected 

Presets side also includes "Custom changes" with all custom changes that were made to AT, 

reconstruction, and output settings. The selected presets and custom changes are listed in the Preset 

section of the Build Parameters dialog box. 

Note: The Last Build Parameters preset includes all the Build settings from the last build.  

Note: The PhotoMesh Default preset is designed to provide optimal results for the majority of 

projects. 
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 If you want to set your selections as the default presets for new projects, click Set Selection as 

Default.  

 If you want to clear your selections and restore the last saved default, click Reset to Default. 

 Click OK.  

Loading a Preset from File 

To load a preset from file: 

 In the Steps tab of the Build Parameters dialog box, click Select and Manage Presets. The Preset 

Manager dialog box is displayed. 

Note: The Preset Manager can also be opened from the PhotoMesh Options dialog box. See 

"Setting PhotoMesh Options" in the "Basic Concepts" chapter for more information.  

 

 

Preset Manager  

 On the Manage Presets tab, click Load Preset File. The Load Preset from File dialog box is 

displayed. 

 Browse to the required file, and click Open.  

Creating a New Preset 

A new preset can be easily created by saving your build settings to a preset file. You can save all your 

build settings, or only the settings from specific build steps. Only changes to the default settings are 

saved.  
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To create a new preset: 

 Set the build parameters as required. See “Setting Build Parameters and Processing the Build” in this 

chapter for information. 

 On the Output tab, click Save as Preset. The Save Preset dialog box is displayed. 

 

Save Preset Dialog Box 

 Type a Preset Name for the preset and a free text Description. 

 Select the check boxes of the build steps whose settings you want to save in your preset file.  

 Click Save. 

Deleting Presets 

To delete a preset file: 

 In the Steps tab of the Build Parameters dialog box, click Select and Manage Presets. The Preset 

Manager dialog box is displayed. 
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Preset Manager  

 On the Manage Presets tab, select the required preset from the list, and click Delete Preset. 

Note: Built-in presets cannot be deleted. 

 Click OK. 

Editing Presets 

To edit a preset file: 

 In the Steps tab of the Build Parameters dialog box, click Select and Manage Presets. The Preset 

Manager dialog box is displayed. 



   

 207 

PhotoMesh User Guide 

 

Preset Manager  

 On the Manage Presets tab, select the file you want to edit from the list, and click Edit. The preset 

XML file is opened in a text editor 

Note: Built-in presets cannot be edited. 

 Edit the file in the text editor, and save your changes. 

 In the Preset Manager dialog box, click OK. 

Monitoring a Build 

PhotoMesh Build Manager has two sections for monitoring the current build: 

▪ The upper monitoring section of PhotoMesh Build Manager displays information for each fuser, 

including status, its currently running step, and its progress for that step. 

▪ The lower monitoring section of PhotoMesh Build Manager displays information for each 

aerotriangulation and reconstruction tile, including currently running step, last step, progress, and 

currently running fusers. 

To monitor the build: 

 In the upper monitoring section of PhotoMesh Build Manager, from the Filter drop-down list, select 

one of the following: 

▪ All – To view all fuser information 

▪ Selected – To view only information related to selected fusers.  

 The following data is available in the upper monitoring section for each of the available fusers: 
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Field Description 

Fuser Fuser name. 

Running Step Step that the fuser is currently processing. 

Step Elapsed Time Time that has elapsed since the currently processing step was 
started. 

Progress Percentage of currently running step that has been completed. 

Status Fuser status:  

▪ Online – Working – Online and processing 

▪ Online – Waiting – Online but not currently processing 

▪ Offline – Will be used when online – Fuser was either 
disabled or closed. 

 In the lower monitoring section of PhotoMesh Build Manager, from the Filter drop-down list, select 

one of the following: 

▪ All – to view all task information. 

▪ Errors – to view only information related to task errors.  

 The following data is available in the lower monitoring section: 

Field Description 

Task All project tasks including a list of AT and reconstruction tiles. 

Last Step The previous step that was performed  

Running Step Step that the fuser is currently processing. 

Status Description Information about the build status. 

Progress Percentage of currently running step that has been completed. 

Fusers Fuser that is currently processing this task. 
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PhotoMesh Build Manager – Monitoring a Build 

 If you want to view a build report, click Build Report. See “Viewing a Tile’s Build Report”, and 

“Viewing an Aerotriangulation Tile’s Detailed Report”  in the “Reviewing Your Build” chapter. 

 If you want to view build settings (read-only), click Show Settings. 

 When the build process is complete, the Build Finished dialog box is displayed. 
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Build Finished Dialog Box 

 If you want to open the output folder, select the link in the Output Folder field, and open it in your 

browser.  

Note: The output folder can also be opened at any time from the Project Tree’s shortcut menu. 

See “Outputs Menu” in “Using the Project Tree and Item List” chapter for more information. 

 If a 3DML was created in this build, and you want to show it in the 3D Window, click Show 3DML.  

Note: The 3DML’s display can also be turned on or off by clicking its entry’s show/hide icon in the 

Project Tree. 

 If you want to view a build report, click View Report.  

Canceling a Build 

To cancel a build: 

▪ On the bottom right of PhotoMesh Build Manager, click Cancel. 

Resuming a Build 

A PhotoMesh build process can be resumed in any of the following cases: 

▪ The initial build process was canceled by the operator in the middle. 

▪ Unexpected hardware or software failure occurred during the build causing the build to stop 

To resume a build: 

Note: You can only resume a build when you are in Review mode for that build.  

 If you are not in Review mode, on the Home tab, in the Review group, click Review Mode. 

 On the Home tab, in the Build group, click the arrow under Build and select Resume Build. 

Note: If you want to create an entirely new build, see “Creating a New Build” in this chapter for 

information. 

Opening Build Output in TerraExplorer 

Many outputs can be opened in TerraExplorer after the build is complete. The supported outputs include: 

3DML, AT Calculated Photos, AT Tiles, DSM, DTM, and Orthophoto. These outputs are added to the 

Project Tree when a build is finished. 
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To open in TerraExplorer: 

▪ Right-click the output folder in the Project Tree, and select Open with TerraExplorer. A FLY file 

opens in TerraExplorer with the 3DML, AT Calculated Photos, AT Tiles, DSM, DTM, and Orthophoto 

outputs, if they were generated in the PhotoMesh project. 

Note: The Project Tree’s shortcut menu also provides an option to access to any of the project’s 

outputs by opening the location of the project’s output folder. 

Exporting DSM Output to LAS/LAZ 

DSM output can be exported to LAS/LAZ format. 

To export DSM output to LAS/LAZ: 

 Right-click the DSM output in the Project Tree, and select Export to LAS/Export to LAZ. The Select 

LAS/LAZ dialog is displayed. 

 Browse to the output folder, and click Select Folder. 

Rebuilding  

If a previously built project requires modification, instead of building the entire project again from the first 

step of the build process, you have the option to run the build again, incorporating some of a previous 

build’s results. Rebuilding provides flexibility both with regard to the project section (entire project, only 

error tiles or selected tiles) and project steps that are to be performed. Alternative build parameters can 

also be set. PhotoMesh will automatically determine what processing is required to apply the changes to 

the project, by rebuilding the project from “Auto”. E.g., when rebuilding a project after modifying a water 

polygon, only affected tiles are rebuilt from the point cloud step. Similarly, when rebuilding after 

reimporting exported models, only affected tiles are rebuilt, either from the texturing step, if just models 

were imported, or from the output step, if both models and textures were imported. 

Note: If you want to create an entirely new build, see “Creating a New Build Version” in this chapter for 

information. 

To rebuild: 

 On the Home tab, in the Build group, click the arrow next to Build, and select the required option: 

▪ Build  

▪ Build and Rerun Failed Tasks – Continue the build process including rerunning of any build failed 

task. Tiles with insufficient photo coverage for reconstruction are not rebuilt. To rebuild these tiles, 

select the Rebuild Selected Tiles option, and perform all build steps (i.e., select Complete 

Project). 

▪ Rebuild Selected Tiles – Rebuild only the tiles that are currently selected. 

The Build Parameters dialog box is displayed. 

 Select the project steps and enter the required parameters. See “Setting Build Parameters and 

Processing the Build” in this chapter for information.  

Note: It is generally recommended to select Auto for the Start From step. In this case, 

PhotoMesh will automatically determine what processing must be performed to complete 

the project. 

Note: Some of the parameters will only apply if tiles need to be recreated. 

Note: Output fields are not available when rebuilding error tiles. 
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 PhotoMesh Build Manager then opens. Select the required fusers, and then click Build. See “Using 

Fusers” in the “Fusers” chapter for more information.  

Note: The expected production times for a 9 gigapixel project (0.06 km2 and 3 cm GSD) on an i7 

10th generation, 8 core CPU, with 16 GB RAM, and a local SSD drive are as follows:  

• Approximately 20 minutes for photo preparation (207 photos) 

• 2 minutes for a single AT tile 

• 7 hours and 30 minutes for the reconstruction tiles 

The total machine time adds up to 7 hours and 55 minutes (approximately 52 minutes per gigapixel). 

Creating a New Build Version 

You can create a new build version with different project steps and different build parameters.  

Note: If you want to create a completely new build version with a copy of the AT information from the 

current build, see “Creating a New Build with a Copy of the Current Aerotriangulation Results” in 

this chapter. 

To create a new build version: 

 On the Home tab, in the Build group, click the arrow next to New Version, and select New Build 

Version. The Build Parameters dialog box is displayed.  

 Select the project steps and then enter the required parameters. See “Setting Build Parameters and 

Processing the Build” in this chapter for information. The New build description dialog box is 

displayed with a consecutive build number, e.g. “Build_2”, “Build_3” etc. 

 Type a new build description, and click OK. PhotoMesh Build Manager then opens. Select the 

required fusers, and then click Build. See “Using Fusers” in the “Fusers” chapter for more 

information. 

Creating a New Build Version with a Copy of the Current Aerotriangulation 

Results 

When no AT parameters were changed from a previous build, you can create a new build version with 

different build parameters (e.g. reconstruction tile size) but with a copy of the AT information from the 

current build, thereby significantly accelerating the build process.  

Note: If you want to create a completely new build version without copying the AT information from the 

current build, see “Creating a New Build Version” in this chapter. 

To create a new build version with a copy of the AT: 

 On the Home tab, in the Build group, click the arrow next to New Version, and select New Build 

Version – Copy AT. The Start From field is automatically set to Auto to automatically select the steps 

that were not yet completed, and is read-only. 

 In the Build Until field, select the step until which you want to build. 

 Click Next and then enter the required parameters, and click OK. See “Setting Build Parameters and 

Processing the Build” in this chapter for information.  

Note: Some of the parameters will only apply if tiles need to be recreated. 

Note: Output fields are not available when rebuilding error tiles. 

The New build description dialog box is displayed. 
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 Type a new build description, and click OK. PhotoMesh Build Manager then opens. Select the 

required fusers, and then click Build. See “Using Fusers” in the “Fusers” chapter for more 

information. 
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CHAPTER 17  REVIEWING YOUR BUILD 

About Reviewing Your Build 

Upon initiating a build, PhotoMesh automatically switches to Review mode, enabling an array of 

capabilities relating to the processed data. These include: 

▪ Viewing all processed build data in the 3D Window, e.g. AT and reconstruction tiles, calculated 

camera positions, and point cloud, 3D model, and texture data. 

▪ Reading build and AT reports containing statistical and graphical information about the build process. 

▪ Exporting/importing tiles for manual retouching. 

▪ Rerunning the build (for the entire project or for selected tiles) with different parameters. 

As soon as a build step is completed for a tile, its build data becomes immediately available and 

viewable, e.g. if aerotriangulation was performed, PhotoMesh can display the calculated camera positions 

in the 3D Window, and if reconstruction tiles were calculated, they can be displayed in the 3D Window, 

with each tile colorized according to the build step completed. 

In addition to these capabilities which are specific to Review mode, you can also perform in Review mode 

nearly all operations that were available in preparing for the build, e.g. add or edit control points, water 

polygons, and reconstruction polygons, add terrain objects and layers and perform measurements. The 

only operations that cannot be performed in Review mode involve changes to the project’s photos 

(addition, exclusion, or deletion) or modifications to the AT area. 

Turning on Review Mode 

To turn on review mode: 

▪ On the Home tab, in the Review group, click Review Mode.  

Note: Review mode is activated automatically after a build was performed.  

Clearing Review Data from Terrain 

To clear review data: 

▪ On the Home tab, in the Review group, click Clean Review Data. This clears any point clouds, 

models, or textured models displayed on terrain or photo projection on the terrain. 

Reviewing Aerotriangulation (AT) and Reconstruction Tiles 

Upon completion of aerotriangulation or any of the build steps, the aerotriangulation/reconstruction tiles 

can be previewed in the 3D Window, with the tiles colorized according to their processing status. 

Additional tile information (tile camera positions and build data) can be viewed from the Tile tab. 

The sections that follow describe the activities that can be performed to evaluate the 

aerotriangulation/reconstruction tile results: 

▪ View aerotriangulation tiles 

▪ View reconstruction tiles 

▪ Navigate to a tile 
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▪ Display original camera positions for tiles 

▪ Display calculated camera positions for tiles 

▪ View an aerotriangulation tile’s sparse point cloud 

▪ Display reconstruction tile results 

▪ View and set tile status 

▪ Display user status flags 

▪ Set a reconstruction tile's selection style 

▪ View a tile’s build report 

▪ View an aerotriangulation tile’s detailed report 

▪ Export tiles 

▪ Import tiles 

Viewing Aerotriangulation (AT) Tiles 

To view aerotriangulation tiles: 

Note: This information is also available in the AT Tiles list. See “Selecting Tiles" and "Viewing Tile 

Information in the Tile List" in this chapter for information.  

 On the Home tab, in the Tiles group, click AT Tiles. The aerotriangulation tiles are colorized 

according to their aerotriangulation status: 

▪ White tile – Unprocessed 

▪ Purple tile – Aerotriangulation completed 

▪ Yellow tile – Aerotriangulation merged 

▪ Orange border – Aerotriangulation failed (retrying) 

▪ Red border – Aerotriangulation failed 

▪ Blue border - <80% Success 

Note: In the AT Tiles legend, the colored squares (e.g. ) indicate colored tiles, while the 

colored lines (e.g. ) indicate a colored border. 

 If you hover anywhere on the tile, the tile's name and number of photos in the tile are displayed at the 

top left corner of the 3D Window.  

 In the 3D Window, click the tile you want to review, or select the tile in the Tiles List. The Tile tab is 

displayed from which you can navigate to the tile, display its original and calculated camera positions 

and sparse point cloud, and view build reports. See “Navigating to a Tile”, “Displaying Original 

Camera Positions for Tiles”, “Displaying Calculated Camera Positions for Tiles”, “Viewing an 

Aerotriangulation Tile’s Sparse Point Cloud” and “Viewing a Tile’s Build Report” in this chapter for 

information.  

Viewing Reconstruction Tiles 

To view the reconstruction tiles: 

Note: This information is also available in the Reconstruction Tiles list. See “Selecting Tiles" and 

"Viewing Tile Information in the Tile List" in this chapter for information.  



 

216 

PhotoMesh User Guide 

 On the Home tab, in the Tiles group, click Reconstruction Tiles. The reconstruction tiles are 

colorized according to the last build processing step completed for the tile.  

▪ Yellow tile – Aerotriangulation is complete. 

▪ Pink tile – All steps through point cloud creation are complete. 

▪ Dark Blue tile – All steps through model creation are complete, 

▪ Light Blue tile – All steps through model texturing are complete. 

▪ Green tile – All steps through project output are complete.  

▪ Orange border – An error occurred in the processing step that follows the last successfully 

completed step and a retry mechanism will be applied soon (e.g., if a dark blue colored tile has an 

orange border, this indicates that the 3D model creation step completed successfully but that 

model texturing failed and will be retried).  

▪ Red border – Tile failed. 

▪ Dark Red border – Insufficient photo coverage for reconstruction. 

Note: In the Reconstruction Tiles legend, the colored squares (e.g. ) indicate colored tiles, 

while the colored lines (e.g. ) indicate a colored border. 

 

Reconstruction Tiles 

 If you hover anywhere on the tile, the tile's name and number of photos in the tile are displayed at the 

top left corner of the 3D Window.  

 In the 3D Window, click the tile you want to preview, or select the tile in the Reconstruction Tiles 

list. The Tile tab is displayed from which you can navigate to the tile, display its original and 

calculated camera positions and reconstruction tile results, view build reports, and export and import 

the tile’s model. See “Navigating to a Tile”, “Displaying Original Camera Positions for Tiles”, 

“Displaying Calculated Camera Positions for Tiles”, “Displaying Reconstruction Tile Results”, and 

“Viewing a Tile’s Build Report” in this chapter and the “Importing and Exporting Models” chapter for 

information. 
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Selecting Tiles 

Tiles can be selected either in the 3D Window or from the AT or Reconstruction Tile Lists to perform 

various commands on them, e.g., jump to tile, show calculated information, or show AT or reconstruction 

tile results.  

 

Reconstruction Tiles List 

To select tiles: 

 In the 3D Window, click the tile you want to select, or select the tile(s) in the Reconstruction Tiles 

list. You can multi-select tiles using the Tile List commands. See "Selecting Items Using the Item List" 

in the "Using the Project Tree and Item List" chapter and "Selecting Objects in the 3D Window" in the 

"Basic Concepts" chapter for more information.  

 If you want to save your selection, right-click in the Reconstruction Tiles list, and select Save 

Selection.  

 To clear your selection, right-click, and select Clear Selection.  

 To load a tile's .select file with selection information, right-click, and select Load Selection. See "Tile 

Menu" in the "Using the Project Tree and Item List" chapter for more information. 

 

Viewing Tile Information in the Tile List 

The AT and reconstruction tiles lists provide information about each tile, including: photo count, build 

processing status, and error status. See "Selecting Items Using the Item List" in the "Using the Project 

Tree and Item List" chapter for more information.  

 

To view tile information: 

▪ In the Project Tree, select the AT Tiles or Reconstruction Tiles group. The tile list displays all the 

tiles in the selected group, and the following information:  

Property Description 

Selection Select the check box to select the tile in the 3D Window. You can 
select multiple tiles to perform actions on multiple tiles.  
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Name Name of the tile (Read-only). 

Photo Count Number of photos in the tile (Read -only). 

Photo Calculated Number of photos in AT tile for which PhotoMesh successfully 
calculated camera position (only AT) (Read -only). 

Calculated % Percentage of photos in AT tile for which position information was 
calculated: Photos Calculated/Photo Count (only AT) (Read -
only). 

Build Status For AT tiles: 

▪ Unprocessed  

▪ AT completed  

▪ AT merged  

For reconstruction tiles: 

▪ AT complete  

▪ All steps through point cloud creation are complete  

▪ All steps through model creation are complete  

▪ All steps through model texturing are complete  

▪ All steps through project output are complete  

(Read -only) 

Note: The tiles in the 3D Window are also colorized based on 
build status. See “Viewing Aerotriangulation (AT) Tiles” 
and “Viewing Reconstruction Tiles” in this chapter for 
information. 

Error Status Indicates if there was an error in creating the tile: Failed, Failed 
(retrying), No coverage (only reconstruction) or <80% success 
(only AT) (Read -only). 

User Status Click the drop-down arrow, and select the applicable status, 
indicating what actions still need to be performed on the tile, e.g., 
rebuild, editing or external retouch. You can also set the user 
status from the Tile tab > User Status. User status flags can be 
displayed in the 3D Window on each of the tiles to indicate at a 
glance the current status of each tile. See “Setting and Displaying 
User Status Flags and Legend” in this chapter for information.  

You can customize the name and color associated with each user 
status in the Options menu. See “Setting PhotoMesh Options” in 
the “Basic Concepts” chapter for more information.  

▪ For AT Tiles: OK, Requires Rebuild, Requires Tie/Control 
Points. 

▪ For Reconstruction Tiles: OK, Requires Rebuild, Requires 
Editing, Requires External Retouch. 

Note: User status can also be set from the Tiles tab (Tiles tab > 
User Status).  
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Comments Free text field where you can add any applicable information 
about the tile. You can add comments from the Tile tab > User 
Status. 

Navigating to a Tile 

To fly or jump to a tile:  

 In the 3D Window, click the tile you want to select, or select the tile(s) in the tile list. See "Selecting 

Items Using the Item List" in the "Using the Project Tree and Item List" chapter and "Selecting Objects 

in the 3D Window" in the "Basic Concepts" chapter for more information.  

Note: If multiple tiles are selected, navigation is to the last selected tile. 

 On the Tile tab, in the View group, click Fly to Tile/ Jump To Tile. 

Displaying Original Camera Positions for Tiles 

After the aerotriangulation step has begun, you can display photos’ original camera positions. 

To display photos in the original camera positions defined in the project: 

 In the 3D Window, click the required tile, or select the tile(s) in the AT Tiles list. See "Selecting Items 

Using the Item List" in the "Using the Project Tree and Item List" chapter and "Selecting Objects in the 

3D Window" in the "Basic Concepts" chapter for more information. The Tile tab is displayed. 

  On the Tile tab, in the Original Photos group, toggle on Original.   

 On the Tile tab, in the Original Photos group, in the Color Code drop-down, select one of the 

following options for color coding of the photos’ camera symbols: 

▪ Status – Camera symbols are color coded based on photo status (calculated/ not calculated).  

▪ Collection – Camera symbols are color coded according to collection, with a random color 

assigned to each collection’s camera symbol. 

Note: These settings can also be accessed from the View tab. 

Displaying Calculated Camera Positions for Tiles 

Calculated camera positions for photos can only be displayed after the aerotriangulation step is complete.  

Note: When calculated camera positions are displayed, you can also view calculated property 

information in the Photos list. See “Calculated Camera Position Properties” in the “Photo 

Management” chapter for information.   

To display photos in the camera positions calculated through aerotriangulation: 

 In the 3D Window, click the required tile, or select the tile(s) in the AT Tiles list. See "Selecting Items 

Using the Item List" in the "Using the Project Tree and Item List" chapter and "Selecting Objects in the 

3D Window" in the "Basic Concepts" chapter for more information. The Tile tab is displayed. 

 On the Tile tab, in the Calculated Photos group, toggle on Calculated. In the 3D Window, the 

photos are displayed in the camera positions calculated through aerotriangulation, and calculated 

positioning information is included in the Photos list. See “Photos List” in the “Photo Management” 

chapter for information. 

 On the Tile tab, in the Calculated Photos group, in the Color Code drop-down, select one of the 

following options for color coding of the photos’ camera symbols in the 3D Window:   

▪ Status – Camera symbols are color coded based on status (calculated/ not calculated).  

▪ Collection – Camera symbols are color coded according to collection, with a random color 

assigned to each collection’s camera symbol. 
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▪ Median Error – Camera symbols are color coded according to median error (px):  

▪ Green: px < 0.5 

▪ Orange: 0.5 < px < 1 

▪ Purple: px > 1 

▪ Reconstruction Group – Camera symbols are color coded according to reconstruction group 

(i.e., photo blocks created in the AT process), with a random color assigned to each 

reconstruction group’s camera symbol. This information is significant in identifying the largest 

group (i.e., the group PhotoMesh will perform reconstruction on) and determining which additional 

photos can be connected to this group using tie points and other methods, for optimal output. 

▪ Number of Matches - Camera symbols are color coded according to the number of photo 

matches: 

▪ Red: matches <= 2 

▪ Orange: 2< matches <= 4 

▪ Green: matches > 4 

Viewing an Aerotriangulation Tile’s Sparse Point Cloud 

A sparse point cloud is a representation of all photo features that were automatically found in two or more 

project photos, with their computed positions.  

 

To view an AT tile’s sparse point cloud: 

 In the 3D Window, click the required tile, or select the tile(s) in the AT Tiles  list. You can multi-select 

tiles using the tile list commands. See "Selecting Items Using the Item List" in the "Using the Project 

Tree and Item List" chapter and "Selecting Objects in the 3D Window" in the "Basic Concepts" 

chapter for more information. The Tile tab is displayed.  

 On the Tile tab, in the Sparse Point Cloud group, click Show Point Cloud.  

Note: The sparse point cloud may take some time to display the first time it is shown or after 

making changes to the project.  

 Select the Point Size in pixels. 

 Select the color coding option for classifying the point cloud’s points: 

▪ Single color – A single color is used for all points.  

▪ Num. tied photos – Points are color coded according to the number of photos in which this point 

was found. 

▪ Orange – Two matches 

▪ Green – Three or more matches  

Displaying Reconstruction Tile Results 

To display point cloud, 3D model, or texture results for a tile: 

 In the 3D Window, click the required reconstruction tile, or select the tile(s) in the Reconstruction 

Tiles list. You can multi-select tiles using the tile list commands. See "Selecting Items Using the Item 

List" in the "Using the Project Tree and Item List" chapter and "Selecting Objects in the 3D Window" 

in the "Basic Concepts" chapter for more information. The Tile tab is displayed.  

 On the Tile tab, in the Show group, toggle on any of the following options: 

▪ Point Cloud  



   

 221 

PhotoMesh User Guide 

▪ Model – Shows only the mesh model  

▪ Textured Model 

▪ Orthophoto – If RGB color bands were selected for the orthophoto, they are displayed. Otherwise, 

only the first band is displayed in grayscale mode. See “Selecting the Collections and Bands to 

Include in the Build Outputs” in this chapter for information.  

Note: Each of these options is enabled only if the build step for this data was completed. 

Setting and Displaying User Status Flags and Legend 

You can set and display the user status of AT and reconstruction tiles. By default the user status options 

are used to indicate what actions still need to be performed on the tile, e.g., rebuild, editing or external 

retouch, but they can be customized as required from the Options menu. After setting user status, flags 

can be displayed in the 3D Window on each of the tiles to indicate at a glance the current status of each 

tile. 

To set and display user status flags: 

 In the 3D Window, click the required tile, or select the tile(s) in the Reconstruction Tiles or AT Tiles 

lists. You can multi-select tiles using the tile list commands. See "Selecting Items Using the Item List" 

in the "Using the Project Tree and Item List" chapter and "Selecting Objects in the 3D Window" in the 

"Basic Concepts" chapter for more information. The Tile tab is displayed. 

 On the Tile tab, in the User Status group, click the drop-down arrow and select the applicable status, 

indicating what actions still need to be performed on the tile, e.g., rebuild, editing or external retouch. 

See "Viewing Tile Information in the Tile List" in this chapter for more information.  

Note: You can customize the color and name associated with each user status in the Options 

menu. See “Setting PhotoMesh Options” in the “Basic Concepts” chapter for more 

information.  

 On the View tab, in the Reconstruction Tiles group, click the arrow under User Status Flags, and 

select Show User Status Flags. 

 If you want to show a user status legend that indicates what AT and reconstruction tile user status is 

associated with each color flag, on the same tab, click the arrow under User Status Flags, and select 

Show User Status Legend.  

  

User Status Legend 

Setting a Reconstruction Tile’s Display Style  

There are three options for the display style of selected reconstruction tiles: 

▪ 2D rectangle 

▪ 3D box 
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▪ 3D filled box 

To set the display style for selected reconstruction tiles: 

▪ On the View tab, in the Reconstruction Tiles group, click the arrow under Selection Style and select 

the style you want. If you want to display a frame around reconstruction tiles only when selecting a 

tile, and not when hovering over it, click the arrow under Selection Style and select Hide Tiles 

Hover. 

Viewing a Tile’s Build Report 

The Build report contains statistical and graphical information about the build process. The first section of 

the report displays summary information: 

▪ Basic project information including: project name, number of photos, and total input gigapixels.  

▪ Basic aerotriangulation information including: AT area, number of aerotriangulation tiles, calculated 

photos, and mean median error. The mean median error is the average of the median reprojection 

errors for all photos in the collection. 

▪ Basic ground control point and check point information  

▪ Basic reconstruction information including: output area, number of reconstruction tiles, and output 

coordinate system. 

▪ Performance information including: build and fuser time.  

This summary section is followed on each report tab by detailed information and graphs relating to the 

respective tab: 

▪ Aerotriangulation – Aerotriangulation details per photo collection (e.g. mean median error, focal 

length, and principal X/Y). See “Collection Property Sheet” in the “Photo Management” chapter for 

information about the properties displayed. Information is only displayed in this section if an 

aerotriangulation tile was selected. 

Note: If a report is generated while aerotriangulation is in progress, a message is displayed in the 

aerotriangulation section that the aerotriangulation is not yet complete. 

▪ (Build Process) Steps – Details about each build step: steps involved, tiles produced, processing 

time, and active fusers. When a reconstruction tile is selected, details display about the tile building 

steps (point cloud, model, texturing). When an aerotriangulation tile is selected, details display about 

the aerotriangulation. 

▪ Fusers – Statistics for each fuser regarding processing time for each build step and each tile in each 

step. 

To view a build report: 

 Do any of the following:  

Note: The same build report opens in each of these options but with different filter values 

selected. 

▪ On the Home tab, in the Review group, click the arrow under Build Report, and click one of the 

options: AT Report, Steps Report, or Fusers Report. 

▪ Select a tile in the 3D Window or in the Tile List, and then on the Tile tab, in the View group, 

click Build Report. 
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▪ In PhotoMesh Build Manager, click the Build Report button.  

▪ In PhotoMesh Build Manager, right-click a fuser, and select Fuser build report. 

▪ In PhotoMesh Build Manager, right-click a tile, and select Tile build report. 

 At the top of the Build report, select a report type. This determines what detailed information and 

graphs display in the section following the summary section. 

▪ AT (Aerotriangulation)  

▪ Steps (Build) 

▪ Fusers  

 The detailed information and graph data can be filtered to display information only about tiles with 

warnings or errors or about specific build process steps, fusers, or aerotriangulation tiles. Click Filter 

and, select one of the following: 

▪ All 

▪ With warnings 

▪ With errors 

▪ User selection 

 If you choose User selection, the Select dialog is displayed: 

a. Select the required step, fuser or AT tile (depending on the report type being viewed). Use CTRL 
and SHIFT to multi-select. Then click OK. 

b. If you want to change your selection, click Select to reopen the Select dialog. 

 

Select Dialog Box 
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 If you want to expand or collapse parts of the report to make it easier to find and view only the 

information you want, click Expand/Collapse All at the top of the report. 

 If you want to export the Build Report as an HTML file, at the top of the report, click Export. Then in 

the Export Build Report dialog box, browse to the required file location, and click Save. 

 If you want to print the report, at the top of the report, click Print. 

Viewing an Aerotriangulation Tile’s Detailed Report 

View information about each photo included in a selected aerotriangulation tile. 

To view detailed aerotriangulation information: 

 In the 3D Window, click the required aerotriangulation tile, or select the tile(s) in the AT Tiles list. See 

"Selecting Items Using the Item List" in the "Using the Project Tree and Item List" chapter and "Selecting 

Objects in the 3D Window" in the "Basic Concepts" chapter for more information. The Tile tab is 

displayed. See "Selecting Tiles" in this chapter for more information. 

 On the Tile tab, in the View group, click Detailed Report. The Aerotriangulation Detailed Report is 

displayed showing two tables: 

▪ Inputted and calculated aerotriangulation details per photo collection (e.g., mean median error, 

focal length, and principal X/Y). Note that this table displays the same information as in the tile’s 

build report for aerotriangulation, with the addition of input data for each property and principal 

point data.  

▪ Inputted and calculated positioning and orientation values for each of the photos (organized by 

collection) in the selected tile. 

 

Detailed Aerotriangulation Report 

 If you want to export the Detailed Report as a .txt file, click Export. Then in the Export 

Aerotriangulation Report dialog box, browse to the required file location, and click Save. 

Exporting Tiles 

Selected AT or reconstruction tiles with all their information (e.g., user status, comment, photo count) can 

be exported to an SQLite file, and then imported into TerraExplorer or standard geospatial applications. 

This allows you to easily share information about the project's data coverage. The exported tiles can also 

be reviewed in TerraExplorer or other geospatial applications, and user status and comments added, and 

then reimported to PhotoMesh. See "Importing Tiles" in this chapter for information. 

To export a tile: 

In the Project Tree, select the required AT Tiles or Reconstruction Tiles group. 
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In the AT Tiles list or Reconstruction Tiles list, select the required tile(s), right-click and select Export 

Selected Tiles. The Export Tiles dialog box is displayed. See "Selecting Tiles" in this chapter for more 

information. 

Browse to the required folder, and click Save. 

Importing Tiles 

After exported tiles were reviewed in TerraExplorer or other standard geospatial applications, and user 

status and comments were added, the tiles can be reimported to PhotoMesh. See "Exporting Tiles" in this 

chapter for information. 

To import a tile: 

In the Project Tree, select the required AT Tiles or Reconstruction Tiles group. 

In the AT Tiles list or Reconstruction Tiles list, right-click and select Import Tile Status. The Import Tile 

Status dialog box is displayed. 

Browse to the required folder, and click Open. 

Working with Water Body Polygons  

Water bodies are difficult to model accurately because it is hard to identify and match features due to the 

uniformity and non-static nature of water. In order to enable PhotoMesh to model and texture a water 

body successfully, you can define the required water body by drawing or importing a corresponding 

polygon. PhotoMesh uses this polygon to generate a flat surface over the user-defined water body, and 

automatically reconstruct any above-water elements – boats, piers, small islands without requiring special 

user markings. Water bodies can be either of the following: 

▪ Leveled – A constant water level (i.e., altitude) is set for all points in the water body polygon, to 

create level water bodies such as seas, lakes, ponds, and pools. This is especially useful for creating 

a level water body on top of a non-flat terrain or mesh, or for creating a flat water body based on an 

imported polygon with variable altitude values.  

▪ Non-Leveled (Sloped) – PhotoMesh segments the water body polygon into multiple flat 

reconstruction tiles, each of which has a different elevation value based on the average elevation 

within the specific tile. This option should be selected to create an elevation gradient for water bodies 

such as rivers, with non-uniform water levels.  

Imported polygon layers are each saved separately in the Project Tree, while new polygons that you 

manually create are saved into the “Water - Manually Created” group under the Retouch Layers group in 

the Project Tree. If you open a legacy project with water polygons, the water polygons are converted to 

the new feature layer format during the load. The project must then be saved to save the changes.  

Creating Water Body Polygons 

To create a water body polygon: 

 On the Home tab, in the Add group, click the arrow under Retouch, and select either of the following: 

▪ Create New Water Body 

▪ Create Leveled Water Body 

Note: You can also create a water polygon by selecting Draw Water Body Polygon  or 

Draw Leveled Polygon  in the Polygon list:  
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 With the cursor in the 3D Window, click to add the first point of the polygon. Click again to add 

additional points of the polygon until you have marked the entire shape. You must place at least three 

points to define the polygon. 

Note: It is sometimes easier to draw an accurate water polygon over a textured mesh model. 

After adding the model, rebuild, setting the Build Start From field to Auto, so that the 

required steps are automatically selected.  

Note: When creating a water body polygon, the lines of the polygon should not overlap each 

other.  

Note: It is recommended to keep the number of polygon points to the minimum required to define 

the shape. Adding unnecessary points may adversely affect performance. 

 Right-click to finish the polygon. The polygon name and water average elevation can be modified in 

the Water Polygon list. See “Water Polygon List” in this chapter for information. If you want to edit the 

polygon, see “Editing a Water Body Polygon’s Shape” and “Setting Water Body Polygon Properties” 

in this chapter for information.  

Importing Water Body Polygons 

To import a water polygon shapefile or KML layer: 

 On the Home tab, in the Add group, click the arrow under Retouch, and select Import Water Layer. 

The Import Water Body Polygon Layer dialog box is displayed. 

 Browse to the water polygon layer you want to import, and click Open. If you want to edit the 

polygons, see “Editing a Water Body Polygon’s Shape” and “Setting Water Body Polygon Properties” 

in this chapter for information.  

Exporting Water Body Polygons 

To export a water polygon layer to a shapefile: 

 Save the project, and then on the Home tab, in the Add group, click the arrow under Retouch, and 

select Export Water Layer.  The Export Water Body Polygons dialog box is displayed. 

 Browse to the folder in which to save the layer, type a File name, and click Save.  

Editing a Water Body Polygon 

Note: After modifying a water body polygon, all affected tiles (e.g., tiles that now are intersected by the 

polygon) require rebuilding from the point cloud step. PhotoMesh will automatically determine 

what processing is required following the water polygon change, by rebuilding the project from 

“Auto”.   

To move a water polygon or modify its shape: 

▪ In the Project Tree, select the required water polygon layer, and then in the Polygon List, select the 

required polygon, and click Edit Water Body . See "Editing Polylines and Polygons" in this 

chapter for information on editing polygons.  

Selecting Water Body Polygons 

Polygons can be selected from the Water Polygon list to perform various commands on them, e.g., jump 

to a polygon, level/unlevel, or set average elevation.  
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To select water body polygons: 

▪ In the 3D Window, click the polygon you want to select, or select the polygon in the Water Polygon 

list. You can multi-select tiles using the Water Polygon List commands. See "Selecting Objects in the 

3D Window" in the "Basic Concepts" chapter and  "Selecting Items Using the Item List" in the "Using 

the Project Tree and Item List" chapter for more information.  

Navigating to a Water Body Polygon 

To fly or jump to a water body polygon: 

 In the Project Tree, select the Water ( Manually Created) group or a Water (Imported) layer .  

 In the Polygon List, right-click the required polygon, and select Fly To/Jump To. 

Setting Water Body Polygon Properties 

Water body polygon data can be viewed and modified in the water polygon property sheet and Polygon 

List. In the Water Polygon List, you can set average elevation of the water polygons, as well as polygon 

visibility and inclusion in the project. See “About the Item List” in the “Using the Project Tree and Item List” 

chapter for information on working with the Water Polygon List. 

To display and modify water body polygon properties: 

 In the Project Tree, click the Water ( Manually Created) group or a Water (Imported) layer. 

 For group/layer properties: in the property sheet, modify the property value as required. See “Water 

Polygon Layer Property Sheet” in this chapter for more information. 

 For individual polygon properties: In the Water Polygon List, select the check boxes of the required 

polygons, and modify their properties as required. See “Water Polygon List” in this chapter for more 

information.  

Note: You can also search the list for the required polygons. See “Selecting Items Using the Item 

List” in the “Basic Concepts” chapter for information. 

Water Polygon Layer Property Sheet 

The properties in the water polygon layer property sheet apply to all polygons in the layer. 

Property Description 

Position 

Altitude Offset Altitude offset from the current altitude value applied to entire 
water body layer. 

Coordinate System Coordinate system of all the water polygons in the layer (Read-
only for manually created polygons). 

General 

Name  Name of the water body layer in the Project Tree. 

Excluded Select the check box to exclude the water body layer from the 
project. In the Project Tree, the layer is displayed in strikethrough 
font. 

Original Source Path Original source path from where the water body layer was 
imported (Read-only).  

Fill Color Fill color for all the water body polygons in the layer. 
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Leveled Select the check box to set a constant water level (i.e., altitude) 
for all points in all the water body polygons in the layer, to create 
level water bodies such as seas, lakes, ponds, and pools. This is 
especially useful for creating level water bodies on top of a non-
flat terrain or mesh, or for creating flat water bodies based on 
imported polygons with variable altitude values. If the check box 
is cleared, PhotoMesh segments the water body polygons into 
multiple flat reconstruction tiles, each of which has a different 
elevation value based on the average elevation within the 
specific tile. This option should be selected to create an elevation 
gradient for water bodies such as rivers, with non-uniform water 
levels. 

 

Water Polygon List 

In the Water Polygon list, you can view and set certain polygon properties, as well as set polygon 

visibility and inclusion in the project. See “About the Item List” in the “Using the Project Tree and Item List” 

chapter for information on working with the Polygon list. 

Property Description 

 

Selection Select the check box to select the polygon in the 3D Window. You 
can select multiple polygons to perform actions on multiple 
polygons. 

Excluded Select the check box to exclude the polygon from the project. The 
polygon continues to display in the 3D Window.  

Visible Select the check box to show the polygon in the 3D Window.  

Name Name of the water polygon.  

Leveled Select the check box to set a constant water level (i.e., altitude) for 
all points in the water body polygon, to create level water bodies 
such as seas, lakes, ponds, and pools. This is especially useful for 
creating a level water body on top of a non-flat terrain or mesh, or 
for creating a flat water body based on an imported polygon with 
variable altitude values. If the check box is cleared, PhotoMesh 
segments the water body polygon into multiple flat reconstruction 
tiles, each of which has a different elevation value based on the 
average elevation within the specific tile. This option should be 
selected to create an elevation gradient for water bodies such as 
rivers, with non-uniform water levels. 

If a water polygon is leveled, all its nodes are set to the elevation of 
the first node drawn.  

Note: If you want to level or unlevel multiple polygons, multi-
select the required polygons. Then right-click in the Water 
Polygons list, and select Level/Unlevel. Unleveling allows 
you to set different elevations for each polygon node. See 
"Selecting Water Body Polygons" in this chapter for more 
information. 

Average Elevation The average elevation of the water polygon. When this value is 
edited, PhotoMesh proportionally adjusts the elevation value of 
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each of the individual nodes, so that the ratio between node 
elevations is still maintained. 

Note: If you want to set the average elevation of multiple 
polygons, multi-select the required polygons. Then right-
click in the Water Polygons list, and select Set Average 
Elevation. You can also modify the average elevation of 
multiple polygons by a specified delta. To do so, multi-
select the required polygons. Then right-click in the Water 
Polygons list, and select Set Elevation Delta. See 
"Selecting Water Body Polygons" in this chapter for more 
information. 

Deleting Water Body Polygon Layers 

To delete a polygon layer: 

▪ In the Project Tree, right-click the required polygon layer, and select Delete.  

Deleting Selected Water Body Polygons  

To delete a selected polygon from a layer: 

 In the Project Tree, select the layer.  

 In the Polygon list, right-click the required polygon, and select Delete. 

Note: You can also select the required polygon(s) in the 3D Window, and then right-click in the 

Polygon list, and select Delete. Use CTRL-click or SHIFT-click to multi-select polygons in 

the 3D Window.- 

Editing Polylines and Polygons 

Water body polygons and retouch polygons and polylines are edited using the commands in the mini 

toolbar. This toolbar is displayed whenever the polygon/polyline is selected. 

 

To edit a polygon/polyline: 

 Select the polygon/polyline, and then do either of the following: 

▪ Move the polygon/polyline 

▪ Modify the polygon/polyline shape 

 If you want to select a different object from the one currently being edited, click Select another 

object . 

 If you want to align your polygon/polyline to a surface, click Align to Surface . The 

polyline/polygon's nodes are aligned to the surface. 

To move a polygon/polyline: 

 Click the Edit Object icon . 

 Do any of the following: 



 

230 

PhotoMesh User Guide 

▪ If you want to set position based on mouse and snap the polygon/polyline to another object, click 

Snap Based on Snapping Options icon  (Shortcut key: 4). See "Setting Snapping Options" 

in this chapter for information. 

▪ If you want to set position based on mouse without snapping the polyline/polygon to another 

object, click Set Position Based on Mouse  (Shortcut key: 3). 

▪ If you want to move polygon/polyline in the XY plane, click XY Plane . 

▪ If you want to move the polygon/polyline in the Z plane, click Z Axis .  

 Click the polygon/polyline, and drag it to the required location/altitude. Release the left mouse button 

to set the polygon/polyline at the current location/altitude. If snapping to an object, move and snap the 

polygon/polyline to an edge or vertex of any existing object. 

To modify a polygon/polyline's shape by moving its nodes: 

 Click Edit Nodes . 

 Do any of the following: 

▪ If you want to set position based on mouse and snap the polygon/polyline to another object, click 

Snap Based on Snapping Options icon  (Shortcut key: 4). See "Setting Snapping Options" 

in this chapter for information. 

▪ If you want to set position based on mouse without snapping the polygon/polyline to another 

object, click Set Position Based on Mouse  (Shortcut key: 3). 

▪ If you want to move a node in the XY plane, click XY Plane .  

▪ If you want to move a node in the Z plane, click Z Axis .  

 In the 3D Window, place the cursor over one of the polyline/polygon’s nodes. The node turns blue. 

 Click the node and drag it to the required location in the XY/Z Plane. Release the mouse button to set 

the node at the current location. 

Setting Snapping Options 

You can set how a node or object snaps to other objects. 

To set snapping options: 

 Select a single object for editing.  

 On the top bar of the object’s property sheet or mini toolbar, click Set Snapping Options . 

 Toggle on any of the following options: 

▪ Node Snapping – Snap object or node to nodes of other objects or features. 

▪ Line Segment Snapping – Snap object or node to line segments of other objects or features. 

▪ 3D Snapping – Smart snap object or node to dynamically-identified edges and corners of any 

element in the 3D World. 

▪ Directional Snapping – Constrain the object line segments currently being drawn to pre-defined 

angle increments. The angle constraint can either be absolute, i.e., relative to true North or 

relative to the previous line segment. 

▪ Segment Distance on Edit – Show segment lengths while editing a polygon/polyline. 
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Retouching a Mesh Layer  

Mesh imperfections, such as bumps, irregular surfaces, or floating artifacts, can be flattened, filled, and 

cleaned up in PhotoMesh using the Manual Retouch tool. This tool allows you to mark the surfaces for 

flattening and floating artifacts for removal. The output of the Manual Retouch tool is a polygonal feature 

"retouch layer" with attribute information that defines what retouch action should be performed in each 

area: clean, flatten, and retexture. When rebuilding the project, PhotoMesh uses the manual retouch layer 

to add a set of constraints to the reconstruction algorithms. Most of the constraints defined apply to the 

mesh model, and the modified model is then retextured using the project’s photos. There is also an option 

in the Manual Retouch tool to set a specific file texture, e.g., water or grass, for a marked area, instead of 

basing texturing on the project’s photos. 

You can run the manual retouch tool either on the reconstruction tile’s 3D textured models or on the final 

3DML. All retouch operations are listed in the Manual Retouch list. 

To use the Manual Retouch tool: 

Note: The shortcut keys only work when keyboard focus is on the retouch toolbox or the 3D Window. 

 Do either of the following: 

▪ In the 3D Window, click the required reconstruction tile. Then on the Tile tab, in the Show group, 

toggle on Textured Model. 

▪ In the Project Tree, in the Outputs folder, under the required Build folder, select the 3DML 

output. 

 On the Home tab, in the Add group, click the arrow under Retouch, and select Open Manual 

Retouch Toolbox. The Manual Retouch Toolbox is displayed. 

Note: You can also open the Retouch tool by clicking Manual Retouch under the Retouch 

Layers group in the Project Tree.  

Note: You can also turn on global selection, and then select a manual retouch polygon/polyline in 

the 3D Window. See “Selecting Objects in the 3D Window” in the “Basic Concepts” chapter 

for information. 

 

Manual Retouch 

 If you want to tag your edits with your name, click the user name link, and enter your user name. This 

information is saved in the layer’s username attribute. When multiple users work on the same retouch 
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layer, this attribute enables you to identify the particular user that last worked on each retouch 

polygon. 

 If you want to create a surface on which to draw your retouch polygon or polyline, e.g., for a model 

that is not flat or missing corners, click the arrow next to Drawing Surface (Shortcut key: d) and 

select one of the following options: 

▪ Show Last – Display the last surface that was created. 

▪ Edit – Open the surface property sheet to edit altitude, x, y, yaw, pitch, and roll properties, and 

use the toolbar to edit the surface in the 3D Window. See "Editing Polylines and Polygons" in this 

chapter for information. 

▪ Click one of the other manual retouch commands and draw a polygon or polyline whose 

nodes are all lying in the same plane. Selecting Set Position Based on Mouse  or Snap 

Based on Snapping Options  in the polygon property sheet before drawing makes it 

easier to draw the polygons on a vertical plane.  

▪ Horizontal – The surface is aligned horizontally to the area under the cursor. 

▪ Vertical – The surface is aligned vertically to the area under the cursor. 

▪ 3 Points – The surface is aligned to the polygon created by the three points you draw. 

 Perform one of the following retouch operations: 

▪ Flatten polygon (Shortcut key: f) – Remove all elements inside a defined volume, and add a flat 

surface in the area of the 2D polygon. For e.g., filling holes and flattening walls. 

i. Click Flatten Polygon. 

ii. Draw a polygon around the area for flattening. Right-click to complete.  

▪ Flatten profile (Shortcut key: p)  – Create multiple flatten polygons by defining a profile line 

(usually on a roof top) and the base elevation. A flatten polygon is created for each segment of 

the profile line (from the line to the base elevation). This method is useful for creating retouch 

polygons in hard to access places, e.g., between buildings. 

i. Click Flatten Profile. 

ii. Draw the profile line, and then right-click to complete. 

iii. Use the property sheet's toolbar to edit the polygon. See "Editing Polylines and Polygons" in 

this chapter for information. Close the mini toolbar when finished editing. 

iv. Place the "X" on the model to define the base elevation. 

▪ Remove floating (Shortcut key: r) – Remove all elements inside a defined volume. This option is 

generally used to remove floating elements that aren’t connected to the ground. 

i. Click Remove Floating. 

ii. Click any point on the floating artifact. PhotoMesh automatically creates a polygon that 

includes the selected point. 

▪ Remove wire (Shortcut key: w) – Remove thin elements such as power lines by drawing a 

polyline that marks the wire to be removed. A separate floating polygon is created for each 

segment of the polyline.  

i. Click Remove Wire. 

ii. Draw a polyline along the wire to remove, and then right-click to complete.  

 To select the polygon for editing after it is drawn, click Select and Edit (Shortcut key: s), and then 

select the retouch object for editing. Use the mini toolbar to edit the polygon. See "Editing Polylines 

and Polygons" in this chapter for information.  
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 To adjust the length to extrude the retouch polygon upwards or frontwards and downwards or 

backwards in the direction of the polygon’s normal, select the polygon and in the Manual Retouch 

Toolbox, slide the Front buffer and Back buffer sliders. If a polygon’s elevation angle to the ground 

is less than 20 degrees, the polygon is extruded vertically. If the polygon points were created in a 

clockwise orientation, then the front is the side facing the user. 

 If you want to add water or grass texture to your flatten polygon (created via "Flatten Polygon" or 

"Flatten Profile"), select the polygon, and then in the Manual Retouch Toolbox, select a Texture 

file. Enter a value for the texture tile size. If you want to remove the added texture, select the first 

entry which is blank in the Texture file list. 

 To select how to display the drawn polygon, click the Volume icon (Shortcut key: o):  

▪ Volume Colorize – Mark the area for retouching by colorizing all parts of the mesh contained 

within the extruded polygon. 

▪ Volume Polygon – Mark the area for retouching by displaying 3D polygons based on the 

extruded polygon. 

▪ Volume No – Mark the area for retouching only with a 2D polygon.  

Modifying Retouch Polygons 

All retouch operations can be viewed and edited from the Manual Retouch list. See "Selecting Items 

Using the Item List" in the "Using the Project Tree and Item List" chapter for more information. 

 

Manual Retouch List 

To modify a retouch operation: 

 In the Project Tree, select the Manual Retouch layer, and then in the Manual Retouch list, select 

the required row. 

 Perform any of the following actions: 

▪ Fly To/Jump To – Right-click the required row, and select Fly To/Jump To. 

▪ Delete Polygon – Right-click the required row, and select Delete. 
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▪ Edit Polygon – Right-click the required row, and select Edit. The retouch polygon is selected in 

the 3D Window and a mini toolbar is displayed. See "Editing Polylines and Polygons" and 

"Marking a Mesh Layer for Retouching" in this chapter for information on modifying the polygon 

shape/position and properties. Some properties can be modified directly in the Manual Retouch 

list.  

Exporting and Importing a Retouch Layer 

You can export retouch layers with selected retouch polygons to an SQLite file. The layer can be modified 

in TerraExplorer and reimported to PhotoMesh. 

To export a retouch layer: 

 In the Project Tree, select the Manual Retouch layer, and then in the Manual Retouch list, select 

the retouch polygons that you want to export, right-click and select Export. The layer is exported with 

the selected retouch polygons as an SQLite file. 

 Browse to the required folder, and click Save.  

To import a retouch layer: 

 In the Project Tree, select the Manual Retouch layer, and then in the Manual Retouch list, right-

click and select Import. 

 Browse to the required SQLite file, and click Open. The layer is imported to the project. 

Exporting Aerotriangulation Results 

You can export your aerotriangulation results either as multiple tiles or as a single unified SQLite or XML 

file.  

To export your aerotriangulation results: 

 On the Home tab, in the Review group, click the arrow under Build Report and select Export AT. 

The Export Aerotriangulation Results dialog box is displayed. 

 

Export Aerotriangulation Dialog Box 

 In the Method field, select how to export the AT results: 



   

 235 

PhotoMesh User Guide 

▪ Unified AT – Create a single, unified file from all AT tiles for export of AT information into a single 

set of AT results for each photo and camera. The unified AT includes the average AT results for 

photos/cameras that participate in more than one AT tile . 

▪ Multiple AT Tiles – Export each AT tile to a separate file. 

▪ Create a unified AT (see description above) + generate undistorted photos based on the 

distortion parameters calculated in the AT process.  

Note: When photos are loaded into a project, most include distortions resulting from camera 

lens properties. In the build’s photo preparation step, PhotoMesh calculates the 

parameters necessary to undistort the photos, and then uses these parameters to 

properly perform feature matching and other AT sub-steps. If this option is selected, 

these parameters are also used to create and save undistorted versions of all the 

project’s photo files. 

 Select a Format:  

▪ Blocks Exchange XML – An open exchange format for import/export of AT data. 

▪ SQLite - Skyline internal format for import/export of AT results.  

 In the Output File field, click Browse, and then in the Save Aerotriangulation Results dialog box, 

do the following: 

a. Browse to the folder in which you want to save the AT results.  

b. Type the File Name for your results, and click Save.  

Note: If the results are being exported as multiple tiles, the naming system for each of the tiles 

is as follows: File Name_AT_Tile-]Tile # [, e.g., FileName_ AT_Tile-0-0-1-1.xml, 

FileName_ AT_Tile-0-1-1-1.xml, etc.   

 If you want to exclude uncalculated photos from the exported AT results, select the check box. If 

uncalculated photos are not excluded, they are exported with original position and orientation values. 

 Click Export. 
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3DML Display Style Options  

Several style options are available for displaying the mesh model output. The mesh model can include a 

wireframe and be textured or solid color. 

To select a mesh layer display style: 

▪ On the View tab, in the Mesh Layer group, select the arrow under Display Style and select a style:  

▪ Texture  

▪ Texture + wireframe  

▪ Solid color  

▪ Solid color + wireframe  
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Managing Build Versions 

To manage your build versions: 

 On the Home tab, in the Build group, click Versions Manager. The Build Versions Manager is 

displayed. 

 

Build Versions Dialog Box 

 If you want to load a different version than the current one, select the version and click Load. If the 

current version was not saved, a dialog box is displayed asking if you want to save it before the 

selected version is loaded. Click Yes to save. 

 If you want to delete a version, select the version and click Delete. 
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CHAPTER 18  IMPORTING AND EXPORTING MODELS 

About Importing and Exporting Models 

After a 3D mesh model is created in Skyline PhotoMesh, certain tiles may require editing, e.g. to remove 

a particular building that is being torn down, flatten surfaces and correct certain imperfections such as 

bumps or irregular surfaces, or edit textures. These edits, whether they involve mesh or texture 

retouching, can be performed in external software, such as Autodesk® MeshMixer, by exporting the 

required OBJ models and then reimporting them to PhotoMesh in order to rebuild the project. When edits 

are complete, you can reimport precisely the data you want to import, all in one step:  

▪ Only textures, using the models generated by PhotoMesh before the edits  

▪ Only models (in which case retexturing is required in PhotoMesh) 

▪ Both models and textures  

You can import a single model or a folder with multiple model files, in which case each model file is read 

into its respective tile as long as its original file name is maintained.  

Exporting a Point Cloud 

To export a point cloud: 

 On the Home tab, in the Tiles group, click Reconstruction Tiles. 

 Click the tile whose point cloud you want to export. You can use CTRL-click or SHIFT-click to multi-

select tiles. The Tile tab is displayed. 

 On the Tile tab, in the Export group, click Point Cloud. The Export Point Cloud dialog box is 

displayed.  

 Browse to the required location, and click Save. 

Exporting a Model 

To export a model: 

 On the Home tab, in the Tiles group, click Reconstruction Tiles. 

 Click the tile whose model you want to export. You can use CTRL-click or SHIFT-click to multi-select 

tiles. The Tile tab is displayed. 

 On the Tile tab, in the Export group, click Model. The Export Model Folder dialog box is displayed. 

 Browse to the required location, and click Save. 

Note: When reimporting an exported model file after editing in external software, the model file 

must have the original file name with which it was exported to enable PhotoMesh to update 

the respective tile based on the edited model. 

Importing a Model  

To import a single model:  

 On the Home tab, in the Tiles group, click Reconstruction Tiles. 

 Click the tile for which you want to import a model. The Tile tab is displayed. 

 On the Tile tab, in the Import group, click Model. The Import Model dialog box is displayed. 

 Browse to the required model and click Open. The Import Model dialog box is displayed. 
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Import Model Dialog Box 

 Select the model data to import and then click Import: 

▪ Import model and textures 

▪ Import only textures – use model generated in PhotoMesh 

▪ Import only the model – requires rebuilding from texturing 

 After reimporting, rebuild using the “Build” command starting from "Auto", to have PhotoMesh 

automatically determine what processing must be performed to complete the project. See 

“Rebuilding” in the “Building” chapter for information.  

To import a folder with multiple models: 

 On the Home tab, in the Add group, click Import Models. The Import Model Folder dialog box is 

displayed. 

 Browse to the folder that contains the edited models and click Select Folder. The Import Model 

dialog box is displayed. 

Note: The model files must have the original file names with which they were exported to enable 

PhotoMesh to update the respective tiles based on the edited models. 
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Import Model Dialog Box 

 Select the model data to import and then click Import: 

▪ Import model and textures 

▪ Import only textures – use model generated in PhotoMesh 

▪ Import only the model – requires rebuilding from texturing 

 After reimporting, rebuild using the “Build” command starting from “Auto” and building until “Output”, 

to have PhotoMesh automatically determine what processing must be performed to complete the 

project. See “Rebuilding” in the “Building” chapter for information.  
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CHAPTER 19  ADDING TERRAIN OBJECTS AND LAYERS 

About Terrain Objects and Layers 

Terrain objects and layers can be added to a PhotoMesh project to enable you to visualize how the model 

will appear in TerraExplorer’s 3D World. 

You can add any of the following objects and layers: 

▪ Locations 

▪ Imagery and Elevation Layers 

▪ 3D Mesh Layers 

▪ Terrain Objects (Modify Terrain and Hole on Terrain) 

Locations 

A location defines the geographical coordinates of a point on the terrain as well as the position from which 

the point is to be viewed.  

To create a new location in the current camera position: 

▪ On the Tools tab, in the Objects and Layers group, click Create Location. The location of interest is 

set to the terrain coordinate at the center of the 3D Window. If there is no terrain at the center of the 

view (the camera is facing the sky), the location of interest is set to a distance of two times the current 

altitude of the camera above the terrain. The location is added to the Project Tree in the Objects and 

Layers section. 

Note: When you create a location, the point of interest is set only to the terrain coordinate of the 

center of the 3D Window and is not affected by any 2D or 3D models in front of the terrain. 

Imagery and Elevation Layers 

Raster layers can be added to your project from any of the following:  

▪ Files on your own computer or on your local network. 

▪ A database that is served over a network by one of these GIS servers: 

▪ Web Map Service 

▪ Web Map Tile Service 

▪ Oracle Spatial Database 

▪ ECW Image Web Server 

▪ TerraGate Server  

▪ SkylineGlobe Server (See the “Working with SkylineGlobe Server” chapter for information) 

▪ ArcSDE Raster Server 

See the TerraExplorer User Guide for more information. 

To add an imagery/elevation source to a project: 

 On the Tools tab, in the Objects and Layers group, click Imagery Layer/Elevation Layer. The Load 

Imagery/Elevation Layer dialog box is displayed. 

https://www.skylinesoft.com/hubfs/KB_Resources/TED/Web%20Help/User%20Guide/index.htm#t=About_TerraExplorer.htm
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 Browse to the required file and select it, or select the server type and enter the required information. 

See the TerraExplorer User Guide for further information. 

 Click Open.  

Note: If the source file is geo-referenced, it is located accordingly on the terrain. Otherwise, it is 

placed at the center of the 3D Window. You can then manually edit its position, or reproject 

it. 

 After the layer has been placed on the terrain, you can change its properties using the property sheet. 

See “Imagery and Elevation Layer Parameters” in the TerraExplorer User Guide for further 

information. 

3D Mesh Layers  

3D Mesh Layers (3DML) can be loaded from 3DML files on your own computer or local network or from a 

database that is served over a network by SkylineGlobe 3D Mesh service. 

To load a mesh layer: 

 On the Tools tab in the Objects and Layers group, click 3DML. The Browse for 3DML Layer dialog 

box is displayed. 

 Browse to the required file, and click Open or select the required server type, and click Select. Then 

enter the information required for the selected server. See the “Working with SkylineGlobe Server” 

chapter for information. 

 After the layer has been placed on the terrain, you can change its properties using the property sheet. 

See “3D Mesh Layer Parameters” in the TerraExplorer User Guide for further information. 

Terrain Objects 

The following terrain objects can be added to a PhotoMesh project to enable you to visualize how the 

model will appear in TerraExplorer’s 3D World: 

▪ Modify terrain 

▪ Hole on terrain 

Modifying the Terrain 

Using the Modify Terrain tool, you can modify the elevation values in an area of the terrain by drawing a 

polygon in the 3D Window and then setting the Modify Terrain object’s properties in its property sheet. 

The surface of the terrain is raised or lowered according to the elevation values of the polygon's points. 

Different elevation behaviors allow replacing, cropping above or cropping below the original values of the 

terrain. The interior of the polygon can be flat or irregular in shape. 

To modify the terrain: 

 On the Tools tab, in the Objects and Layers group, click Modify Terrain. The Modify Terrain 

property sheet is displayed. 

 With the cursor in the 3D Window, click to add the first point of the polygon. 

 Click again to add additional points of the polygon until you have marked the entire shape. You must 

place at least three points to define the polygon. 

Note: When creating a Modify Terrain object, the lines of the polygon should not overlap each 

other.  

https://www.skylinesoft.com/hubfs/KB_Resources/TED/Web%20Help/User%20Guide/index.htm#t=About_TerraExplorer.htm
https://www.skylinesoft.com/hubfs/KB_Resources/TED/Web%20Help/User%20Guide/index.htm#t=About_TerraExplorer.htm
https://www.skylinesoft.com/hubfs/KB_Resources/TED/Web%20Help/User%20Guide/index.htm#t=About_TerraExplorer.htm
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Note: It is recommended to keep the number of polygon points to the minimum required to define 

the shape. Adding unnecessary points may adversely affect performance. 

 Right-click to finish the object. 

 Continue to edit the object’s parameters and shape, or close the property sheet to finish the 

operation. See “Modify Terrain Property Sheet” in the TerraExplorer User Guide for further 

information. 

Cutting a Hole on Terrain 

Cutting a hole on the terrain removes the terrain texture while maintaining the original contours of the 

terrain. The objects or feature layers created on the terrain in the area of the hole are drawn on the 

original contours of the terrain. 

To cut a hole on the terrain: 

 On the Tools tab, in the Objects and Layers group, click Hole on Terrain. The Hole on Terrain 

property sheet is displayed.  

 With the cursor in the 3D Window, click to add the first point of the hole. 

 Click again to add additional points of hole until you have marked the entire shape. 

 Right-click to finish the hole. 

Note: It is recommended to keep the number of hole points to the minimum required to define the 

shape. Adding unnecessary points may adversely affect performance. 

 Continue to edit the hole or close the property sheet to finish the operation. See “Hole on Terrain 

Property Sheet” in the TerraExplorer User Guide for further information. 

 

https://www.skylinesoft.com/hubfs/KB_Resources/TED/Web%20Help/User%20Guide/index.htm#t=About_TerraExplorer.htm
https://www.skylinesoft.com/hubfs/KB_Resources/TED/Web%20Help/User%20Guide/index.htm#t=About_TerraExplorer.htm
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CHAPTER 20  ANALYSIS TOOLS 

About Analysis Tools 

The Tools tab provides you with a set of TerraExplorer analysis tools that help you validate photo 
parameters. 

Tool Description 

Distance Displays the aerial distance, elevation difference, horizontal 
distance and slope angle between two or more points in the 3D 
Window. 

Area Measure the following for a defined area on the terrain: 

▪ Horizontal plane – Displays the measurement of the 
horizontal projection of an area in the 3D Window. 

▪ Terrain surface – Displays the measurement of the marked 
area while taking into account terrain contours.  

Query Provides data about any point or object in the 3D World.  

Distance Tool 

The Distance tool allows you to measure the aerial distance, elevation difference and slope between two 

or more points. The aerial distance is the actual distance between the points. 

To use the Distance tool: 

 On the Tools tab, in the Measure group, click Distance. The Distance Measurement dialog box is 

displayed with the following options regarding display of distance information in the 3D Window: 

Note: The aerial, horizontal, and vertical distance information are calculated and displayed in the 

Distance Measurement dialog box even if the respective option was not selected 

▪ Show Aerial Distance – Show a yellow line marking the aerial distance, i.e., the actual distance 

between points, in the 3D Window. 

▪ Show Horizontal Distance – Show a white line marking the horizontal distance between points 

in the 3D Window. 

▪ Show Vertical Distance – Show a purple line marking the vertical distance between points in the 

3D Window. 
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Distance Measurement Dialog Box 

 If you want to snap the measurement points to an object’s edge or vertex, click Snap . All edges, 

i.e., intersections of two plane faces, and vertices, i.e. intersections of two polylines are automatically 

detected. 

 In the 3D Window, click any point on the terrain or on an object to define the start point of the 

measurement. A yellow line extends from the start point. Drag the cursor to the next point and click 

again. Repeat to add as many segments as required. If you want to delete the last point added, click 

Delete Point . Right-click to finish the measurement.  

The Distance Measurement dialog box displays the following measurements: 

Measurement Description 

Total Aerial Distance The aerial distance, i.e., the actual distance between the points. 
This measurement is the sum of the aerial distances between the 
points as you progress from the start point to the endpoint.  

Total Horizontal Distance The horizontal distance between the points. 

This measurement is the sum of the horizontal distances between 
the points as you progress from the start point to the endpoint.  

Total Vertical Distance The difference in elevation between the points. 

If you have marked more than two points, this measurement does 
not take into account the elevation values of the middle points.  

Slope The slope of the line between the first and last points. 

If you have marked more than two points, this measurement does 
not take into account anything other than the elevation at the start 
point and the elevation at the endpoint.  

 If you want to delete the measurement polyline in the 3D Window, click Delete . 

 To perform additional distance measurements, repeat steps 2-3 above. 

 To close this tool, click the X on the top right corner of the dialog box. 

Area Tool 

Using the Area tool, you can calculate area on the terrain or on an arbitrary plane. 
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To use the Area tool: 

 On the Tools tab, in the Measure group, click Area. The Area Measurement dialog box is displayed. 

 

Area Measurement Dialog Box 

 Click either of the following commands: 

▪ Horizontal plane area (2D measurement)  - Calculate area on terrain. The area measured is 

the horizontal projection of the area you have outlined, even if some or all of your selected area 

encompasses mountainous terrain. 

▪ 3D plane area  - Calculate area on an arbitrary plane. The polygon’s orientation is determined 

by the first three points selected. 

 If you want to snap the measurement points to an object’s edge or vertex, click Snap . All edges, 

i.e., intersections of two plane faces, and vertices, i.e. intersections of two polylines are automatically 

detected.  

 Draw a polygon in the 3D Window that defines the borders of the region being measured: 

▪ Place the polygon points in the 3D Window by clicking in the desired locations. A red line 

extends from the start point. If a valid selection area was drawn, the line turns white after the third 

click, indicating that you can then right-click and obtain the required measurement. A minimum of 

three points must be selected. If you want to delete the last point added, click Delete Point. 

Note: If the boundary line of the measured area crosses itself, it turns red, and a dialog box is 

displayed informing that the polygon is invalid.  

 Right-click to finish the measurement. The Area dialog box displays area and perimeter 

measurements.  

 If you want to delete the area polygon in the 3D Window, click Delete . 

 To perform additional area measurements, repeat steps 2-5 above. 

 To close this tool, click the X on the top right corner of the dialog box. 

Information Query Tool 

The Query tool provides you with data about any point or object in the 3D World. For a point on the 

terrain, location and elevation information is provided, while for an object, the query also displays the 

object’s perimeter and area. If the object selected was loaded from a layer with attribute information, the 

object’s attributes are also displayed.  

To use the information query tool: 

 On the Tools tab, in the Measure group, click Query.  

 Move the cursor over any point in the 3D Window. When you move the cursor over an object, the 

object is highlighted. 
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 Click the left mouse button on the point or object for which you require information. 

▪ In the Message Bar, the longitude, latitude and altitude are displayed. 

▪ The Query Results dialog box is displayed, showing the longitude, latitude, and elevation. When 

an object is selected, general information about the object and attribute information, if available, is 

displayed.  

 With the Query tool selected, you can click again on any point in the terrain to find its coordinates. 

Repeat for as many points as you wish. 

On the Tools tab, in the Measure group, click Query again to close the Information Query.  
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CHAPTER 21  PHOTOMESH AUTOMATION 

About PhotoMesh Automation 

PhotoMesh provides you with REST APIs for automating PhotoMesh project and queue tasks.  

▪ PhotoMesh API - REST API to automate the production phases, e.g., load photo files or list, set AT 

and reconstruction areas, begin and manage a build, and create new build versions.  

▪ ProjectQueue API - REST API to create a project queue, and then activate, monitor, and manage 

the queue processing.  

Creating a Project Queue 

Processing of the project queue is activated from the PhotoMesh Queue Builder. After the project queue 

JSON file is loaded, the relevant fields in the Queue Builder are automatically populated based on the 

information in the loaded file. These fields can be edited in the Editor and additional projects can be 

added to the queue. When the queue is ready, you activate queue processing, and then PhotoMesh 

begins performing the build tasks according to their order in the queue. During the build process, the 

builds included in the queue are monitored and managed from the Projects Queue Manager. See 

"Managing the Queue" in this chapter for more information  

 

To create a queue: 

 From the Start page, open the Automation Dashboard and in the Project Queue section, click 

Project Queue. The Projects Queue Editor is displayed. See "Automation Dashboard" in the "Basic 

Concepts" chapter for information. 

 Click Load from File, and browse to the project queue JSON file you created. See “Creating a 

Project Queue JSON File” in this chapter for information. The file is loaded, and the relevant fields are 

automatically populated based on the file information. If you want to start with a blank JSON file, and 

enter all the values manually, click New projects template. 

 Enter/modify the required information for your file type: 

Field Description 

Name Free text describing the project. 

Action The action you want to perform in PhotoMesh. The following are 
the possible options: 

▪ Create (and Build) New Project 

▪ New Build 

▪ New Build – Copy AT 

▪ Rebuild 

▪ Pause 

▪ Script (Python or JavaScript) 

Project Path Type the full path to: 

▪ The PhotoMeshXML project file that should be loaded if 
performing a new build or rebuilding, 
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▪ The PhotoMeshXML project file that should be created if 
creating and building a new project. 

▪ A script file if the action selected is script. 

Build From The step from which you want to start the build. Select "Auto” to 
have PhotoMesh automatically determine what processing must 
be performed to complete the project, avoiding unnecessary 
rebuilding.  

Build Until The step until which you want to build. 

Inherit from Build The name of the build version from which to inherit the project's 
base build parameters. This property is applied only when 
performing a New Build or – New Build-Copy AT. 

Preset If the preset file is saved under the application's AppData or in the 
application files' Presets folder, enter the name of the preset files 
to be loaded by PhotoMesh, separated by a comma. Otherwise 
enter the full path of each preset, separated by a comma. Click 
Select to select one or more presets from a list, and then click OK, 
or type the full path to the file.The available preset files are in the 
Presets folder located under the folder from where PhotoMesh is 
running. Only the file name should be typed, without the file 
extension, e.g., "Draft_mode" or "Standard_GPS".  

Max Pool Fusers Maximum number of pool fusers to run. 

Max AWS Fusers Maximum number of Amazon Web Services (AWS) fuser 
instances to run. 

AWS Startup Script The startup script PhotoMesh should use when launching AWS 
fuser instances. This field is only displayed if Max AWS Fusers 
was set > 0. 

AWS Configuration Name The name of the configuration JSON file PhotoMesh should use to 
determine which AWS instances to launch. Only the file name 
should be passed, without the file extension. This field is only 
displayed if Max AWS Fusers was set > 0. 

AWS Configuration JSON 
Path 

The path to the folder where the AWS Configuration Name JSON 
file is saved (default is ./PhotoMesh/AWSConfigurations). This 
field is only displayed if Max AWS Fusers was set > 0. 

Collections The source of the project's photo information. This property is only 
displayed when Action was set to Create New Project. The 
following options are available: 

▪ Load Folder 

▪ Load Video 

▪ Load List (XML, Excel)  

Collection XXX This property is only displayed when Action was set to Create New 
Project: 

▪ If Collections was set to Load Folder – Enter the name and full 

path to each of the project's collections.  

▪ If Collections was set to Load Video – Enter the name and full 
path to each of the project's collections (containing the video 
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file). 

Excel Full path to the photo list. 

Properties Full path to the collectionProperties.xml file (optional). There are 
no restrictions on the naming of the collection properties XML file, 
or on the location where this file is saved. This property is only 
displayed when Action was set to Create New Project and 
Collections was set to Load Folder. 

Focal35 Equivalent focal length in millimeters for a 35 mm film camera. 
This property is only displayed when Action was set to Create New 
Project and Collections was set to Load Video. 

Taken Every Sampling interval, i.e., every how many seconds a frame should 
be captured. This property is applied only when loading a video. 
This property is only displayed when Action was set to Create New 
Project and Collections was set to Load Video. 

Seconds Start Type the start time from which video frame extraction should 
begin. This property is only displayed when Action was set to 
Create New Project and Collections was set to Load Video. 

End Type the end time for video frame extraction. This property is only 
displayed when Action was set to Create New Project and 
Collections was set to Load Video. 

 Repeat steps 2- 3 for each project you want to add.  

 Click Remove to remove a project. 

 Click Move up  and Move down  to change the order of the projects in the queue. 

 Click Add to Queue. 

Managing the Queue 

The project queue is monitored and managed from the Projects Queue Manager. The Manager provides 

dynamic information on the status of the projects in the queue and enables you to start/stop the projects 

in the loaded queue, and change fuser allocation. See “Projects Queue Editor” in this chapter for more 

information on loading a queue file.  

To manage the projects in your queue: 

 From the Start page, open the Automation Dashboard and in the Project Queue section, click 

Project Queue. The Projects Queue Editor is displayed. See "Automation Dashboard" in the "Basic 

Concepts" chapter for information. 

 Click Queue Manager. The Projects Queue Manager is displayed, with the left side displaying 

information on each of the projects in the queue. Click Move up  and Move down  to 

change the order of the projects in the queue. 

 If you want to remove any of the projects from the queue, click the Remove link above the project 

name. If you want to clear the entire queue, click Remove All at the top of the page. 

 Click Build to start building the projects in the queue. 

 If you want to abort the current build project, and all other builds in the queue, click Abort & Stop.  

 If you want to change the maximum number of AWS or pool fusers for the queue, enter the required 

number in the appropriate field, and click Change. 

https://d.docs.live.net/0536dd8b79f24e72/Skyline/PhotoMesh_UserManual7.2.1-OneDrive.docx#_Projects_Queue_Editor
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PhotoMesh API 

PhotoMesh provides a REST API for PM Production to automate the production phases, e.g., load photo 

files or list, set AT and reconstruction areas, begin and manage a build, and create new build versions.  

To view interactive documentation of the PhotoMesh REST API: 

▪ From the Start page, open the Automation Dashboard and in the PhotoMesh API section, click 

Reference Guide. See "Automation Dashboard" in the "Basic Concepts" chapter for information. 

Note: You can also access it from Resources >PhotoMesh API. See "PhotoMesh Resources" in 

the "Introduction" chapter for information. 

Queue API 

PhotoMesh provides a REST API to create a project queue and then activate, monitor, and manage 

queue processing. The project queue is created using the add API method, in which a project queue 

JSON file is passed that lists all the tasks that should be performed for each of the projects in the project 

queue. See “Creating a Project Queue JSON File” in this chapter for more information. 

 

To view technical and interactive documentation of the Queue REST API: 

▪ From the Start page, open the Automation Dashboard and in the Project Queue section, click 

Reference Guide. See "Automation Dashboard" in the "Basic Concepts" chapter for information. 

To use PhotoMesh Queue API: 

▪ From the Start page, open the Automation Dashboard and in the Project Queue section, click 

Project Queue. See "Automation Dashboard" in the "Basic Concepts" chapter for information. 

Creating a Project Queue JSON File 

The project queue JSON file lists all the tasks that should be performed for each of the projects in the 

project queue. It also includes photo information and build and fuser settings for each of the queue’s 

projects. The steps below describe the file structure and syntax. 

To create a projects queue JSON file: 

 Create a JSON object that holds a “projects” array whose objects are each of the projects to be 

included in the queue. 

 Create project objects that are composed of name/value pairs separated by commas, which set the 

build tasks to perform, build and fuser settings, and photo information. The following name/value pairs 

should be included: 

Field Description 

Mandatory Parameters 

action Determines what action is performed. The following are the 
possible values: 0 – Create New Project (Create project, 
load photos and photo information, and then build the 
project), 1 – New Build, 2 – New Build-Copy AT, 3 – 
Rebuild, 4 – Pause, 5 – Script (Python or JavaScript). 

projectPath The full path to: 

▪ The PhotoMeshXML project file that should be or 
created if creating and building a new project (action = 
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0). 

▪ The PhotoMeshXML project file that should be loaded 
if performing a new build or rebuilding (action = 1, 2, or 
3). 

▪ A script file if the step is script (action = 5) 

buildFrom The step from which to start the build. The following are 
the possible values: 0 – Auto, 1 – Data Preparation, 2 – 
AT, 3 – Point Cloud, 4 – Model, 5 – Texturing, 6 – Output. 

buildUntil The step until which to perform the build. The following are 
the possible values: 0 – Auto, 1 – Data Preparation, 2 – 
AT, 3 – Point Cloud, 4 – Model, 5 – Texturing, 6 – Output. 

preset The name of the preset file to be loaded by PhotoMesh. 
Click select to select a preset or type the full path to the 
file. The available preset files are in the Presets folder 
located under the folder from where PhotoMesh is running. 
Only the file name should be passed, without the file 
extension, e.g., "Draft_mode" or "Standard_GPS". 

Specific Parameters 

sourceType The source type of the project's photo information. This 
parameter is applied only when creating a new project 
(action = 0). The following are the possible values: 0 – 
Load Folder, 1 – Load Video, 2 – Load List (Excel or XML 
file). 

sourcePath This parameter is applied only when creating a new project 
(action = 0): 

▪ If creating a new project by loading a folder of photos 
(sourceType = 0), the sourcePath array contains the 
name and full path to each of the project's collections, 
and an optional "properties" value with the full path to 
the collectionProperties.xml file. When using the API, 
there are no restrictions on the naming of the collection 
properties XML file, or on the location where this file is 
saved. 

▪ If creating a new project by loading a video 
(sourceType = 1), the sourcePath array contains the 
name and full path to each of the project's collections 
(containing the video file), focal length 35, Sampling 
interval (frameEvery), and start and end times for 
video frame extraction.  

▪ If creating a new project by loading an Excel or XML 
photo list file (sourceType = 2), the sourcePath array 
contains the full path to the photo list. 

inheritBuild The name of the build version from which to inherit the 
project's base build parameters. This property is applied 
only when performing a New Build or – New Build-Copy 
AT (action = 1 or 2). 

Fusers Parameters 
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MaxLocalFusers The maximum number of pool fusers to use for the build. 

MaxAWSFusers The maximum number of Amazon Web Services (AWS) 
fuser instances to launch for the build. 

AWSFuserStartupScript The startup script PhotoMesh should use when launching 
AWS fuser instances. This parameter is required if 
MaxAWSFusers was set > 0. 

AWSBuildConfigurationName The name of the configuration JSON file PhotoMesh 
should use to determine which AWS instances to launch. 
Only the file name should be passed, without the file 
extension. This parameter is required if MaxAWSFusers 
was set > 0. 

AWSBuildConfiguration.JsonPath The path to the folder where the 
AWSBuildConfigurationName JSON file is saved (default 
is ./PhotoMesh/AWSConfigurations). This parameter is 
required if MaxAWSFusers was set > 0. 

 

Example 1: New Project from Folder 
{ 

  "projects": [ 

{ 

      "comment": "New project from folder", 

      "action": 0, 

      "projectPath": "N:\\PM 

Projects\\ProjectFolder\\ProjectName.PhotoMeshXML", 

      "buildFrom": 1, 

      "buildUntil": 6, 

      "inheritBuild": "", 

      "preset": "PhotoMesh Default", 

      "workingFolder": "N:\\WorkingFolder", 

      "MaxLocalFusers": 10, 

      "MaxAWSFusers": 7, 

      "AWSFuserStartupScript"script",  

      "AWSBuildConfigurationName": "AT_MultiCoreCPU", 

      "AWSBuildConfigurationJsonPath": "", 

      "sourceType": 0, 

      "sourcePath": [ 

        { 

          "name": "RGB", 

          "path": "X:\\RGB", 

          "properties": "X:\\RGB.xml" 

        }, 

        { 
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          "name": "NIR", 

          "path": "X:\\NIR", 

          "properties": "X:\\NIR.xml" 

        }, 

        { 

          "name": "Thermal", 

          "path": "X:\\THERMAL", 

          "properties": "X:\\Thermal.xml" 

        } 

      ] 

    } 

  ] 

} 

 

Example 2: New Project from Video 
{ 

  "projects": [ 

{ 

      "comment": "New project from video", 

      "action": 0, 

      "projectPath": "N:\\PM 

Projects\\ProjectFolder\\ProjectName.PhotoMeshXML", 

      "buildFrom": 1, 

      "buildUntil": 6, 

      "inheritBuild": "", 

      "preset": "PhotoMesh Default", 

      "workingFolder": "N:\\WorkingFolder", 

      "MaxLocalFusers": 10, 

      "MaxAWSFusers": 7, 

      "AWSFuserStartupScript":  "script",  

      "AWSBuildConfigurationName": "AT_MultiCoreCPU", 

      "AWSBuildConfigurationJsonPath": "", 

      "sourceType": 1, 

      "sourcePath": [ 

        { 

          "name": "Collection 1", 

          "path": "X:\\PMProjects\\Washington\\PMCollections", 

          "focal35": 24, 

          "frameEvery": "00:00:05", 

          "startTime": "00:00:00", 
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          "endTime": "01:00:00" 

        } 

      ] 

    } 

  ] 

} 

Example 3: Rebuild Project     
{ 

  "projects": [ 

{ 

      "comment": "Rebuild project", 

      "action": 3, 

      "projectPath": "N:\\PM 

Projects\\ProjectFolder\\ProjectName.PhotoMeshXML", 

      "buildFrom": 1, 

      "buildUntil": 6, 

      "preset": "PhotoMesh Default", 

      "workingFolder": "N:\\WorkingFolder", 

      "MaxLocalFusers": 10, 

      "MaxAWSFusers": 7, 

      "AWSFuserStartupScript":  "script",  

      "AWSBuildConfigurationName": "AT_MultiCoreCPU", 

      "AWSBuildConfigurationJsonPath": ""    } 

  ] 

} 

Troubleshooting 

If you cannot access the PhotoMesh, PhotoMesh Fuser, or Project Queue API, this is generally due to a 

firewall blocking the required port or missing URL reservations. In this case, you can manually add from 

the command line a rule to allow the required port through the firewall and configure a URL registration. 

Below are the steps for each of the API's: 

▪ PhotoMesh API 

▪ Fuser API 

▪ Project Queue API 

 

PhotoMesh API 

To open the PhotoMesh API port 8086: 

 Click the Start  button, type "cmd", and then select Command Prompt from the list.  
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 In the command prompt window type the following and click Enter: 

netsh advfirewall firewall add rule name="PM API WebAPI TCP Port 8086" 

dir=in action=allow protocol=TCP localport=8086 

 Then type the following and click Enter: 

netsh http add urlacl url=http://*:8086/ SDDL=D:(A;;GX;;;WD) 

The first line adds a firewall rule named "PM API WebAPI TCP Port 8086” allowing it to bypass the 

firewall, and the second line assigns the rights for the port. 

 

If you want to change the port of the PhotoMesh API, do the following: 

 In a text editor, open the PhotoMesh.exe.config file that is located in the application files folder, and 

replace the value of the "API.API URL" key. 

<appSettings> 

    <add key="API.API URL" value="http://XXXX" /> 

</appSettings></appSettings> 

 Open in a text editor the .env file that is located in the application files' PhotoMesh.js folder, and 

replace the value of PHOTOMESH_EXE_SERVER_PORT. E.g.,  

PHOTOMESH_EXE_SERVER_PORT=XXXX 

PhotoMesh Fuser API 

To open the PhotoMesh Fuser API port 8085: 

 Click the Start  button, type "cmd", and then select Command Prompt from the list. 

 In the command prompt window, type the following and click Enter: 

netsh advfirewall firewall add rule name="PM Fuser API WebAPI TCP 

Port 8085" dir=in action=allow protocol=TCP localport=8085 

 Then type the following and click Enter: 

netsh http add urlacl url=http://*:8085/ SDDL=D:(A;;GX;;;WD) 

The first line adds a firewall rule named "PM Fuser API WebAPI TCP Port 8085” allowing it to bypass the 

firewall, and the second line assigns the rights for the port. 

 

If you want to change the port of the Fuser API, do the following: 

▪ In a text editor, open the PMFuserService.exe.config file located in the application files' Fuser folder, 

and replace the value of webApiUrl. E.g.,  

<add key="WebApiUrl" value="http://*:XXXX/" /> 

 

Project Queue API 

To open the Project Queue API fuser port 8087: 

 Click the Start  button, type "cmd", and then select Command Prompt from the list. 

 In the command prompt window, type the following and click Enter: 

netsh advfirewall firewall add rule name="PM ProjectQueue WebAPI TCP 

Port 8087" dir=in action=allow protocol=TCP localport=8087 
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 Then type the following and click Enter: 

netsh http add urlacl url=http://*:8087/ SDDL=D:(A;;GX;;;WD) 

The first line adds a firewall rule named "PM ProjectQueue WebAPI TCP Port 8087” allowing it to bypass 

the firewall, and the second line assigns the rights for the port. 

 

If you want to change the port of the Project Queue API, do the following: 

▪ In a text editor, open the .env file located in the application files' PhotoMesh.js folder, and replace 

the port number.  

E.g., PORT=8087 > PORT=XXXX 

 

 


